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Language Settings
You can set your language settings by clicking File > General Settings... 
and then changing your language in the Language option.

Support Information
For more information about the program please refer to Online Help 
(http://help.onyxgfx.com/x10). For troubleshooting tips see Service 
Center at www.onyxgfx.com/service. 

Minimum System Requirements
Operating System

• Windows XP Pro® 32-bit and 64-bit with the latest service pack, or
• Windows Vista® Business/Enterprise 32-bit and 64-bit with the latest ser-
vice pack, or
• Windows 7® Professional, Enterprise, and Ultimate, 32-bit and 64-bit with 
the latest service pack

CPU
• Intel Core 2 Duo, Pentium IV 3+ GHz  
• AMD Phenom, Athlon X2, Athlon 64/Opteron 2+ GHz
• Dual-core CPU or two single-core CPUs when multiple RIPs are used

Storage
• 50 GB of  hard drive space (SATA recommended)
• 2 GB RAM per CPU (especially important for ProductionHouse)

Video
• 1280 x 1024 16-bit color 

Hardware
• USB Port for Security Key (dedicated)

• DVD-ROM drive

Anti-Virus Software
Several types of  Anti-Virus software (including Symantec/Norton Anti-
Virus and McAfee Anti-Virus) running real-time scans on your ONYX sta-
tion can cause problems running the software such as slow rip times, failure 
to save printer settings, and issues with color device readings not being ac-
cepted by Media Manager.
To resolve this issue, go into your Anti-Virus control panel (for Symantec/
Norton it’s under Real Time Scanner) and disable any scans on the ONYX 
folder. 
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In order to receive the most efficient 
support, please be at your computer 
with the software available. When 
e-mailing, please include your contact 
information, key number, and a brief  
description of  the problem.

Introduction

For current optimal and minimum re-
quirements or information on running  
your ONYX RIP on a Mac please visit 
the Service Center at 
www.onyxgfx.com/service.
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How to Use This Manual
This manual will help you understand how to use the various features of  
your software. Due to the complexity of  the product, this guide does not 
fully describe all the possible software features.
If  you do not find a particular topic in this guide please refer to Online 
Help (http://help.onyxgfx.com/x10) and Service Center at 
www.onyxgfx.com/service
Some features described in this guide may not be available in your soft-
ware package. Check your Hardware Key permissions to view which ap-
plications and features you can use. 

To check your Hardware Key permissions:
1. Run the software.
2. Select File > View > Hardware Key from the File menu to display 

the Hardware Key dialog (see Figure i).

If  you have any questions about which features and applications are in-
cluded in your software package, contact your sales representative.

Manual Icons
This manual uses icons to help you find important information quickly. 
These icons are displayed at the left with a description of  their purpose.
The arrow icon (above) indicates steps or instructions.

Quick Tips
1. Embed ICC Profiles when saving your image in your graphic ap-
plication. This helps guarantee better color.
2. Copy your files to your local system for faster processing.
3. When saving .eps files, make sure that the printer and screen 
fonts are included with your file.
4. Keep your printer maintained properly by running daily main-
tenance. Print a warm-up job to check that there are no areas of  
over- or under-inking.
5. Recalibrate your media to provide up-to-date printer performance 
information.

This icon directs you to other sources of  
information or help.

This icon shows important suggestions, 
tips, or ideas.

This icon shows warnings, cautions, 
and critical information.

Figure i—Hardware Key Permissions
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User Guide for X10 
Workflow Products
RIP-Queue Navigation
The main RIP-Queue window is divided into five main areas:

• Printer Area (see 1)
• Jobs Ready to Print Area (see 2)
• Buffered Jobs Area (see 3)
• Information Area (see 4)
• Console (see 5)

Each area provides information relative to the area on the status of  your 
printers, jobs, or software. You can modify many settings by right-click-
ing in each area.

1

1

2

3

4

5



Setup & Printing
Objectives
This chapter takes you through the basics of  installing your software and 
printing. By the end of  this chapter, you will be able to do the following:

• Install the software and printers
• Setup your printer
• Print an image
• Setup contour cutting
• Use a Quick Set
• Use Hot Folders

Installing Your Software
To install the software:

1. Log on to your computer with Administrator Privileges.
2. Plug-in your Hardware Key to your computer.
3. Insert the Program Disk into your DVD drive. Once the Install 

window opens, review the install location, and click Next.
4. Read the License Agreement, check that you agree, and click 

Install. This begins the install (see Figure 1).
5. If a previous installation is detected, you will be given the option 

of importing printer settings from the previous install (Figure 2).
Only settings from the most recent install will be imported. For 
instance, if you have both 6.5 and 7.3.2 installed on the same 
system, only the settings from the 7.3.2 install will be considered. 
If you choose to import previous settings, the following will be 
automatically transferred to the new install: 

• Printer activity state

• Printer medias and modes

• Custom printer page sizes

• Printer port settings

• Printer Quick Sets
The following will not be imported from previous installations:

• Custom ppd locations

2 Setup & Printing—User Guide

1
These objectives may be covered in greater 
detail in other chapters and the Online 
Help (http://help.onyxgfx.com/x10/
rip-queue)

If  the software installation does not 
begin automatically, browse to your 
DVD drive and double-click it.

Figure 2—Import Settings

Figure 1—Install Screen



• Changes to Base Folder (location of Input and Work folders)

• PrintMetryx account settings

• PostScript RIP settings (jaws.cfg)

• Printer placement settings
6. Once the install is complete, click Finish to exit the installation.

Installing Your Printers
Your Hardware Key determines which printers are available to you. If  
the printer you want is not available, contact your sales representative for 
a Key Update. While you install the software only once, you can install 
additional printers and media at any time. You can open the Printer In-
stall dialog by clicking Show Options at the end of  installation. If  you 
need to install printers later, insert your Program Disk into the DVD 
drive. The Printer Install dialog will open automatically.

To install printers:
 1. In the Printer Install dialog, select the printers and media that you 

would like installed and click Install.
2. Once the install is complete, click Finish. The program will open 

automatically. 

Configuring Your Printers
Each time you install or add a printer, the Configure Printer dialog will 
appear. This dialog only displays valid configuration options for your 
printer. If  you do not know the type of  port your printer uses, contact 
your printer manufacturer or your network administrator. If  you need 
to reconfigure a printer, click Configure Printer on the main toolbar to 
open the Configure Printer dialog.
There are many types of  ports available, but the most common are 
TCP/IP, USB, and Firewire. 

To configure a TCP/IP printer:
1. In the Configure Printer dialog, click the Device tab. Select the 

printer you want to configure, and click Configure Port. This 
opens the Configure Printer Port dialog.

2. Select TCP/IP, and click Configure (see Figure 3).
3. Enter your IP Address and change the Data Type to <Port9100>. 

Port9100 is the most commonly used port. For information on 
other port types, see Online Help at http://help.onyxgfx.com/x10/
rip-queue
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Figure 3—Configure Printer Port: TCP/IP

To download new media profiles, go to 
http://www.onyxgfx.com, click Down-
loads, and then click Profiles. Download 
the ONYX Driver and Profile 
Download Manager to get ONYX 
RIP printer drivers and profiles.

Printer Install dialog will appear every 
time you open the ONYX product if  
no printers are installed.



Figure 6—Open an Image

4. Click Test to verify that the IP address is valid. Click OK to finish.

To configure a USB printer:
1. In the Configure Printer dialog, click the Device tab. Select the 

printer you want to configure, and click Configure Port. This 
opens the Configure Printer Port dialog.

2. Select USB Printer, and click Configure.
3. Select your USB device from the available options, and click OK 

(see Figure 4).

To configure a Firewire printer:
1. In the Configure Printer dialog, click the Device tab. Select the 

printer you want to configure, and click Configure Port. This 
opens the Configure Printer Port dialog.

2. Select Firewire Printer, and click Configure.
3. Select your Firewire device from the available options, and click 

OK (see Figure 4).

Setting Up Your Media
After you’ve configured your printer, verify that the media settings in the 
program match the media that is currently loaded in your printer.

To setup media:
1. If you have not already done so, load the media into your printer 

following your printer’s instructions.
2. In the program, highlight the printer in the Printer area (top-left 

corner). The media and settings are displayed to the right of the 
printer.

3. If the information in the program matches your media, you are 
ready to print. If not, click Change on the right-side of the main 
screen. This opens the Change Media and Placement dialog (see 
Figure 5).

4. Use the drop-down arrows to select the options that match the 
media and page size options that you want to use. Click Setup to 
configure your placement options.

5. Click OK to complete setup.

Opening an Image
There are several ways to open an image. 

To open an image using RIP-Queue:
1. Click Open on the toolbar, or click File > Open. This displays the 

Open dialog.
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Figure 4—Configure Printer Port: USB or Firewire

Figure 5—Change Media and Placement



2. On the left-side of the dialog (see Figure 6), select which printer 
you want to use from the drop-down menu. If you have already 
created Quick Sets, select your Quick Set. If you have not, leave 
this setting as Default.

3. If you want to preview your image, check the Open in Preflight 
option. 

4. On the right-side of the dialog (see Figure 7), browse to your im-
age, highlight it, and click Open. The image will open and move 
to the Jobs Ready to Print area of the program window.

To open an image using Preflight:
1. In Preflight, click Open on the toolbar, or click File > Open. This 

displays the Open dialog.
2. On the left-side of the dialog (see Figure 6), select which printer 

you want to use from the drop-down menu. If you have already 
created Quick Sets, select your Quick Set. If you have not, leave 
this setting as Default.

3. If you want to apply the settings you used for your most recent 
job, check the Apply Settings option. 

4. On the right-side of the dialog (see Figure 7), browse to your im-
age, highlight it, and click Open. The image will open in Preflight. 
From here, you can modify and edit your image.

When you have finished modifying your image in Preflight, you can send 
the image to RIP-Queue by clicking File > Submit.

Printing an Image
Once you have opened an image into RIP-Queue and setup your printers 
and media, you are ready to print.
Printing is simple—Click on the image you want to print and drag it into 
the Jobs Ready to Print area of  your window. 
However, the job will not print if  the media settings for the job do not 
match the media settings for the printer. If  the media do not match, the 
job remains in the Waiting for Media state until you change the media 
type for the printer or the job so they match.

To change the media for a job:
1. Highlight the job in the Jobs Ready to Print area. This displays 

information about the job in the Job Information area on the right.
2. Click Change. This opens the Job Properties dialog (see Figure 

8).
3. Change the Media Configuration Name, Media, or Page Size to 

match the media that is currently loaded in the printer. Make sure 
that this media matches the media settings for your job.

4. Click OK.
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Preflight allows you to edit and modify 
your image. For more information, see 
the Preflight chapter.

Figure 7—Open an Image

Remember, if  you make any changes, 
you must reprocess the job before you 
print it.

Figure 8—Job Properties

To help create an efficient workflow, 
RIP-Queue automatically prints jobs 
after they are processed. 



Once the Media for the job and the printer match, your image is ready to 
print. If  your job does not print automatically, verify again that your me-
dia match. If  they match, you may need to select your printer and click 
the Print Now button located on the right-side of  your screen.

Virtual Printers
You can also print to RIP-Queue using Virtual Printers. A Virtual Printer 
is a RIP-Queue printer that is used as a Windows printer. When you 
install a printer, RIP-Queue automatically creates a Virtual Printer that 
can be used from any application. This lets you print to RIP-Queue from 
graphic design programs, word processors, internet browsers, or any 
other application. To use the Virtual Printer, click File > Print in your 
application, and select the RIP-Queue virtual printer (see Figure 9).

Job Status
The icons located in the Printer Information area of  the window indicate 
the status of  the print. There are three different statuses: Online, Offline, 
and Hold.

• Online—indicated by a green sphere (see Figure 10). Clicking the 
purple button will send the printer offline.
• Offline—indicated by a red sphere (see Figure 11). Clicking the 
purple button will send the printer online.
• Hold—indicated by a hand (see Figure 12). The hold status shows 
that there is something stopping the print from continuing. Often 
this is an incorrect media setting or a Wait for Operator hold. If  the 
hold is a Wait for Media hold, change your media settings. Other-
wise, click the Print Now button.

Setting up Contour Cutting
To set up contour cutting:

1. Create a cut path in a vector-based drawing program such as Adobe® 
Illustrator® or CorelDRAW®.
2. Create a special Quick Set that uses the cutter path prefix and sets the 
marks for your specific cutter. This creates the cut file from the cut paths 
in the image and sets up the print with a barcode and registration marks. 
For more information see Contour Cutting Chapter of this guide and Online 
Help at http://help.onyxgfx.com/x10/rip-queue
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Figure 10—Online

Figure 11—Offline

Figure 12—Hold
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Whenever you change the media for your 
printer, always make sure to change the 
media settings in RIP-Queue. Doing 
this will prevent any problems with 
printing on incorrect media.

Figure 9—Virtual Printer



Using Quick Sets
A Quick Set is a tool that automatically applies certain settings to your 
jobs. Using Quick Sets is similar to using a cookie cutter. Cookie cut-
ters create cookies with particular shapes in an efficient manner. Just as 
it would take a very long time to cut out perfect star patterns for each 
cookie using only a table knife, it would also take a very long time to set 
all your job settings or options for each image. More importantly, you 
can use different Quick Sets to apply different settings or options to dif-
ferent jobs much the same way you would use multiple cookie cutters to 
create different cookie shapes (see Figure 13).
Once you create and apply Quick Sets to your jobs, each job will have 
the correct settings right from the beginning. When you open an image, 
you select which Quick Set to apply. If  you need to modify a particular 
setting, you can do so in RIP-Queue or Preflight. If  you don’t need to 
modify any settings, you can go ahead and print. If  you develop your 
Quick Sets well, you can dramatically increase your productivity.

Creating a New Quick Set
To create a new Quick Set:

1. In your program, highlight your printer, and click Configure 
Printer. This opens the Printer Configuration dialog.

2. Click the Quick Sets tab, then New (see Figure 14). This opens 
the Edit Quick Set dialog.

3. Set the options you want to use for this Quick Set. Click Ad-
vanced... if you want to set advanced options.

4. Click OK.

Edit Quick Set Options

The Edit Quick Set dialog allows you to setup your Quick Sets to match 
your workflow needs (see Figure 15). The dialog lets you set the follow-
ing options:

• Quick Set Name—this option determines the Quick Set name. 
Use a name that accurately represents your settings. 
• Media and Page Size—this option automatically assigns the cur-
rent media and page size for your printer to your jobs. If  you do 
not use this option, you can specify your own settings in the Edit 
Quick Set dialog. Make sure that your settings match what is in your 
printer.
• Print Mode—the Print Mode consists of  a predefined group of  
settings that make up a mode. Modes are specific to the printer and 
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Figure 14—Quick Sets New

Figure 13—Cookie Cutters & Quick Sets

Figure 15—Edit Quick Set
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The Sizing Rule can be restricted to the 
size of  the media page. If  the image 
does not fit on the page, the image will 
be shrunk to fit that page size unless 
you have Tiling enabled. For more 
information on Tiling see Online Help 
at http://help.onyxgfx.com/x10/
rip-queue

consist of  a variety of  settings.  
• Color Management—lets you set which profiles your jobs will 
use. You can select from the drop-down list or click Change Pro-
files to set up your own.
• Sizing Rule—this option determines the size of  the printed 
image. You can choose from Source Image, Width, Height, Pixel 
Based, or Magnification. Source Image maintains the size (or factor 
of  the size) that the image file specifies. Width sets a standard width 
for each job. Height sets a standard height for each job. Pixel Based 
sizes the image by pixels. Magnification takes any of  the previous 
settings and enlarges (or reduces) the image by that factor. If  your 
image is larger than your page size, it is automatically reduced.
• Media Options—click this button to open the media specific 
printer options for the media. If  your printer provides such options, 
Media Options button will appear next to the Media Configuration 
Name option.
• Cutter options:
Cutter Selection—the drop-down list contains the names of  all 
cutters or cutter families supported by RIP-Queue (Figure 16). The 
By Printer option is for use with printers that have an on-board cut-
ter. When this option is selected, RIP-Queue will print the image 
and then immediately send the cut commands to the device. A cut 
file is not generated. For all other selections, a cut file is generated 
for CUT-Server. CUT-Server is used to manage and send the cut 
data to the specified cutting device. For more information see On-
line Help at http://help.onyxgfx.com/x10/cutserver
Use Cutter Path Prefix. In order for spot colors to be interpreted 
as cut paths, the name of  the spot colors in the PostScript files must 
be defined in the Use Cutter Path Prefix option. The name entered 
in the Use Cutter Path Prefix field must have a prefix identical to 
the name of  the spot colors in the file. For example, if  CutCon-
tour was entered in the Use Cutter Path Prefix field, spot colors 
named CutContour1, CutContour2, etc. would be converted into 
cut paths. However, spot colors named 1CutContour, 2CutContour, 
etc. would not be converted.
Add PDF Trim Box to cut paths—this option works only with 
PDF files and creates a cut path around the image according to the 
border of  the PDF.
Generate Tile Outline Cut Path—this option generates a cut path 
around the outside edge of  each tile.

The Media Options button is only ac-
tive when the Get Media and Page Size 
From Printer option is not activated.

To learn more about profiles, see Online 
Help at http://help.onyxgfx.com/
x10/mediamanager

Figure 16—Cutter Selection
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• Image Options
The controls in this group allow you to set the default parameters 
instructing RIP-Queue how to print all of  the images processed 
with this Quick Set (see Figure 17).
Number of  Copies—this determines how many copies will be 
made of  the job. To allow the number of  copies to be specified by 
the PostScript file, set this option to Auto. 
Print Reflection—this option prints the job as a mirror-image of  
the original image file. This option is typically used when printing 
on backlit media.
Rotate—you can rotate your image by 0º, 90º, 180º, or 270º by 
clicking the appropriate option. Rotating an image may improve 
nesting by maximizing media usage.
• Operator Instructions
The controls under this heading allow you to set the defaults telling 
RIP-Queue whether to wait for operator interaction or not, and the 
default operator name attached to each job (See Figure 18).
Hold for Operator—this option stops a job from printing until an 
operator chooses to print the job.
Default Operator Name—it is the User name attached to each 
job. If  you have many different users sending jobs from various sys-
tems, consider setting the Default Operator Name for each system.
• PrintMetryx
This option is only displayed if  you have signed up for PrintMetryx 
and enabled it (Figure 19). If  PrintMetrix is enabled, the only con-
trol is the Keyword button which when clicked will display the key-
words you have set up within PrintMetryx. Here you can only select 
the keywords to be actively used. You can add/modify keywords 
within PrintMetryx. For more information see PrintMetryx Online 
Help at http://help.onyxgfx.com/printmetryx

Advanced Quick Set Options
Advanced Quick Set options let you control the settings that are typically 
only modified for uncommon situations or non-standard workflows. To 
access these options, click Advanced in the Edit Quick Set dialog. 

Output

The Output tab of  the Advanced Quick Set options controls how RIP-

For more information on Advanced 
Quick Set options, see the Online Help 
at http://help.onyxgfx.com/x10/
rip-queue

Figure 17—Image Options

Figure 18—Operator Instructions

Figure 19—PrintMetryx



• Rotate—this option allows you to rotate your image by incre-
ments of  90°.

• Image—this option allows you to set the number of  copies you 
would like to print as well as print reflections (a mirror image of  the 
original file).

• Processing—this group of  options determines your processing 
settings. You can set the program to Perform Image Processing 
During Print Stage, Process with Interpolation, Process to allow ro-
tation during print stage, and Calculate Ink Usage. These options 
improve your workflow and help you be more efficient. 

Bit Depth combo box allows you to select the processing method 
you would like to use. In most situations 8-bit processing provides 
good results, however, 16-bit processing gives noticeable improve-
ment in large images with a gradient in one color over a large area. 
Please note that 16-bit processing does slow processing down con-
siderably. 

To select processing method: 
1. Click Edit Quick Sets. On the Edit Quick Set dialog click Advanced. 

The Output tab will be displayed (Figure 20).

2. At the bottom of the Processing options group Bit Depth combo box is 

displayed (Figure 21). Choose the processing method you would like to 

use from the drop-down menu. Click OK.

Tiling

The Tiles tab lets you separate a job into two or more pieces (see Figure 
22). Typically, you use this option to print images larger than your media 
or for display and mounting purposes. This option should only be used 
if  you want your Quick Set to tile every image the same way. For more in-
formation see Online Help at http://help.onyxgfx.com/x10/rip-queue
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Processing only affects raster (pixel 
based) images.

Figure 22—Tiles Options

Figure 20—Output Options

Queue processes jobs (see Figure 20). You can set the following op-
tions:

• Output—this option determines what type of  image output will 
be processed. You can choose from Color, Grayscale, and Separa-
tions.

Figure 21—Bit Depth combo box



Marks

Marks are special lines that are printed to aid in trimming, measuring, 
or welding the image after it was printed (see Figure 23). The Marks tab 
allows you to set various types of  marks as well as the Print Label. For 
more information see Online Help at http://help.onyxgfx.com/x10/
rip-queue

Crop

The Crop option lets you set a pre-defined area of  each image that will 
not be printed (see Figure 24). This option should only be used if  you 
want your Quick Set to crop every image the same way.

PostScript Halftone

The PostScript Halftone options determine how your halftone screens 
are processed (see Figure 25). These options only apply to PostScript im-
ages using the Halftone Dot Pattern. For more information see Online 
Help at http://help.onyxgfx.com/x10/rip-queue

PostScript File

The PostScript File tab controls the file name and separation options 
that pertain to PostScript files (see Figure 26). If  you do not use Post-
Script files, these options are not used. 

• File Name Selection—this option determines whether you use 
the image file name or the file’s embedded title as the name of  the 
image in RIP-Queue. 
• Use Cutter Path Prefix—this option defines the spot channel 
name prefix of  a PostScript file that has been prepared for contour 
cutting. For more information see Online Help at 
http://help.onyxgfx.com/x10/rip-queue
• Separations—this option determines how RIP-Queue processes 
and prints separations. These options must be configured properly 
for the image to process correctly. This option should only be used 
if  your Quick Set uses separated PostScript files with the same op-
tions every time.
• Auto Detect—this option automatically detects the configuration 
of  a PostScript Separated file.

PostScript

The PostScript tab controls the job options that pertain to PostScript 
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Figure 23—Marks Options

Figure 24—Crop Options

Figure 25—PostScript Halftone Options

Figure 26—PostScript File Options



files (see Figure 27). If  you do not use PostScript files, these options are 
not used.

• Page Size—PostScript files use an element called a bounding box. 
This is a specific rectangular area of  an image. Usually, the bound-
ing box is the same size as the image; however, some images use a 
larger box for margins or a smaller box for cropping. To print the 
area defined by the bounding box, select the Only Use Bounding 
Box option.
• Warning Level—use this option if  you want the program to 
abort the job if  you have a missing font. If  you disable this option, 
the job will be processed with a substitute font. 
• Two Stage Processing—this option converts your PostScript file 
to a raster image. You can then further modify the raster image. The 
Pixel Duplication option processes the image at a smaller resolution 
and then copies the pixels to achieve the correct output resolution. 
• Anti-Aliasing—this option smooths areas in your image that ap-
pear jagged. This can improve the appearance of  low resolution 
images (see Figure 28). 
• Spot Color Replacement—this option lets you apply the spot 
color specifications defined in the Color Matching Table. The Table 
allows you to share colors you created in your graphics creation pro-
gram with your printer. 
• Override Default PostScript Settings. While most images will 
process correctly with the default settings, it sometimes becomes 
necessary to override these settings to get the desired output. This 
option lets you modify the settings for a specific Quick Set without 
changing the default settings and behavior of  the overall product. 
The RIP engine has several options that may be enabled and/or 
modified to define how the image will process (Figure 29). 
For more information on PostScript RIP options, see Online Help  
at http://help.onyxgfx.com/x10/rip-queue or Service Center at 
www.onyxgfx.com/service
• Submit Pages as Individual Jobs - this option enables RIP-
Queue to separate individual pages of  a PDF document into sepa-
rate jobs in the queue. 
Workflow

The Workflow tab determines how images and jobs are handled (see 
Figure 29). For more information see Online Help at 
http://help.onyxgfx.com/x10/rip-queue
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Using a duplication factor of  2 or 
higher can greatly reduce processing 
time, but may cause image degradation.

Figure 28—Anti-Aliasing (left—anti-aliasing 
applied)

Figure 27—PostScript Options

Figure 29—Workflow Options



Display
The Display tab allows you to set the Color Display settings for a job 
(see Figure 30). Use these options to modify how the program displays 
color information.

• Color Display—these options set the display you want to use for 
sample point values. They do not affect the display for Color Cor-
rection tools.
• Color Correction Tools Display—this option determines if  you 
use CMYK values (0-255) or percentages (0-100). This becomes the 
default setting for the Primary Color Curves and Color Replace-
ment dialogs in Preflight.

Color Correction

The Color Correction tab assigns a Color Correction Filter to all jobs 
using a particular Quick Set (see Figure 31). Click Import to add an ad-
ditional filter. For more information see Online Help at 
http://help.onyxgfx.com/x10/rip-queue

Managing Quick Sets
Managing Quick Sets alters the printer setup. Because of  this, the pro-
gram cannot process or print jobs while you modify the Quick Sets. 
Make sure that you are not processing or printing a job before managing 
Quick Sets.

To edit a Quick Set:
1. In the printer area of the main window, highlight the printer that 

uses the Quick Set that you want to modify.
2. Click Edit Quick Sets in the toolbar. This opens the Edit Quick 

Sets dialog.
3. Highlight the Quick Set you want to modify, and click Edit.
4. Modify the Quick Set options. 

To rename a Quick Set:
1. In the printer area of the main window, highlight the printer that 

uses the Quick Set that you want to rename.
2. Click Configure Printer on the toolbar. This opens the Configure 

Printer dialog (see Figure 32).
3. From the Quick Sets tab, highlight the Quick Set you want to 

rename, and click Edit.
4. Change the name of the Quick Set. The Default Quick Set cannot 

be renamed.
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Editing a Quick Set in this manner 
does not interrupt processing and 
printing. 

Figure 32—Configure Printer Dialog

Figure 30—Display Options

Figure 31—Color Correction Options



Figure 33—Hot Folders

To copy a Quick Set:
1. In the printer area of the main window, highlight the printer that 

uses the Quick Set that you want to copy.
2. Click Configure Printer on the toolbar. This opens the Configure 

Printer dialog (see Figure 33).
3. From the Quick Sets tab, highlight the Quick Set you want to 

copy, and click Copy. A new Quick Set with the same name plus 
a number appears in the Quick Set list. To change the name, 
click Edit.

To delete a Quick Set:
1. In the printer area of the main window, highlight the printer that 

uses the Quick Set that you want to delete.
2. Click Configure Printer on the toolbar. This opens the Configure 

Printer dialog (see Figure 33).
3. From the Quick Sets tab, highlight the Quick Set you want to 

delete, and click Delete. You cannot delete the Default Quick Set.

To export a Quick Set:
1. In the printer area of the main window, highlight the printer that 

uses the Quick Set that you want to export.
2. Click Configure Printer on the toolbar. This opens the Configure 

Printer dialog (see Figure 33).
3. From the Quick Sets tab, highlight the Quick Set that you want 

export, and click Export.
4. Browse to the location where you want to save the Quick Set, 

specify a name for the Quick Set, and click Save. 

To import a Quick Set:
1. In the printer area of the main window, highlight the printer that 

will use the Quick Set that you want to import.
2. Click Configure Printer on the toolbar. This opens the Configure 

Printer dialog (see Figure 32).
3. From the Quick Sets tab, click Import.
4. Browse to the Quick Set you want to import, and click Open.

Using Hot Folders
A Hot Folder is a special folder that automatically assigns Quick Set op-
tions to a job. Each Quick Set you create has a corresponding Hot Folder 
that is automatically created. When the program is running, RIP-Queue 
constantly monitors all of  your Hot Folders for image files. When an 
image is placed into a Hot Folder, the program moves it out of  the Hot 
Folder and into the queue where the image is processed and printed us-
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ing the Quick Set options associated with that Hot Folder.
Hot Folders are located in the Input folder in your program files. Be-
cause RIP-Queue automatically shares the Input folder, you can copy 
image files into a Hot Folder from any network system (Windows, Mac, 
Linux, and so forth). RIP-Queue then processes and prints each image 
using the Quick Set properties of  that Hot Folder.

To drop images into a Hot Folder:
1. Open the folder where your images are located.
2. Copy them by right-clicking on them and selecting Copy.
3. In your program files, find the Input folder, and select the printer 

you want to use. This opens the Hot Folders associated with that 
printer (see Figure 33).

4. Paste your image files directly into the Hot Folder you want to 
use. The images appear in RIP-Queue and begin processing ac-
cording to the properties of that Hot Folder’s Quick Set.

The Info Folder is not a Hot Folder. It is a special RIP-Queue folder that 
contains printer configuration settings.

Troubleshooting Hot Folders
If  RIP-Queue does not automatically process images dropped in a Hot 
Folder, check the following: 

• Does your Hardware Key have Hot Folders enabled? Check the 
Hardware Key using the Hardware Key dialog (File > View > 
Hardware Key) and verify that Hot Folders is enabled in your Key 
tree. If  it is not, contact your sales representative for an update.
• Are the images valid (supported) image files? Try opening them in 
RIP-Queue using File > Open.
• Is RIP-Queue running? The Hot Folders are only active when the 
RIP-Queue application is running.
• Are the image files read-only? RIP-Queue cannot process read-
only images. 

To remove read-only restrictions from a file: 
1. Highlight the image files in Windows Explorer.
2. Right-click the files.
3. Select Properties.
4. Uncheck the Read-Only checkbox.
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Copying files into the Info Folder or 
modifying the files that already reside 
in the Info Folder can cause errors in 
RIP-Queue.
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If  you do not have Preflight, contact your 
sales representative for a Key Update.
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Objectives
This chapter will take you through the basics of  using Preflight. By the end 
of  this chapter, you will have an understanding of  the following:

• Opening images in Preflight
• Modifying basic job options
• Adjusting color using Color Correction
• Modifying the image setup
• Using the Printer Manager

What is Preflight?
Preflight allows you to view and modify jobs before they are printed in 
RIP-Queue. Preflight is not a required step to process and print a job, but 
it is a useful tool when jobs need to be modified. Preflight can also im-
port images directly from a scanner or digital camera and preview color 
corrections and ICC profiles.

Opening Images in Preflight
You can bring an image into Preflight using any of  the following ways:

• File > Open in Preflight
• File > Open from RIP-Queue
• Import into Preflight
• Preflight button in RIP-Queue

To open an image using File > Open in Preflight
1. Select Open from the File menu. This displays the Open dialog.
2. Browse to and highlight your image.
3. Choose a printer from the Printer drop-down menu.
4. Select a Quick Set from the Quick Set drop-down menu.
5. Click Open.
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To open an image using File > Open in RIP-Queue
1. Click File > Open from the File menu. This displays the Open 

dialog.
2. Browse to and highlight your image.
3. Choose a printer from the Printer drop-down menu.
4. Choose a Quick Set from the Quick Set drop-down menu.
5. Click the Open in Preflight option in the lower left corner of the 

dialog.
6. Click Open.

The job opens in Preflight and displays in the Jobs Ready to Print area of  
the RIP-Queue window with a status of  Busy. Once you submit the job 
from Preflight, RIP-Queue will process and print it. 

To open an image by importing it into Preflight
1. Click File > Twain32 > Select Source from the File menu. This 

opens the Select Source dialog.
2. Highlight the device you want to use, and click Select. This 

becomes your default source. You can change it by selecting a 
different device.

3. Click File > Twain32 > Acquire to display the Acquire Twain 
dialog.

4. Browse to and highlight your image.
5. Choose a printer from the Printer drop-down menu.
6. Choose a Quick Set from the Quick Set drop-down menu.
7. Click Open.

To open an image using the Preflight button in RIP-Queue
1. Highlight the job in RIP-Queue.
2. Click Preflight on the right-side of the program window. 

RIP-Queue sends the job to Preflight along with the job settings, and the 
job displays in the Jobs Ready to Print area with a status of  Busy. Once 
you submit the job from Preflight, RIP-Queue will process and print it.

Modifying Basic Job Options
Preflight allows you to modify many of  the characteristics of  your job 
using the tabs across the top of  the Preflight window. These tabs are 
Printer & Media, Preview & Size, Tiling Setup, Color Correction, and 
Print. After you have modified your job, click the Print tab and Submit 
to send the job back to RIP-Queue for printing.

If  your device is not listed, reinstall 
the Twain drivers for your device. For 
more information, see your device’s user 
manual.



Printer & Media Tab
The Printer & Media tab is used to set your media and mode (see Figure  
1). You can also see which printer you are using and some basic informa-
tion about your job.

To change the media for a job:
1. Click the Printer & Media tab.
2. Use the drop-down arrows to change your Media Configuration 

and Media Name. 

To set your mode:
1. Click the Printer & Media tab.
2. Use the drop-down arrows to set your Print Mode settings. Print 

Mode includes your resolution, dot pattern, and color manage-
ment settings.

The Color Management setup of  a job allows you to control whether 
or not the program applies ICC Profiles to the job. It also allows you to 
select which ICC Profile, if  any, the program applies for each color space. 
For more information see Online Help at http://help.onyxgfx.com/x10/preflight

To set a Color Management option:
1. Select the Printer & Media tab.
2. Under Mode, choose the Color Management option that best fits 

your workflow.
3. If you want to customize the profile setup, click Change Profiles. 

This opens the ICC Profile Setup dialog (see Figure 2). Select 
the input profiles, output profiles, and rendering intents you want 
to use, and click OK. 

Preview & Size Tab
The Preview & Size tab allows you to crop, size, and rotate your jobs.

Cropping Your Image
Cropping an image selects a rectangular portion of  the image to print. 
The portion not included in the rectangular area is not printed. You can 
crop an image using your mouse or Origin and Size values.

To crop an image using your mouse:
1. In the Preview and Size tab, place your cursor on the edge of 

your image. The cursor will change into a line with two opposing 
arrows.Figure 2—ICC Profile Setup
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Figure 1—Printer & Media Tab
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2. Click and drag the dotted line until it defines the area you want to 
print. You can move the print area by clicking inside the box and 
dragging it to a new location.

3. Click Apply.

Cropping Using Origin and Size Values
Using Origin and Size values to crop your image lets you specify an exact 
width, height, or magnification for your image (see Figure 3). Each of  
these values can be locked to a specific size. To lock a value, click on the 
checkbox next to each value. You can also use the Size values to enlarge 
or shrink your image.

To crop an image using origin and size values:
1. In the Preview and Size tab, lock any values that you want to 

remain fixed.
2. Enter the values that you want to modify in the appropriate boxes.

To change the size of a job:
 1. Select the Preview & Size tab.
2. Choose your Maximum Print Area by clicking the down-arrow 

and selecting the size you want. Maximum Print Area determines 
the printable area that will be assigned to the job. Typically it is 
the page size of the media loaded into the printer. 

3. Click OK.
4. Change the width, height, or magnification of your image. 

When you modify one value, the other values will change to 
maintain the image proportions. If you want to lock any value, 
click the Lock box next to the value.

Rotating Your Image
You can rotate your image by 90° increments using the Image Setup area 
of  the Preview and Size tab. To rotate an image, select the rotation you 
want to use, and click Apply. You can also flip an image by selecting Im-
age Flip (see Figure 4).

Tiling Setup Tab
The Tiling Setup tab in Preflight lets you set tiling options. Tiling sepa-
rates a job into two or more pieces and lets you print an image larger 
than your page size or break an image into specific sizes for display or 
mounting purposes. 

If  you want to create an image larger 
than your page size, enable Tiling in 
the Tiling tab. See the Tiling section of  
this chapter for more information.

Figure 4—Rotate or Flip an Image

Figure 3—Crop Using Origin and Size Values

Experiment with locking and unlocking 
the value checkboxes to see what different 
effects you can create. You can lock more 
than one box at a time.

Rotating and flipping images can take 
several minutes depending on the size 
of  the file. 



Enabling Tiles
To enable tiles, select the Tiling Setup tab, and check the Enable Tiling 
option. Activating this option allows you to choose any width for your im-
age. If  you disable tiling, Preflight restricts the image to a single tile where 
the maximum width is equal to the Maximum Print Area selected for your 
job. You can set the tile width and height in the Default Tile area by enter-
ing values into the Width and Height fields or using the down arrows. 

Printing with Tiles
If  tiling is enabled and your output exceeds the maximum print width or 
height of  your printer, the program will automatically break the image 
into tiles. Because each tile is considered a separate piece, you can print 
or re-print any tile you want. You can even process tiles individually by 
clicking the Rip Tiles Individually checkbox.

To print specific tiles:
1. After enabling and setting up your tiles, click Tile Setup from the 

Print tab. This opens the Tiles dialog.
2. Select the tiles you want to print, and click OK (see Figure 5). By 

default, all the tiles are selected for printing. 

Adjusting Tiles
When you choose a print size larger than the maximum page size for 
your printer, the image preview displays dotted tile lines inside the image. 
You can adjust these lines to create tiles of  varying size. Making adjust-
ments to a single tile affects all the tiles in that same row or column. 

To create custom tiles:
1. In the Tiling Setup tab, enable Tiles, and click on the tile you 

want to adjust.
2. In the Custom Tile area (see Figure 6), enter the new Width and 

Height values for the tile. You can also click on the tile line in the 
image and drag it to a new location.

If  you want to cancel any adjustments, click Reset All Tiles at the bot-
tom of  the Tile Setup tab. This restores all tiles to the default values 
listed for the Default Tile. 

Overlapping Tiles
You can set tiles to overlap between connecting tiles. This adds a repeat-
ed portion of  the image between the tiles and makes it easier to properly 
align the printed tiles.
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Figure 5—Tile Dialog

Remember that changing a tile line af-
fects all the tiles in that row or column.

Figure 6—Custom Tile
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Overlap has the following attributes:
• Applies to every tile
• Works the same both vertically and horizontally
• Is applied when the image is printed
• Available only if  the image has more than one tile
• Does not affect tile size; tiles are measured from the center of  the 
overlap to the center of  the next overlap.

To set an overlap:
1. In the Tiling Setup tab, select the Overlap option (see Figure 7).
2. Enter the overlap value, or use the up and down arrows to set 

your value. 

The overlap is divided equally to both sides of  the tile. If  you set your 
overlap to one inch, each inside edge of  the tile will print half  an inch of  
the adjoining tile. Outside edges will have no overlap.

Setting Weld Overlap
Welding is the process by which tiles are joined together. This can be-
come difficult if  there is ink on the portion of  the media you want to 
weld because the ink inhibits the adhesive from making a perfect bond. 
The Weld Overlap option reserves a small portion of  the overlap area as 
blank and does not place any ink in this area. This leaves a clean surface 
on which to apply the welding adhesive.
You can activate Weld Overlap by selecting the Weld Overlap option in 
the Tiling tab. 

Color Correction Tab
The Color Correction tab allows you to adjust the color in your image us-
ing several tools: Primary Color Levels, Color/Gray Levels, White/Black 
Limits, Color Replacement, and Spot Layer. It also allows you to apply 
color correction filters and view different color correction options.

Primary Color Levels
The Primary Color Levels tool allows you to modify the amount of  satu-
ration each primary color channel uses. You can access this tool by click-
ing Tools in the Color Correction tab and then selecting Primary Color 
Levels. 

Figure 7—Overlap

Weld Overlap is only available if  your 
overlap is set to at least half  an inch.



Adjusting Saturation

You can adjust the saturation of  each primary color channel by mov-
ing the saturation sliders left or right (see Figure 8). This tool modifies 
the values in the mid-range more than those at the extreme high or low. 
This creates a smooth curve that bows from the normal values. As you 
modify each saturation value, your preview image will change to reflect 
your modifications.

Primary Color Curves

The Primary Color Curves tool allows you to modify the amount of  ink 
printed at any specific level. This differs from the Color Levels tool in 
that Color Curves lets you modify specific areas of  color such as high-
lights and shadows. Color Levels on the other hand affects the entire 
range of  color equally. Click Primary Color Curves in the Color Cor-
rection tab to open this tool (see Figure 9). This tool displays a curve for 
each primary color. 
The two axes for CMYK color correction curves represent input and 
output color densities. The x-axis represents input density and the y-
axis represents output density. These values, based on the location of  
the cursor, are shown above the curve window as Before and After values 
respectively. 

To modify a Primary Color Curve:
1. In the Edit Channel window, mark each color that you want to 

modify. You can modify multiple colors at the same time, or you 
can modify individual colors (see Figure 9).

2. Click and drag in the curve window to create your curve. Depend-
ing on your settings, you can create several types of curves. For 
more information on Primary Color Curves see Online Help at 
http://help.onyxgfx.com/x10/preflight

Color/Gray Levels
The Color/Gray Levels tool allows you to adjust the color composition 
of  an image by altering the contrast, brightness, and saturation of  your 
colors and the highlights, mid-tones, and shadows of  your grays. Click 
Tools in the Color Correction tab and then select Color/Gray Levels 
to open this tool (see Figure 10).

Color Levels

Color Levels allow you to modify the attributes of  all the colors in your 
image. These controls are similar to the controls on your television set. 

22 Preflight—User Guide

You should not use the Primary Color 
Curves tool for color replacement.

Figure 9—Primary Color Curves

Color/Gray Levels only modify the K 
value of  a color sample. If  there is no 
K present, this tool will have no effect.

Figure 8—Saturation
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They do not change the actual color, but they can shift the color from 
light to dark and dark to light. There are three controls: Contrast, Bright-
ness, and Saturation.

• Contrast—this control adjusts the contrast of  your image, mak-
ing darks darker and lights lighter. Increasing the contrast increases 
the difference between your dark and light values; decreasing the 
contrast decreases the difference. 
• Brightness—this control adjusts the brightness of  your image by 
changing the amount of  K in all the colors of  your image. Increas-
ing the brightness lowers the amount of  K; decreasing the bright-
ness raises the amount of  K.
• Saturation—this control adjusts how much color there is in your 
image. Increasing the saturation adds more color to your image; de-
creasing the saturation reduces the amount of  color. This tool does 
not affect the amount of  K in your image.

To modify Color Levels:
1. Click Tools > Color/Gray Levels in the Color Correction tab. This 

opens the Color/Gray Levels tool (see Figure 10).
2. In the Color Levels area, click and drag each value to your de-

sired value, or enter the value into the value box.

Gray Levels

Gray Levels allow you to modify the K level of  an image in three differ-
ent ranges: highlights, mid-tones, and shadows, by changing the amount 
of  K in an image. 
Increasing the value increases the amount of  black; decreasing the value 
decreases the amount of  black.

• Highlights—this control adjusts the amount of  black in the light-
er tones of  your image.
• Mid-Tones—this control adjusts the amount of  black in the mid-
dle tones of  your image
• Shadows—this control adjusts the amount of  black in the darker 
tones of  your image.

White/Black Limits
The White/Black Limits tool lets you clean up your image without intro-
ducing contrast. This tool was developed primarily to clean up scanned 
images. When an image is scanned, the white and black values do not ap-
pear as true white and black. Setting White/Black Limits fixes this prob-

Figure 10—Color/Gray Levels



lem and balances the other colors. Because White/Black Limits control 
the lightness of  the color value averages instead of  controlling the inks, 
this tool uses RGB values instead of  CMYK.

Color Limit

The Color Limit tool automatically sets the White and Black limits from 
a selected color range (see Figure 11). Click Tools in the Color Correc-
tion tab and then White/Black Limits to open this tool. Select the 
Color Limit option and click the A button. This will automatically set 
the Color Limit. You can also adjust the color limit by entering values 
into the number boxes, or by using the up and down arrows.
Clicking the A button takes the average of  all RGB values in the image 
and moves the white and black points in 5% of  the total pixels in the im-
age. This means that the lightest 5% of  pixels are all set to white, and the 
darkest 5% of  all pixels are set to black, effectively reducing the gamma 
range by 10%.

White Limit

The White Limit lets you manually set the white point of  your image by 
selecting the pixels in your image that best represent white (see Figure 
12). Click Tools in the Color Correction tab and then White/Black 
Limits to open this tool. Select the White Limit option, and click the 
Sample button. With your cursor, click the lightest point of  your image 
or on a color that you want to make the lightest point. This will change 
all the colors equal to or lighter than the color you selected to white. You 
can also modify the White Limit by entering values into the R, G, and B 
boxes, or by using the up and down arrows.

Black Limit

The Black Limit lets you manually set the black point of  your image by 
selecting the pixels in your image that best represent black (see Figure 
13). Click Tools in the Color Correction tab and then White/Black 
Limits to open this tool. Select the Black Limit option, and click the 
Sample button. With your cursor, click the darkest point of  your image 
or on a color that you want to make the darkest point. This will change 
all the colors equal to or darker than the color you selected to black. You 
can also modify the Black Limit by entering values into the R, G, and B 
boxes, or by using the up and down arrows.
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The Color Limit, Black Limit, and 
White Limit tools are additive tools. If  
you use these tools together, your image 
can become much darker or lighter than 
intended. 

Figure 12—White Limit

Figure 13—Black Limit

Figure 11—Color Limit
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Color Replacement
The Color Replacement tool allows you to change the colors of  a job 
by substituting one color for another (see Figure 14). Click Tools in the 
Color Correction tab and then Color Replacements to open this tool. 
For more information see Online Help at http://help.onyxgfx.com/
x10/preflight

Spot Layer Tool
The Spot Layer Tool allows you to use Specialty Inks such as White 
ink. You can also use this tool for Knockouts. Click Tools in the Color 
Correction tab and then Spot Layer Tool to open this tool. For more 
information see Online Help at http://help.onyxgfx.com/x10/preflight

Filters
A color correction filter is a file that modifies the color of  a job. Think of  
a filter as a pane of  colored glass—if  you place it on top of  the image, it 
changes the colors in the image.
A job can only have one color correction filter applied, but that filter can 
contain multiple filters. Each filter can have one or more color correction 
tools. If  it has none, it is an empty filter. 

To create a filter:
1. Click File > Filter Manager (see Figure 15).
2. Click New.
3. Enter a name for your filter.
4. Click Close.

Print Tab
Print Setup
Print Setup allows you to set Workflow, Marks, and Output options. These 
options determine how the program will process and print your jobs. To 
access these options, select the Print tab, and click Print Setup.

Setting Workflow Options
Workflow Options allows you to set the following workflow options (see 
Figure 16):

After Processing

• Delete Source Image—this option deletes the source image after 

Figure 14—Color Replacement

Figure 16—Workflow Options

Figure 15—Filter Manager

An empty filter is automatically created 
when a job is first opened in Preflight.



processing. This does not delete the job, and you can still reprint the 
job. However, you cannot reprocess the job.

After Printing

• Archive Job as Space Allows—this option moves printed jobs 
to the Recycled Jobs area. These jobs will be deleted as needed to 
obtain additional hard disk space to process incoming jobs.
• Archive Jobs Indefinitely—this option moves jobs to the Re-
cycled Jobs area. Even if  additional hard disk space is required, ar-
chived jobs will not be deleted.
• Delete Jobs—this option automatically deletes jobs after they are 
printed. You cannot retrieve, restore, or reprint deleted jobs.

Job Creation

• Preview Image Before Processing—this option automatically 
creates a preview of  your jobs before they print. 
• Make Copy of  Image—this option copies the source file to the 
work folder instead of  referencing the location of  the image. If  you 
are dealing with extremely large files, you may want to disable this 
option.
• Create Proof  Automatically—this option automatically sends a 
copy of  the job to a different printer as a proof. To use this feature, 
you must have the Proof  Workflow feature on your Hardware Key, 
and you must configure a proofing printer. Contact your sales rep-
resentative if  you do not have this feature.

Process/Print Options

• Reprocess—this option reprocesses the job each time it is printed.
• Print—this option prints the job without reprocessing.

Operator

• Hold for Operator—this option will stop a job from printing un-
til an operator chooses to print the job. Each job will appear in the 
Jobs Ready to Print area of  the program with a hold status. You can 
print the job by highlighting it, and clicking the Hold icon.
• Default Operator Name—this option allows you to set user 
names for each job. RIP-Queue displays the user name in the User 
column of  the queue. If  you have multiple users sending jobs from 
various systems, this helps you determine where each job is coming from.
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Figure 17—Marks Options

For more information on proofing, see 
the Online Help at 
http://help.onyxgfx.com/x10/
preflight
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Marks Options
Marks are special lines that print with the image to aid in trimming or 
measuring the final output. The Marks option also lets you set Print La-
bel options (see Figure 17). 

Registration Marks

Registration Marks print a crosshair at each corner of  the image. These 
help ensure that the image is straight on each side when trimming.

Tile Dotted Overlap

Tile Dotted Overlap marks are used when tiling an image with an over-
lap. These marks show where the overlap begins and ends to help you 
combine tiles easily. When piecing the tiles together, the Tile Dotted 
Overlap Mark of  one tile overlays the corresponding mark on the adja-
cent tile. 

Zero-Line Tile Marks

Zero-Line Tile Marks print a black crosshair with a white inner portion 
in the middle of  the tile overlap area (see Figure 18).

Crop Marks

Crop Marks are quarter-inch right-angle marks that are placed on the 
edges of  each corner of  the image. Because that same area is used for 
Registration Marks, Crop Marks do not have any effect if  you are already 
using Registration Marks (see Figure 19).

Crop Outline

Crop Outlines are a solid line (1 pixel wide) printed on the border of  an en-
tire image. Because Crop Outlines use the same area as Crop Marks, Crop 
Marks do not have any effect when using Crop Outlines (see Figure 20).

Print Label

The Print Label option allows you to print job information at the end of  
the printed image. For example, the print label can contain information 
such as the date when the job was processed and printed; the type of  
ink, media, media configuration, and resolution; and the name of  the file. 
Check the Use Large Text option to print the label using 22.5 pt. font 
instead of  the default setting of  7.5 pt.

Figure 18—Zero-Line Tile Marks

Figure 19—Crop Marks

Figure 20—Crop Outlines

For more information on the Print La-
bel and Contour Cutting features, see 
Online Help at http://help.onyxgfx.
com/x10/preflight



Contour Cut Paths

Enable the Generate Tile Outline Cut Paths checkbox to cut around the 
border of  an image. The Trim Overlap option cuts on the Zero-Line Tile 
Mark if  you have tiled your image using an overlap. These features only 
apply if  you are using a contour cutting device.

Output Options
The Output tab controls how RIP-Queue processes jobs. This tab is di-
vided into three sections: Output, Image, and Processing (see Figure 21).

Output
The Output section determines the type of  image output that RIP-
Queue processes. You can choose any of  the following options:

• Color—this option, the default, creates color output.
• Grayscale—this option creates black and white output using only 
the black channel of  your printer.
• Separations—this option creates a black and white representa-
tion of  each color channel. If  the primary color setup is CMYK, 
Separations will print four images; if  you configure your media for 
CMYKOG, Separations will print six images.

Image
The Image section allows you to print the job as a mirror image of  the 
original file. This option is typically used when printing on backlit or 
transparent media.

Processing
The Processing section allows you to control how the image is processed.

• Perform Image Processing During Print Stage (Rip & Print 
on the Fly)—this option processes the image while the data is be-
ing sent to the printer. If  you disable this option, the image will be 
processed first and then sent to the printer. Use the Print Jobs Indi-
vidually placement strategy when this feature is enabled.
• Process with Interpolation—this option softens jagged edges 
of  low-resolution images. Although this option will not adversely 
affect high-resolution images, it does increase the processing time.
• Process to allow rotation during print stage—This option au-
tomatically rotates images for a job to create the best fit to save 
media.
• Calculate Ink Usage—this option calculates the amount of  ink 
that is used for a job

28 Preflight—User Guide

Printing in Grayscale can create a 
speckled appearance to your image. To 
fix this, convert your image to grayscale 
using an image editor program and then 
print it using the Color output option.

Processing options are only available if  
you are modifying a raster image.

Figure 21—Output Options
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• Bit Depth combo box allows you to select the processing method 
you would like to use. In most situations 8-bit processing provides 
good results, however, 16-bit processing gives noticeable improve-
ment in large images with a gradient in one color over a large area. 
For more information on different processing methods please see 
Edit Quick Sets section of  this Guide or Online Help at 
http://help.onyxgfx.com/x10/rip-queue

Manage Printers
Because Preflight does not print directly to a printer, use Printer Manager 
to add or delete RIP-Queue printers for use by Preflight. Click File > 
Printer Manager to open the Printer Manager (see Figure 22).
When you install printers, RIP-Queue automatically adds printers to Pre-
flight. Use Printer Manager to add RIP-Queue printers from a remote 
system, or to re-add printers that have been previously deleted.

To add a printer:
1. In the Printer Manager, click Connect. This opens the Browse 

Printers dialog.
2. Browse to the Input folder for the printer you want to add, high-

light the name of the printer, and click Add (see Figure 23).

To delete a printer:
1. In the Printer Manager, click Delete. This will remove the printer.
2. Click Close.

Deleting a printer from Preflight does not remove that printer from 
RIP-Queue. However, deleting a printer from RIP-Queue removes the 
printer from Preflight.

Figure 22—Printer Manager

Figure 23—Browse Printers

Adding a printer is not the same as 
installing a printer. To learn how to 
install a printer, see chapter 1.
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Objectives
This chapter briefly describes the new X10 Media Manager. By the end of  
this chapter, you will have a basic understanding of  the following:

• Overview of  the Media Manager
• Purpose of  the Media Manager

What is Media Manager?
Media Manager is a set of  tools for creating, modifying, analyzing and 
managing the media and print modes used in your printing workflow. 
Media Manager provides quality and consistency by offering a system of  
controls for your ink and media configurations, calibration, and profile 
management. It provides more than just a simple solution to consistent 
color, it allows you full control over managing your output.
You control your output through two main functions: Calibration and 
Profiling. 

• Calibration is the process of  synchronizing the media, ink, resolu-
tion, and dot pattern combination for your printer to ensure con-
sistent output.
• Profiling establishes your target output’s density and color to en-
sure the highest quality prints.

Although the initial setup may take time, improved default settings make 
maintaining good color simple and fast. 
Media Manager allows you to control the following functions:

• Manage Media—create new media and modify existing ones.
• Manage Modes—set the ink type and configuration used by your 
media and printer.
• Configure Printer Capabilities—control the use of  dot patterns 
and resolutions as well as enable the use of  additional ink colors.

In addition, Media Manager gives you absolute control over your color 
through profiling. Profiling involves going through a series of  four basic 
steps to create a profile. These steps set the Ink Restriction, Calibration, 
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Ink Limit and ICC Profile for the media. 
• Ink Restriction—ensure that the proper amount of  ink is placed 
on the media and prevent over-saturation of  ink combinations.
• Calibration—determine the exact ink density for your printer.
• Ink Limit—prevent over-saturation of  four-color combinations.
• ICC Profile—use or create specific color information for each 
media, ink, resolution, and dot pattern combination.

Media Manager provides further output control by supporting the fol-
lowing:

• Create Screens for Press Proofing—customize screen dot pat-
terns for color proofs and dot simulation.
• Import and Export ICC Profiles—use ICC Profiles from other 
applications or import and export previously created ICC Profiles.
• Manage Color Measurement Devices—select from an exten-
sive list of  supported color measurement devices. 
• View Measurement Data—view one or more patch measure-
ments as Spectral or Colorimetric  plots (Status T Density, Spectral, 
L*a*b*, L*c*h*). 

The New Media Manager
In the past, profiling had the potential to consume a lot of  time and ma-
terial. In Media Manager X10 the workflow has been simplified to reduce 
the waste of  time and material by including device appropriate default 
settings, adding software assisted Ink Restrictions, and allowing uninter-
rupted access to printer configuration settings while profiling. 
In X10 Media Manager all advanced settings are automatic, but option-
ally configurable, and are clearly identified with a black diamond (Figure 
2). In many cases profiling is as easy as Print, Read, Next. 
X10 Media Manager has improved step-by-step help (Tips) as well as 
improved Online Help (http://help.onygfx.com/x10/mediamanager)
If  you do not have Media Manager, contact your sales representative for  
a Key Update.
You can open Media Manager by clicking Media Manager on the RIP-
Queue toolbar.

Ink density is the intensity of  ink in 
one area. It can be affected by resolu-
tion, dot pattern, and ink restrictions.

Figure 1—Media Manager 

Figure 2—Black Diamond Icon



Workflow & 
Hardware Key
Objectives
This chapter will take you through how an image is printed and discuss 
your Hardware Key. By the end of  this chapter, you will have an under-
standing of  the following:

• ONYX Workflow
• Hardware Keys

What is the ONYX Workflow?
Workflow is the process an image follows from the original file to the 
printed job. RIP-Queue uses many different ways to reach those results, 
and although the end result is a printed image, your actual workflow de-
pends on the type of  printer, desired output, and the image itself.
The most basic workflow is opening an image in RIP-Queue and print-
ing (see Figure 1). Of  course, the actual process of  how images become 
ready for printing is much more intricate. 
Before you can print an image, you need to provide specific information 
to RIP-Queue about how the image should be printed. Following are 
several questions that should be answered:

• What size should the printed image be?
• What resolution should the final output have?
• What type of  media will the printer use?
• Should the image use ICC profiles?

These and similar questions (known as Job Settings) determine how an 
image is printed. Once your image has job settings, RIP-Queue can pro-
cess it and send it to the printer (see Figure 2). 
Following is an explanation of  each step in a basic workflow process. 
These and other topics are covered in greater detail throughout this man-
ual and Online Help at http://help.onyxgfx.com/x10/rip-queue

Original Image File
An original image file is only an image file and has no RIP-Queue set-
tings associated with it (see Figure 3). Before RIP-Queue can use the 
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Figure 1—Simple Workflow

Figure 2—Detailed Workflow

Figure 3—Original Image File



image file, you must define those settings. You can apply those settings 
using Quick Sets.

Quick Sets Apply Settings
In a basic workflow, a Quick Set applies the job settings, but you can 
change these options manually if  you want (see Figure 4). Whenever a 
job enters RIP-Queue, a Quick Set is applied to the image even if  it is 
only the generic Default Quick Set. Because different types of  images 
need to be processed differently, you can create Quick Sets to match 
your needs.

Images with Settings Become Jobs
After the Quick Sets are applied, the image file becomes a job (see Figure 
5). A job is an image combined with the RIP-Queue settings necessary to 
print the image. When you apply settings to a job, the image itself  is not 
modified, but the job is. Once the image becomes a job, it is moved into 
RIP-Queue where it is ready to be processed.
If  you need to modify any of  the job settings, this is the most efficient 
time to do it. While you can modify a job after it has been processed, you 
will need to reprocess the job for the changes to take effect.

Processing Jobs
The job settings determine how each job is processed (see Figure 6). 
Processing a job can take several minutes depending on the job settings 
and the original source file. For example, an image that is 2” by 3” would 
take only a few seconds to process, but an image that was 200” by 300” 
would take much longer. 

Ripping

The method by which jobs are processed is called Ripping. The word 
RIP is an acronym that means raster image processing or raster image proces-
sor. Raster data, a collection of  dots that make up an image, is the type 
of  data that is sent to the printer. When a job is processed, the original 
image data is read and output data (processed data) is created according 
to the job settings.

PostScript Files

PostScript files (*.ps, *.eps, and *.pdf) are different than raster files 
because they are not comprised of  pixels or dots. Instead, they are a 
set of  instructions that describe how to create raster data. When Post-
Script files are processed, they are read instructions first. This is called 
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Figure 4—Quick Sets

Figure 5—Image with Job Settings

Figure 6—Processing Jobs

Raster files must still be ripped because 
the processed raster data is different 
than the original raster data. 



interpreting. After the file is interpreted, RIP-Queue then creates raster 
data—rendering.

Ready to Print
Once RIP-Queue processes the job, it is ready to print (see Figure 7). 
At this stage in the workflow, you can still modify the job settings, but 
certain job settings, like media, page size, and resolution, require that you 
reprocess the job for the changes to take effect. Other job settings, like 
number of  copies, can be modified without reprocessing.

Printing Jobs
By default, images are printed in the order they are received (see Figure 
8). Therefore, a job cannot print until the previous job finishes printing. 
Depending on your settings, a job may wait until other jobs are also ready 
or until you manually start the printing. You can configure the printer to 
start printing automatically, when a certain percentage of  the media is 
used efficiently, or when a time-out value has passed.

Reprinting Jobs
Once RIP-Queue prints the job, it moves the file to the Buffered Jobs 
area of  the queue (see Figure 9). You can reprint jobs in this area at any 
time, or you can modify the job, reprocess it, and then print.
Because the processed data has been created for files that were printed, 
you can reprint a job at any time using the same processed data. Once 
RIP-Queue creates the process data, you can even print jobs that no 
longer have the original source image. However, you can only reprocess 
a job if  you still have the original source image.

Hardware Key
The Hardware Key determines the actual functions and features you can 
use in your program. The Key is a physical plug that came with your 
software (see Figure 10). Your Key contains information that specifies 
exactly which features, printers, and capabilities you are able to use.

Updating Your Hardware Key
If  your Key does not list the features or printers that you want to use, 
you can get a Key Update File from your sales representative. A Key Up-
date is a small file that adds permissions to your Hardware Key. 
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Figure 7—Ready to Print

Figure 8—Printing 

Figure 9—Reprinting

Figure 10—Hardware Key

For information on checking your 
Hardware Key permissions, see the 
Introduction to this manual.



To update your Key:
1. Run WinKey by choosing What’s On My Key from the Windows 

Start menu.
2. Click File > Update.
3. Browse to the Key Update File (extension *.key).
4. Select the Key Update File, and click Open. 

If  the Key Update adds a new feature or capability, you may need to re-
install the software for that feature or capability to take effect. If  the Key 
Update only adds permissions for an additional printer, you only need to 
install the new printer.
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Objectives
This chapter will take you through printing. By the end of  this chapter, you 
will have an understanding of  the following:

• How jobs are printed
• Placement Strategies
• Job Management

When are Jobs Printed?
RIP-Queue is designed to print your jobs automatically once certain con-
ditions are met. These conditions include making sure you are using the 
correct media, ensuring that the printer is online and not currently print-
ing, and making sure that all holds are turned off. If  any condition is not 
met, the job will not print. 

Holds
RIP-Queue will not print jobs that are On Hold. A Hold lets you review 
a job before it is printed. After it is reviewed and modified, you can re-
move the Hold.

To change the Hold status of a job:
1. Highlight one or more jobs in the Jobs Ready to Print area.
2. Click the Hold button (the hand icon). This will remove the Hold 

and, if all other conditions are met, print your image.

Media
Every job has a media associated with it. The media controls the output 
profiles and printer settings and is the most important job setting besides 
the printer itself. 
Every printer also has a media associated with it. The media associat-
ed with the printer represents the media that is physically loaded in the 
printer. Because your software will print automatically, make sure that the 
media designated in RIP-Queue matches the media that is actually in the 
printer. Failure to do so can cause your jobs to print on incorrect media. 
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If  the media for the job and the media for the printer do not match, 
RIP-Queue will not print the job. The job will have a Wait for Media 
status (see Figure 1). Once you change the media so they match, your 
job will print.

To change the media for a printer:
1. Highlight the printer in the Printers List area of the program 

window.
2. Click Change in the Printer Information area on the right-side of 

your screen. This opens the Change Media and Placement dialog 
(see Figure 2).

3. Use the drop-down menus to select the Media that is currently 
loaded into your printer.

4. Click OK.

To change the media for a job:
1. Highlight the job in the job list to display the job settings in the Job 

Information area of the RIP-Queue window.
2. Click Change on the right-side of your screen. This opens the 

Job Properties dialog (see Figure 3).
3. Change the Media Configuration Name and Media to match the 

media that is currently loaded into the printer.
4. Click OK.

Page Size
Each image is processed for a specific page size, and a job will not print 
if  the page size is equal to or smaller than the page size currently loaded 
in the printer.
The Maximum Printable Area of  a job does not need to be the same as 
the page size of  the media in the printer, but the width and height of  
the job does need to fit on the page. Tiling lets you print a larger image 
than your page size by splitting your image into smaller pieces. For more 
information on Tiling, read the Tiling section in the Preflight chapter, or 
see Online Help at http://help.onyxgfx.com/x10/preflight 

Printer Online
The printer must be online before RIP-Queue can print a job. A green 
icon in the Printer Information area indicates a printer is online; a red 
icon indicates that it is offline. A yellow icon indicates that a printer is 
currently printing. Once it finishes, it will go into an online state. Use the 
online/offline button next to the green or red icons to change the state 
of  the printer.

39

Figure 1—Wait for Media

Changing the media for either your 
printer or job sets a Wait for Media 
hold. Release the hold to print.

Figure 2—Change Media and Placement

Figure 3—Job Properties



Triggering
Triggering is the method by which you allow jobs to print. There are two 
types of  Start Print triggers: Manual and Automatic.

• Manual Triggering—this option delays printing until you click 
the Print Now button in the Printer Information area.
• Automatic Triggering—this option automatically prints jobs 
based on the percentage of  the media that will be used or a time-
out setting. You can also use the Print Now button to override any 
delays.

To modify the triggering method:
1. Highlight the printer with the triggering method you want to change.
2. Click Change in the Printer Information area on the right-side of 

your screen. This opens the Change Media and Placement dialog 
(see Figure 2).

3. Click Setup. This opens the Placement Strategy dialog (see 
Figure 4).

4. Check or uncheck the Automatically Start Printing option.
5. Click OK.

How Are Jobs Printed?
There are two sets of  criteria that control how jobs are printed: Job Op-
tions and Printer Settings.

Job Options
Job Options control settings that are specific to each job. This includes 
resolution, media, page size, tiling, marks, and other settings.
Job Options do not affect where the job prints on the media, neither do 
they determine whether the job is nested or grouped with other jobs. 

Printer Settings
Printer Settings control settings that apply to the jobs collectively. For 
example, they control where jobs print on your media and whether they 
are nested, grouped, or printed with cutter marks. The main printer set-
tings are media currently in the printer, page size currently in the printer, 
and placement.

To access the printer settings:
1. Highlight your printer.
2. Click Change to open the Change Media and Placement dialog. 
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Figure 4—Placement Strategy

For more information on Job Options, 
read the Job Options section of  the 
Managing Jobs chapter, or see Online 
Help at http://help.onyxgfx.com/
x10/rip-queue



The Media Configuration Name, Media, and Page Size should always 
match the ink and media currently in your printer. The Placement option 
controls the placement and grouping (nesting) of  your jobs. There are 
five placement options to choose from. 

• BestFit
• Conserve Media
• Group Jobs Together
• Print Jobs Individually
• Fotoba & Dicus Cutter Marks

Included with the Placement option are other settings that are specific 
to the type of  Placement option you select. These settings control the 
positioning and grouping of  jobs. 

To modify the Placement specific options:
1. Highlight the printer.
2. Click Change to open the Change Media and Placement dialog. 
3. Choose a Placement setting.
4. Click Setup. This opens the Placement Strategy dialog (see 

Figure 4).
5. Modify the options you want to change, and click OK.

RIP-Queue retains the configuration for each Placement setting, allow-
ing you to switch Placement settings without reconfiguring the Place-
ment specific options each time. The Placement settings and the Place-
ment specific options are also printer specific. In other words, changing 
the Placement or Placement specific options for one printer will not 
change those settings for your other printers. 

Placement Strategies
Each Placement Strategy uses different algorithms and options that pro-
vide various workflow solutions for different situations. The primary 
difference between each option is speed and unused media. Generally 
speaking, if  you need to print faster, you will include fewer jobs and have 
more unused media. However, if  you can delay printing until multiple 
jobs are processed and ready to print, RIP-Queue can organize them to 
effectively use more media.

BestFit
The BestFit placement strategy conserves the most media, but may be 
your slowest option. BestFit automatically places jobs to use the most 
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media possible. RIP-Queue re-arranges and rotates the jobs when neces-
sary. Every time a new job enters RIP-Queue, this strategy rearranges the 
entire nest to better fit the new job with the existing jobs. Use BestFit if  
you want to save the most media and do not need to print jobs on a strict 
priority (first in, first out) basis.

Conserve Media
The Conserve Media placement strategy is very similar to BestFit with 
some exceptions. Conserve Media does not rotate images for better 
placement. Conserve Media also prints on a row-based system where the 
largest image in a horizontal row determines the maximum height any 
image in that row can be. On the other hand, BestFit does not use rows. 
RIP-Queue rearranges the jobs when necessary. Every time a new job 
enters RIP-Queue, the Conserve Media strategy re-arranges the entire 
nest to better fit the new job with the existing jobs. Use Conserve Media 
if  you want to save media and do not need to print jobs on a strict prior-
ity basis.

Group Jobs Together
The Group Jobs Together placement strategy places jobs side-by-side to 
use more media, but does not rearrange the order of  the jobs as does 
the Conserve Media placement. Use Group Jobs Together if  you want to 
save media and need to print jobs on a strict priority basis.

Print Jobs Individually
The Print Jobs Individually placement strategy prints only one job at a 
time. Use Print Jobs Individually if  you do not want to save media and 
need to print jobs on a strict priority basis.

Fotoba & Dicus Cutter Marks 
Use this strategy to print your images with Fotoba & Dicus Cutter Marks. 
This strategy will conserve as much media as possible, but also creates 
spacing between the images for the Marks. Use this option if  you need 
to print your images with Fotoba & Dicus Cutter Marks.

Modifying Placement Options

Each placement strategy offers a variety of  Placement Options. 

To modify the Placement specific options:
1. Highlight the printer.
2. Click Change to open the Change Media and Placement dialog. 
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3. Choose a Placement setting.
4. Click Setup. This opens the Placement Strategy dialog (see 

Figure 4).
5. Modify the options you want to change, and click OK.

Following is a description of  the available options for each strategy. 

Print Triggering

Print Triggering controls when RIP-Queue sends the jobs to the printer. 
You can select Time Based Start, Area Based Start, or Automatically 
Start Printing, which is the default option.

• Time Based Start—this option forces RIP-Queue to wait a spec-
ified time before printing. 
• Area Based Start—this option forces RIP-Queue to wait until a 
specified amount of  media will be used before printing.
• Automatically Start Printing—this option sets RIP-Queue to 
automatically print a job as soon as it is processed.

Justification

The justification setting determines where the printer places the prints 
on the media. If  you are using a strategy that prints multiple images at a 
time, the justification applies to the group of  images.

Offset

The offset settings add extra white space to the left or top of  the printed 
jobs. If  you are using a strategy that prints multiple images at a time, the 
offset applies to the group of  images.

Printing Gutter

Printing Gutter determines the size and placement of  the gutter. Gut-
ters help make your color consistent by allowing heads to lay down each 
color of  ink on the media before passing over the print.

Flip every other tile

This option flips every other tile in an image 180 degrees

Print Multiple Rows at a Time

This option causes RIP-Queue to send all rows to the printer where it 
prints as one group.

Space Between Copies
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Not all strategies will have the same 
options, for instance, not all options 
are available when using Print Jobs 
Individually placement strategy.

Both Time and Area Based Starts 
can be overridden by clicking the Print 
Now button.



For more information on Quick Sets 
and Preflight, read the Quick Sets sec-
tion of  the Setup & Printing chapter 
and the Preflight chapter, or see Online 
Help at 
http://help.onyxgfx.com/x10/
rip-queue

Set a value for each side of  the image to determine how much white space 
RIP-Queue leaves between images.

Percent to cache before printing

This option allows you to set when the processed information is sent 
to the printer. When it is set to zero percent, information is sent to the 
printer as fast as it is processed. When it is set to 100 percent, information 
is not sent to the printer until the entire print is finished processing.

Cutter Mark Darkness

Select a value to set the darkness of  the cutter mark, where 1 is the light-
est and 4 is the darkest. 

Aborting a Print
To abort a print:

1. Highlight the printer on which the job is printing.

2. Click the Abort button in the Printer Information area of the RIP-
Queue window.

After you abort a print job, the printer automatically goes into an offline 
state. To turn the printer back online, click the Online/Offline button. 
When you abort a print, the jobs that were currently printing are sent to 
the Buffered Jobs area.

Reprinting a Job
After RIP-Queue prints a job, it sends the job to the Buffered Jobs area. 
If  the job is an Archive job, then it remains in the Buffered Jobs area 
until you delete it. If  the job is a Recyclable job, then RIP-Queue auto-
matically deletes it if  you do not have enough hard drive space to process 
new jobs. You can reprint both Archive and Recyclable jobs. The Quick 
Set controls whether a job becomes an Archive or Recyclable job.

To reprint a job:
1. Click and drag the job from the Buffered Jobs area to the Jobs 

Ready to Print area.
2. A dialog appears asking if you want to re-process the job. Click 

No unless you have modified the job in anyway that requires re-
processing. The job appears in the Jobs Ready to Print area and 
prints according to the Triggering method you’ve selected.
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It can take several minutes for a printer 
to cease printing when you abort a job.



Managing Jobs
Managing Jobs is the process by which jobs are modified in RIP-Queue. 
Many options cannot be set from RIP-Queue without using Quick Sets 
or Preflight. If  your software does not include Preflight, contact your 
sales representative for a Key Update.
You can modify the following options directly from RIP-Queue:

• Size (magnification)
• Media
• Number of  Copies
• Workflow Options
• Marks Options

Changing Size (Magnification)
When you open a job, RIP-Queue displays the size of  that job in the 
Buffered Jobs area (bottom left) of  your window (see Figure 5). This size 
is determined by the source file of  your image unless you use a Quick Set 
to modify the size automatically. You can also use RIP-Queue to modify 
the size of  your image after opening it in RIP-Queue.

To change the size of a job from RIP-Queue:
1. Highlight the job in RIP-Queue.
2. Click Change in the Job Information area. This opens the Job 

Properties dialog (see Figure 6). 
3. From the Basic Properties tab, enter a value in the magnification 

box, or use the up and down arrows to change the value. The 
new job size will show under the magnification value box. 

4. Click OK.

When you change the magnification of  a job, the Magnification value is 
reset to 1. For example, if  you change the magnification of  a 10” by 10” 
job to a value of  2, RIP-Queue reprocesses the job at the new size (20” 
by 20”) and sets the new size as a Magnification value of  1. To change 
the job back to its original size, you would enter a Magnification value 
of  .5.
If  you want to specify the exact dimensions of  the image, you must either 
set a Quick Set to determine the height or width of  the image before 
opening it in RIP-Queue, or you can edit the image in Preflight. 

Changing the Media
The media is shown in the Job Information area of  your screen (see 
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Figure 5—Buffered Jobs Area



The maximum number of  copies you 
can enter for a job is 9999. Changing 
the number of  copies does not require 
reprocessing. 
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Figure 5). The media setting is comprised of  two parts: the Media Name 
and the Media Configuration. The media name is the name of  the media 
itself. The Media Configuration (the portion shown in brackets) specifies 
the media or ink setup in the printer. 
The media of  your job must match the media of  your printer or it can-
not print. 

To change the media of a job:
1. Highlight the job you want to modify.

2. Click Change in the Job Information area. This opens the Job 
Properties dialog (see Figure 6).

3. From the Basic Properties tab, select the Media Configuration 
Name you want to use from the drop-down menu.

4. Highlight the Media Name you want to use. If the media name 
you want to use does not appear in the list, it may not be avail-
able with your media configuration, or it was not installed when 
you installed your printer. 

5. Click OK.

After you have changed the media for the job, RIP-Queue automatically 
reprocesses the job. Reprocessing ensures that the correct calibrations 
and profiles are associated with the media.

Changing the Hold Status
The Hold Status determines whether or not the job prints. If  a job is on 
hold, it will not print until you remove the hold.

To change the Hold status of a job:
1. Highlight your job in the Jobs Ready to Print area.
2. Click the Hold button (the hand icon). This will remove the Hold 

and, if all other conditions are met, print your image.

Changing the Number of Copies
RIP-Queue displays the number of  copies in the Basic Properties tab of  
the Job Information dialog (see Figure 6) and in the Copies column of  
the Jobs Ready to Print area of  your screen.

To change the number of copies of a job:
1. Highlight the job you want to modify.
2. Click Change in the Job Information area. This opens the Job 

Properties dialog (see Figure 6).

Figure 6—Job Properties Dialog

For more information on installing 
media, read the Installing Your Printer 
section of  the Setup & Printing 
chapter, or see Online Help at 
http://help.onyxgfx.com/x10/
rip-queue



3. From the Basic Properties tab, enter the number of copies you 
would like printed in the Copies value box or use the up and 
down arrows. 

4. Click OK.

Modifying the Workflow Options
Workflow Options allow you to control how RIP-Queue handles your 
jobs. These options are found in the Job Properties dialog under the 
Workflow tab (see Figure 7). For more information on Workflow Op-
tions, read the Setting Workflow Options section of  the Preflight chapter, or 
see Online Help at http://help.onyxgfx.com/x10/preflight

Modifying the Marks Options
Marks are special lines that are printed with an image to aid in trimming 
or measuring the final output. The Marks tab in the Job Properties dialog 
allows you to set these marks (see Figure 8). For more information on 
Marks Options, read the Marks Options section of  the Preflight chapter, or 
see Online Help at http://help.onyxgfx.com/x10/preflight

Controlling Jobs
Controlling Jobs helps you more effectively manage your workflow. You 
can control jobs in RIP-Queue in the following ways:

• Viewing a Job
• Changing a Job’s Order
• Sending a Job to Preflight
• Reprinting a Job
• Selecting Tiles to Print
• Changing the Printer Settings for a Job
• Copying a Job to a Different Printer
• Deleting a Job

Viewing a Job
Use the Show Jobs For drop-down box to control how jobs are viewed 
in the Jobs Ready to Print area of  your screen (see Figure 9). You can 
choose to view all jobs or just the jobs related to a specific printer.

Changing a Job’s Order
The arrow buttons on the left-side of  the Jobs Ready to Print area of  
your screen control the order in which jobs print (see Figure 10). You 
can change the order of  a job by highlighting it and then using the up 
and down arrows to change its position in the Queue. Jobs are organized 
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Figure 7—Workflow Options

Figure 8—Marks Options

Figure 9—Show Jobs For Option

Figure 10—Job Order



Figure 12—Printer Settings

by printer and then by order; you can only change the job order for each 
printer. If  you are using BestFit or Conserve Media, RIP-Queue ignores 
the job order. 

Sending a Job to Preflight
To send a job to Preflight, highlight the job and click Preflight on the 
main toolbar, or click Preflight in the Job Information area of  your 
screen. When a job is in Preflight, its status will display as Busy. It cannot 
be modified, processed, or printed until it is submitted from Preflight.

Reprinting a Job
To reprint a job:

1. Highlight the job in the Buffered Jobs Area of your screen.
2. Drag the job into the Jobs Ready to Print area, or right-click the 

job, and choose Process/Print.
3. When asked if you want to reprocess the job, click No unless you 

have modified the printer or job options.

Selecting Tiles to Print
To select which tiles you want to print:

1. Right-click the job to open the right-click menu.
2. Choose Edit > Tiles. This opens the Tile for... dialog.
3. Highlight the tiles you want to print (see Figure 11).
4. Click OK.

Changing the Printer Settings for a Job
To change the printer settings for a job:

1. Right-click the job to open the right-click menu.
2. Choose Edit > Printer Settings. This opens the Printer Settings 

dialog (see Figure 12).
3. Modify the Printer Settings you want to change.
4. Click OK.

Changing the printer settings can affect the color quality of  the job.

Copying a Job to a Different Printer
To copy a job to a different printer:

1. Right-click the job to open the right-click menu.
2. Select Copy to.... This opens the Copy to... dialog (see Figure 
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Figure 11—Tiles



13).
3. Select the printer you want to copy the job to.
4. Click OK.

Deleting a Job
To delete a job:

1. Highlight the job you want to delete.
2. Press the Delete key on your keyboard, or click the Delete button 

on the left-side of the job list. This will display a warning dialog 
(see Figure 14).

3. Click Yes to delete the job. 
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Figure 13—Copy Job Option

Figure 14—Delete Job



Virtual Printers & 
Other Systems
Objectives
This chapter discusses virtual printers, printing from other operating sys-
tems, and web printing. By the end of  this chapter, you will know how 
to do the following:

• Use Virtual Printers
• Setup non-Windows Operating Systems for printing
• Print using the Web Portal

Using the Virtual Printer
A virtual printer is a RIP-Queue printer that is used as a Windows printer 
(see Figure 1). When you install a RIP-Queue printer, RIP-Queue auto-
matically creates a Windows printer in the Windows Operating System 
for that device. When you print a job to that Windows printer, it sends 
the job to RIP-Queue for processing and printing. 
You can use any application to print to a virtual printer: graphic design 
programs, word processors, internet browsers, and so forth. Just choose 
File > Print in the application, and the application sends the image to 
RIP-Queue.
When RIP-Queue creates a virtual printer, it automatically shares the 
printer on the network. This means that any computer on the network, 
Windows or Macintosh, can print from any application to the virtual 
printer.

Printing from Other Windows Systems
To add the virtual printer to your Windows system:

1. From the Windows Start menu, access Settings > Printers > 
Add Printer.

2. Choose to add a Network printer and browse to the RIP-Queue 
system.

3. Install the printer.

Once you add the virtual printer to your printer list, you can print from 
any application directly to RIP-Queue by selecting Print from the File 

50 Virtual Printers & Other Systems—Advanced Guide

6

To use a virtual printer, you must have 
Hot Folders enabled on your Hardware 
Key.

Figure 1—Virtual Printers



menu. Be sure to choose the proper orientation, color options, and page 
size from the Printer dialog (see Figure 2).
To configure additional options for your virtual printer, such as the 
printer specific settings, click Advanced. This opens the Advanced Op-
tions dialog (see Figure 3). From the Advanced Options dialog, you can 
modify the following options:

• Page (Paper) Size
• Number of  Copies
• Resolution
• Scaling
• TrueType Font Handling
• Printer Features

Some features in the Advanced Option dialog may not have any effect 
when printing to a virtual printer. For example, RIP-Queue controls 
halftone creation for the image, so the Halftone Color Adjustment op-
tion in the Advanced Option dialog does not affect the color of  the 
printed image.
All of  the printer options (such as page size, dot pattern, and Hot Folder 
settings) are based upon a PPD (Printer Profile Description). A PPD is a 
small text file that describes the features and capabilities of  the printer.
Some settings controlled by the PPD, such as the Media and Hot Folder, 
can change when you modify your printer in RIP-Queue. Whenever you 
modify your printer by installing a new media, changing a Quick Set, or 
performing other similar tasks, RIP-Queue updates the PPD file auto-
matically. However, most programs obtain the printer information from 
the PPD file on startup. This means that if  you change your printer in-
formation, you should restart the programs from which you are printing 
to take advantage of  those changes.

Printing from a Mac OSX (10.2.8 or earlier)
To print from your Macintosh with OSX:

1. Verify that you have Windows/Macintosh connectivity capabilities 
(such as Windows 2000 Server or PCMacLAN).

2. If your Mac cannot access the RIP-Queue Mac PPD folder 
(ONYX Graphics\Production House\server\PPD\Mac), than copy 
the PPDs from the RIP-Queue Mac PPD folder to the Mac’s hard 
drive.

3. On the Mac, open Print Center to open the Printer List dialog 
(see Figure 4). You can find this application on the hard drive in 
the same location as OSX, under Applications > Utilities.
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Figure 2—Printer Dialog

If  you modify any settings that 
contradict a setting in the Quick Set, 
the Advanced Option setting takes 
precedence.

Figure 3—Advanced Printer Options

Figure 4—Printer List



4. In the Printer List dialog, click Add to display a secondary Printer 
List dialog.

5. Use the drop-down menu to select the protocol that your Mac 
connectivity package uses to share the printer (usually Apple-
Talk).

6. Select the appropriate printer from the list (see Figure 5).
7. Use the Printer Model drop-down menu to select ONYX Graph-

ics, and then choose the Model Name that corresponds to the 
printer name you want to install. If neither ONYX Graphics nor 
the appropriate Model Name appears, select Other for the Printer 
Model. Next, browse to the PPDS from the RIP-Queue Mac PPD 
folder (or from the Mac’s hard drive if you copied them there), and 
select the appropriate PPD for your printer from the Choose a 
File dialog (see Figure 6).

8. Verify that you selected the correct printer name and PPD, and 
click Add.

Printing from Mac OSX (10.3.x or higher) with 
Windows Printing
There are three major steps when printing from OSX to an ONYX Vir-
tual printer with Windows Printing: 

• Configure the network
• Establish a Virtual Printer share name
• Add the printer on Mac OSX

Configuring the Network

It is vital that the OSX machine and the PC in which your ONYX Graph-
ics software resides communicate. Configuring the Network ensures that 
communication across the network can occur. 

To configure the network: 
1. Look up the IP Addresses of both the OSX and PC machines 

(see the Finding IP Addresses section for more information).
2. Open a command prompt by clicking Start > Programs > Acces-

sories > Command Prompt.
3. Ping from the PC to see if there is communication between the 

OSX machine and the PC. To do this, in the Command Prompt 
window, type: ping <IP address of OSX machine>, then press 
Enter. You can also open a command prompt by clicking Start > 
Run…. In the Run dialog, type: cmd, and then click OK.

Finding an IP Address

An IP (Internet Protocol) Address consists of  four decimal numbers in 
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The Ping utility is a system adminis-
trator’s tool used to see if  a computer 
is operating and if  the network connec-
tions are intact. A small information 
packet is sent through the network to 
an IP Address. The computer that sent 
the packet waits for a response. If  the 
connections are good, a return packet 
is sent. If  there is no communication 
between the PC and Mac OSX, 
consult your network administrator for 
assistance.

Figure 5—Select a Printer

Figure 6—Select a PPD



the range of  0 – 255 separated by dots, such as 62.223.175.65. When you 
connect to a network, your PC/Mac may automatically issue a unique 
IP Address.

To locate a PC IP Address:
1. Open a command prompt window (Start > Programs > Acces-

sories > Command Prompt).
2. Type: ipconfig. 
3. Press Enter, then look for the output section that specifically says 

IP Address.

To locate a Mac OSX IP Address:
1. Pull down the Apple menu, and select System Preferences.
2. Choose Network.
3. In the Show drop-down list, select the network interface you are 

using.
4. Click the TCP/IP tab.
5. Locate the IP Address line.

Establishing a Virtual Printer Share Name

Creating a Share Name allows you to easily recognize the virtual printer 
when working from your Mac. 

To establish the share name: 
1. From the Start menu, select Settings > Printers and Faxes.
2. Right-click on the ONYX Virtual Printer, and select Sharing.
3. In the Virtual Printer Properties dialog, locate the Share Name 

field and change it so that it is no more than 12 characters long. 
Then, write down the name located in the Share Name field.

4. Click OK to accept your changes and exit the dialog.

Adding the Printer on the Mac OSX

The final step in the OSX/Windows Printing process is to add the print-
er to the Mac OSX. 

To add a printer to the Mac OSX:
1. On your PC, copy the PPD located in ONYX Graphics\Production 

House\Server\PPD\Mac.
2. Paste the PPD somewhere on your Mac. To do this, go to your 

Mac hard drive and choose Library > Printers > PPDs > Con-
tents > Resources > and select an appropriate language for the 
folder, such as choosing En.LPROJ for English).

3. On your Mac, open the Printer Utility. To do this, use the Finder 
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The Share Name cannot be longer than 
12 characters including spaces.



to select Go > Utilities > Printer Setup Utility.
4. Add a new printer.
5. Select Windows Printing from the first drop-down.
6. Select Network Neighborhood from the second drop-down list.
7. Select the Domain or Workgroup of which the ONYX RIP ma-

chine is a member (see Figure 7).
8. Select the name of the PC where the ONYX RIP resides.
9. Once the list of available virtual printers appears, select the 

printer you want to use, and click Choose.
10. From the Printer Model drop-down list, choose Other. Then 

navigate to the folder where you placed the correct PPD (this is 
the PPD you copied and pasted in steps 1 and 2).

11. Click Add (see Figure 8).

Now that you have established communication between your PC and 
Mac OSX, installed Windows Printing, created a share name for the vir-
tual printer, and added the printer onto your Mac OSX, you can print to 
your ONYX Workflow software through your OSX machine.

Printing from Mac OSX (10.3.x or higher) with 
Printservices for UNIX
There are four major steps when printing from OSX to an ONYX Vir-
tual printer with Printservices for UNIX: 

• Configure the network
• Install Printservices for UNIX
• Establish a Virtual Printer share name
• Add the printer on Mac OSX

Configuring the Network

It is vital that the OSX machine and the PC in which your ONYX Graph-
ics software resides communicate. Configuring the Network ensures that 
communication across the network can occur. 

To configure the network: 
1. Look up the IP Addresses of both the OSX and PC machines 

(see the Finding IP Addresses section for more information).
2. Open a command prompt by clicking Start > Programs > Acces-

sories > Command Prompt.
3. Ping from the PC to see if there is communication between the 

OSX machine and the PC. To do this, in the Command Prompt 
window, type: ping <IP address of OSX machine>, then press 
Enter. You can also open a command prompt by clicking Start > 
Run…. In the Run dialog, type: cmd, and then click OK.
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Figure 7—Windows Printing

Figure 8—Add



Installing Printservices for UNIX
To install Printservices for UNIX: 

1. From the Start menu, select Settings > Control Panel > Add or 
Remove Programs. This opens the Add or Remove Programs 
dialog.

2. Click Add/Remove Windows Components (found on the far left 
of the dialog). This opens the Windows Components dialog.

3. Scroll to Other Network File and Print Services. Activate this 
setting by clicking the checkbox, and then click Details. This 
opens the Other Network File and Print Services dialog.

4. Activate Print Services for UNIX, and click OK.
5. In the Windows Components dialog, click Next to configure the 

change.
6. From the Start menu, select Settings > Control Panel > Admin-

istrative Tools > Services. This opens the Services dialog (see 
Figure 9).

7. Scroll to find TCP/IP Print Server, and then double-click it. This 
opens the TCP/IP Print Server Properties dialog (see Figure 10).

8. From the Startup Type drop-down list, choose Automatic.
9. Click Start to begin Printservices for UNIX. Note that the Status 

and Startup Type for TCP/IP Print Server have changed to 
Started and Automatic.

10. During the RIP station set-up, remember to turn off the network 
firewall or make an exception on port 515 to use this workflow.

Establishing the Virtual Printer Share Name
Creating a Share Name allows you to easily recognize the virtual printer 
when working from your Mac. 

To establish the share name: 
1. From the Start menu, select Settings > Printers and Faxes.
2. Right-click on the ONYX Virtual Printer, and select Sharing.
3. In the Virtual Printer Properties dialog, locate the Share Name 

field and change it so that it is no more than 12 characters long. 
Then, write down the name located in the Share Name field.

4. Click OK to accept your changes and exit the dialog.

Adding the Printer on the Mac OSX
The final step in the OSX/Printservices for UNIX process involves add-
ing the printer to the Mac OSX. 
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The Share Name cannot be longer than 
12 characters including spaces.

Figure 9—Services Dialog

Figure 10—TCP/IP Print Server Properties



To add a printer to the Mac OSX:
1. On your PC, copy the PPD located in ONYX Graphics\Production 

House\Server\PPD\Mac.
2. Paste the PPD somewhere on your Mac. To do this, go to your 

Mac hard drive and choose Library > Printers > PPDs > Con-
tents > Resources > and select an appropriate language for the 
folder, such as choosing En.LPROJ for English).

3. On your Mac, open the Printer Utility. To do this, use the Finder 
to select Go > Utilities > Printer Setup Utility.

4. Add a new printer.
5. From the Printer Model drop-down list choose Other, then go to 

the folder where you placed the PPD (this is the PPD you copied 
and pasted in steps 1 and 2).

6. Select LPR as the Printer Port.
7. For the Queue, choose the Share Name of your virtual printer. 

You can change the Share name if you like.
8. In the IP Address field enter the IP address of the RIP station, not 

the IP address of the printer.

Now that you have established communication between your PC and 
Mac OSX, installed Printservices for UNIX, established a share name 
for the virtual printer, and added the printer onto your Mac OSX, you 
can print to your ONYX Workflow software through your OSX ma-
chine.

Using the Web Portal (HTTP Access)
The Web Portal allows you to send jobs to RIP-Queue from a remote 
computer on your local network through your web browser. This in-
cludes sending images to print from Macs. In the Web Portal you can 
view the Active Jobs (equivalent to the Jobs Ready to Print area of  the 
RIP-Queue window), the Inactive Jobs (equivalent to the Buffered area 
of  the RIP-Queue window), and even control some job options like 
number of  copies, magnification, holds, and marks.

To launch the Web Portal:
1. Open RIP-Queue. In the bottom right corner of the window, the 

message “Starting HTTP service on port 80” displays in the RIP-
Queue console (see Figure 11).

2. Open your internet browser.
3. In the address bar of your browser, type http:// followed by 

the name of the machine on which RIP-Queue is running. For 
example, http://Katherine2. If you have changed the port number 
in RIP-Queue, you must follow the name of the machine with a 
colon, then the port number (for example, http://Katherine:8080 
or http://Katherine:1300). 

4. Press Enter. This will open the Web Portal (see Figure 12).
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Figure 11—RIP-Queue Console

To use the Web Portal, you must have 
that feature included with your software. 
Contact your sales representative for a 
Key Update.

Figure 12—Web Portal



Changing the Web Portal Port
The Web Portal uses port 80 by default; however, if  a service is already 
using that port, RIP-Queue displays an error in the RIP-Queue console. 
To resolve this issue, change the port number in the General Settings of  
RIP-Queue. 

To change the RIP-Queue Web Portal Port:
1. In RIP-Queue select General Settings from the File menu to 

open the General Settings dialog.
2. In the General Settings dialog, enter a new port number into the 

Port field (e.g. 8080 or 1300).
3. Click OK.

Submitting a Job Using the Web Portal
To submit a job using the Web Portal:

1. In the Web Portal, click Browse in the Submit New Job area. This 
opens the Choose File dialog (see Figure 13).

2. Browse to the file you want to submit, and click Open.
3. In the Web Portal, select the printer you want to use and the 

Quick Set you want to apply to the image.
4. Click Submit New Job.
5. Once RIP-Queue finishes processing the image, click Home on 

the Web Portal page to refresh the page and display the updated 
Active jobs. Depending on the image size, it can take several 
minutes for the job to display in the Active Jobs list.

If  the newly submitted job does not appear in the Active Jobs list, check 
the RIP-Queue Console (located in the bottom right corner of  the RIP-
Queue window) for information about the image.
Once you submit a job to RIP-Queue using the Web Portal, click the job 
name to display the Edit Job dialog (see Figure 14). In this dialog you 
can choose to modify job options such as holds, number of  copies, and 
magnification.
Placing a checkmark in the box next to the job name allows you to con-
trol the job by deleting, moving, holding, or making the job inactive 
(moving the job directly to the buffered area without printing).
Clicking Refresh on your internet toolbar repeats the last action you 
performed in the Web Portal. To refresh the Active Jobs list, click Home 
on the Web Portal page (not on your browser toolbar).
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Figure 13—Choose File

Figure 14—Edit Job



Managing 
Printers
Objectives
This chapter shows you how to configure and manage your printers. By 
the end of  the chapter, you will know how to do the following:

• Configure your printers
• Manage RIP-Queue printers

Configuring Printers
Configuring printers allows you to set preferences for each of  your print-
ers. You can determine printer ports, folder settings, and other options.
The Configure Printer dialog allows you to control many of  your print-
er’s variables such as Quick Sets, Media, etc (see Figure 1). It also allows 
you to configure how RIP-Queue sends data to your printer.
You can access the Configure Printer dialog in one of  three ways:

• Highlight the printer in RIP-Queue, and click Configure Printer 
on the toolbar
• Highlight the printer in RIP-Queue, and choose Configure Print-
er from the Setup menu
• From Printer Manager, select your printer, and click Configure

Each method brings up the same Configure Printer dialog, with the same 
options and features.

Configuring the Printer Port
The printer port is the method by which RIP-Queue communicates with 
the printer.

To change the printer port for your printer:
1. Select the Device tab on the Configure Printer dialog.
2. Highlight the printer you want to configure from the Printer list.
3. Click Configure Port to display the Configure Printer Port dialog 

(see Figure 2).
4. From the Configure Printer Port dialog, choose the printer port 

you want to print with, and then click Configure to modify the 
port options.
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Figure 1—Configure Printers

Figure 2—Configure Printer Port

Note to Windows Vista Users: 
If  you have any trouble managing your 
printers, see the information on page 
105.



Depending on your printer, you can use any of  the following types of  
ports:

• TCP/IP 
• USB 
• Firewire
• LPT
• SCSI
• VideoNet
• VPT
• Print Forwarding
• Print to Windows Printer Driver
• Print to File

The following ports are not tangible printer ports, but are alternative 
methods to send jobs or prints to the printer:

• Print Forwarding
• Print to Windows Printer Driver
• Print to File

Print Forwarding

This port forwards print jobs to another RIP-Queue system. This allows 
you to use one system to process the data, while another system sends 
the data to the printer.

To use Print Forwarding:
1. Highlight the Print Forwarding port on the Configure Printer Port 

dialog, and click Configure. This opens the Browse for Print 
Server dialog (see Figure 3).

2. Browse to the input folder of the desired RIP-Queue printer. This 
should be the printer to which the prints will be forwarded. In 
most cases, this is on the network within a shared folder called 
CONNECTINPUT.

3. Highlight the desired input folder. This usually has the same 
name as the printer. The text “This is a valid Print Server Folder” 
appears at the bottom of the Browse for Print Server dialog, and 
the OK button is enabled.

4. Click OK in both the Browse for Print Server dialog and the Con-
figure Printer dialog.

If  Print Forwarding does not display in the list, then either your printer 
driver does not support Print Forwarding or you do not have Printer 
Forwarding available on your Hardware Key. If  your Hardware Key does 
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To learn more about the printer ports, 
see Online Help at http://help.onyxgfx.
com/x10/rip-queue

Figure 3—Browse for Print Server
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not have Print Forwarding, contact your sales representative for a Key 
Update.

Print to Windows Printer Driver

You may want to use Print to Windows Printer Driver with certain print-
ers that have printer ports or features that RIP-Queue may not support.

To use the Print to Windows Printer Driver:
1. Highlight the Print to Windows Printer Driver port on the Con-

figure Printer Port dialog.
2. Click Configure. This opens the Select Other Printer dialog which 

lists all the available Windows printers (see Figure 4).
3. Choose the Windows printer that matches the RIP-Queue printer. 

You can also browse to a network printer by clicking Browse.
4. Click OK on both the Select Other Printer dialog and the Config-

ure Printer dialog.

Print to File

Some printers cannot communicate directly with RIP-Queue, but instead 
use an output file to retrieve the image data. You can also use the Print 
to File option for troubleshooting purposes.

To use the Print to File port:
1. Highlight the Print to File port from the list of ports on the Config-

ure Printer Port dialog. 
2. Click Configure. This opens the Select Print File dialog (see 

Figure 5). If the Printer Port dialog does not display Print to File, 
then your printer does not support this option.

3. Browse to the location where you want to save the output file.
4. Type a name for the output file. If you want to use a file exten-

sion other than the one show by default, choose the appropriate 
extension from the Save as Type drop-down menu.

5. Click Save. RIP-Queue automatically creates the output file as a 
placeholder. The software does not save the actual printer output 
until the printer prints a job.

6. Click OK.

Using Printer Pools
A Printer Pool is a RIP-Queue printer that has two or more physical 
printers. Printer pools are an effective tool when printing high-volume 
jobs. When two physical printers are configured as a printer pool, and 
each printer has the same media loaded, RIP-Queue automatically sends 
jobs to the first printer that is ready.

Figure 4—Select Other Printer

If  Print to Windows Printer Driver 
does not display in the list, then your 
printer driver does not support this 
option. 

Figure 5—Print to File
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You can also have each physical printer loaded with a different media. 
This allows incoming jobs to be sent to the same printer (acting as a 
printer pool), but without needing to wait for the media to be changed 
on the printer.
The Physical Printer column in the Configure Printer dialog shows the 
physical printers associated with the RIP-Queue printer. To increase the 
number of  physical printers, modify the value in the Number of  Physical 
Printers field.

Managing Media
Use the Media tab of  the Configure Printer dialog to import and delete 
media or to change the media specific options.

Changing the Media Specific Options

Media options are specific settings that control how the printer functions 
when using that media. These settings can control the number of  passes, 
pass direction, head temperatures, and so forth.

To change the media specific options:
1. Choose the Media tab of the Configure Printer dialog. 
2. Select the correct Media Type (Media Configuration) from the 

drop-down menu.
3. Select the correct Media from the list.
4. Click Options to display the Printer Options dialog (see Figure 6).
5. Modify the media specific options.
6. Click OK.

If  the Options button is disabled or does not appear on the Media tab 
of  the Configure Printer dialog, then your printer does not support 
software-controlled media specific options. Change the options on the 
physical printer to modify how the jobs are printed. 
Changing the media specific options for a printer can affect the color 
quality of  the profiles associated with that media. You should re-profile 
the media if  you make significant changes to the media specific options.

To import a media:
1. In the Media tab of the Configure Printer dialog, click Import. This 

displays the Open Media Library dialog.
2. Browse to and highlight the media library (.oml) file which con-

tains the media you want to import, and click Open. This displays 
the Import Media dialog.

If  you cannot increase the number of  
physical printers, you do not have suffi-
cient Key permissions. Contact your sales 
representative for a Key Update.

Figure 6—Printer Options
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3. In the Import Media dialog, place a check mark in the checkbox 
next to the media you want to import, and click Import.

To delete a media:
1. Go to the Media tab of the Configure Printer dialog.
2. Select the Media Type (Media Configuration) from the drop-down 

menu.
3. Highlight the Media you want to delete, and click Delete.

Managing Page Sizes
The Page Sizes tab of  the Configure Printer dialog shows the available 
page sizes for the printer (see Figure 7). You can add, edit, or delete page 
sizes using this tab. You can only edit Custom or Standard page sizes.

To add a Page Size:
1. Click Add on the Page Size tab of the Configure Printer dialog. 

This opens the Add Page Size dialog (see Figure 8).
2. Choose Roll or Sheet as the page size type.
3. Choose the units of measurement (English or Metric) you want 

RIP-Queue to display for the page size.
4. From the Standard Page Sizes list, highlight the page size you 

want to add. You can choose Custom if you want to define 
the width and height of the page size, or you can choose a 
predefined size from the list. If you choose a pre-defined size, 
specify the margins for each side of the page.

5. Enter a name for the page size.
6. Click OK.

To edit a Page Size:
1. Highlight the Page Size you want to edit, and click Edit on the 

Page Size tab of the Configure Printer dialog. This opens the 
Edit/Add Page Size dialog (see Figure 8).

2. Change the options for the Page Size.
3. Click OK.

To delete a Page Size:
1. Highlight the Page Size you want to delete.
2. Click Delete.

Renaming a Printer
You can rename your printer to help identify your printers. 

Figure 7—Page Sizes

Figure 8—Add Page Sizes
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To rename a printer:
1. Go to the Properties tab on the Configure Printer dialog.
2. Enter a new name for the printer in the Printer Name field.
3. Click OK. 

Changing the Base Folder
RIP-Queue uses two special folders to manage jobs:

• Input Folder
• Work Folder

Input Folder

RIP-Queue uses the input folder to receive incoming image files. It also 
contains the Hot Folder for each Quick Set. You can automatically send 
an image to RIP-Queue by copying the image into the input folder or 
any of  the subfolders that represents a Quick Set. When RIP-Queue is 
running, it automatically moves images from the input folder (and Hot 
Folders) to the work folder where they are kept for processing, printing, 
and archiving.

Work Folder

The work folder is where RIP-Queue keeps the image files for process-
ing, printing, and archiving. RIP-Queue also uses the work folder to keep 
system files that control the state of  the printer.
Another folder, called the Base Folder, is the parent directory of  both 
the input folder and the work folders. The Base Folder is the RIP-Queue 
program folder by default. You may want to change the Base Folder to a 
different hard drive to allow faster access time to the image and job files 
found in the input and work folders.

To change the Base Folder:
1. Select the Properties tab from the Configure Printer dialog.
2. From the Base Folder location of the Properties tab, click 

Change. This opens the Browse Folders dialog (see Figure 9).
3. Browse to the location of the folder you want to use as the Base 

Folder, or click New Folder to create a new folder.
4. Select the folder you want to use.
5. Click OK.

Because the input and work folders can contain many large files, chang-
ing the Base Folder can take several minutes.

For more information on Hot Folders, 
read the Using Hot Folders section of  
the Setup & Printing chapter, or see 
Online Help at 
http://help.onyxgfx.com/x10/rip-
queue

Figure 9—Browse Folders



Ink Calculation
Use the Ink Calculation tab of  the Configure Printer dialog to define the 
Reporting Unit (cost per unit) and if  necessary, adjust the Correction 
Factor (ink drop volume). Each Resolution/Ink Type combination can 
be defined and the reporting values adjusted per ink channel.

Define the Reporting Unit

Before you configure your reporting units, determine the volume of  your 
cartridge and divide it by the cost of  the cartridge. The Cost/Volume = 
the custom unit per volume measured.

To define the reporting unit:
1. In the Ink Calculation tab of the Configure Printer dialog, select 

the Resolution and Ink Type you want to use (see Figure 10).
2. Select the Reporting Unit Type from the drop-down menu.
3. Calculate the cost per unit. (e.g., 680ml cartridge that costs 

$239.99 = $.35/ml)
4. Enter the cost per unit for each ink channel by clicking in the field 

and typing in the cost.

Adjust the Correction Factor

Each printer has a built-in default factor to determine ink usage per drop. 
The default is set at 1 and takes into consideration known variables for 
the device in an ideal working environment. When you print a job using 
the default factor, the values reported reflect ink calculations based on 
the printer manufacturer’s specifications and are interpreted internally by 
the RIP-Queue which reports the data.
Because the reported data does not take into consideration variations in 
the printer or working conditions, with some work on your part, it can be 
fine-tuned to more accurately reflect your conditions. To fine tune your 
correction factor, compare other known values with the reported values 
from RIP-Queue to find the new correction factor.
Here are some simplified examples for fine tuning your correction factor 
if  the reported data is different from the known data. In each case, divid-
ing the known factor (X) by the reported factor (Y) will give you your 
specific Correction Factor.

• The printer reports how much ink is being used as a known value 
(X). In RIP-Queue, compare the known value to the reported usage 
by print job (Y). 
• Install a new ink cartridge with known volume (X) and print until 
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Figure 10—Ink Calculation



it’s empty. In Rip-Queue, print the job log and manually calculate 
the total ink reported (Y) by adding up the ink used for all the jobs 
printed with that ink cartridge. 
• Physically weigh an ink cartridge before and after it prints. Convert 
the mass to volume to get the exact known consumption (X). In 
RIP-Queue, compare that to the reported usage by print job (Y). 

Managing Printers
Use the Printer Manager to perform the following tasks:

• Configure a Printer
• Activate a Printer
• Deactivate a Printer
• Delete a Printer
• Create a PRNINST
• Duplicate a Printer 

To open the Printer Manager, choose Manage Printers from the File 
menu (see Figure 11). Before you manage your printer in RIP-Queue, 
make sure no jobs are processing or printing. Because the printer man-
agement options affect how RIP-Queue is configured, all processing and 
printing stops when you access the Printer Manager.

Activating a Printer
The Printers list in the Printer Manager dialog shows all the printers 
installed on your system. An active printer contains a check mark in the 
box next to the printer name. You can only activate a certain number of  
printers based on your program. RIP-Queue displays the number of  ac-
tive printers allowed at the bottom of  the Printer Manager dialog, as well 
as in the Hardware Key dialog (see Figure 12). To increase this number, 
contact your sales representative for a Key Update.

Deactivating a Printer
To deactivate a printer in the Printer Manager, remove the check mark 
from the checkbox next to the printer’s name. When you deactivate a 
printer, RIP-Queue retains the printer port settings, Quick Sets, and jobs 
assigned to that printer; however, the printer will not appear in the Print-
ers list of  the RIP-Queue window. If  you reactivate a printer, RIP-Queue 
restores all the settings and jobs to the state they were in when you de-
activated the printer.
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Figure 12—Hardware Key

You may want to deactivate a printer 
if  you do not have enough active printer 
permissions for all your printers.

Figure 11—Printer Manager



Deleting a Printer
If  you want to permanently delete a printer from your system, highlight 
the printer in the Printer Manager, and click Delete.

Creating a PrnInst
A PrnInst is a RIP-Queue Printer Installation file. PrnInst files include 
all the files necessary to install a printer in RIP-Queue, such as the profile 
library information (medias and profiles), Quick Sets, and system files 
(such as .dlls).
You may want to use the create PrnInst feature for several reasons:

• Backing up your printer settings
• Backing up your media profiles
• Installing a copy of  the printer on a different RIP-Queue system
• Distributing a custom-made printer installation

To create a PrnInst:
1. In RIP-Queue, select Printer Manager from the File menu. This 

opens the Printer Manager dialog (see Figure 11).
2. In the Printer Manager dialog, highlight the printer for which you 

want to create a PRNINST.
3. Click Create PrnInst. This opens the PRNINST Options dialog.
4. In the PRNINST Options dialog, select the options you want to 

include with the new PrnInst file by placing a check mark in the 
checkbox next to the desired option. Click Next to open the Save 
As dialog.

5. In the Save As dialog, enter a name for the new PrnInst file in the 
File Name field, and click Save.

Duplicating a Printer
Use the Duplicate option to create a new printer that is an exact copy of  
an existing one. This option is useful if  you have more than one printer 
of  the same type.
Duplicating a printer is different than printer pooling. The printers in a 
pool share the same profile library and Quick Sets, and anytime you add 
or modify a media or profile, it applies to all the printers in the printer 
pool.
Duplicate printers are completely separate printers, each with distinct 
profile libraries and Quick Sets. If  you add or modify a media, profile, or 
Quick Set to either of  the duplicate printers, the printers are no longer 
identical.
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Deleting a printer removes all jobs as-
sociated with that printer. 



To duplicate a printer:
1. In Printer Manager, right-click the printer you want to duplicate to 

display a list of options.
2. Choose Duplicate from the list of options.

After RIP-Queue duplicates the printer, verify that the new printer is 
active by making sure the checkbox next to the printer name contains a 
check mark. Duplicating a printer can take several minutes.
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8 Proofing
Objectives
This chapter will show you how to setup proofing. By the end of  the 
chapter, you will know how to do the following:

• Compare printer gamuts
• Configure proofing printers
• Verify the proof

What is Proofing?
Proofing is the process of  simulating the output of  one printer on an-
other device. This concept has long been used in traditional printing 
industries like commercial offset printing where getting ready to print is 
very labor intensive and expensive. These industries use a small, inexpen-
sive printer to proof  or simulate the way a printing press images color. 

Proofing Basics
One of  the primary purposes of  printing a proof  is to give you an idea 
of  what the final output will look like. Proofs can help you identify prob-
lems with your image without having to print the final product. While at 
times you may require a press proof  (an exact copy) of  the final output, 
press proofing involves printing the image to the final media using color 
reproduction technology. This can take time and be expensive. In most 
cases, you only need a simulation proof. A simulation proof  does not 
provide an exact copy of  the final output, but a representation of  the 
final output.
If  you determine that a simulation proof  is acceptable in your situation, 
it is important that you understand that the proof  may not exactly match 
the final output and that it may fall short of  the original. 
To proof  an image, RIP-Queue requires that you have a minimum of  
two active printers. One will act as your final output printer; the other as 
your proofing printer. Your final output printer is the printer on which 
you will print the final image. The proofing printer is the printer on which 
you will proof  your image. This allows you to review a representation of  
your image without using the ink and media of  the final output printer.
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To use Proofing, you must have that 
feature enabled on your Hardware Key. 
Contact your sales representative for a 
Key Update.



To proof  an image properly, you must meet the following conditions:
• Your proofing printer should match the color of  your final output 
printer as closely as possible. This depends upon the compatibil-
ity of  the proofing gamut and the final output gamut. In general, 
the gamut of  the proofing media should completely encompass the 
gamut of  the final output media. If  the gamut of  your final output 
media falls outside the gamut of  the proofing media, the proofing 
printer cannot provide an exact color reproduction. 
• You need accurate profiles for both the output printer and the 
proofing printer. 
• Ensure that you maintain and calibrate both printers regularly to 
ensure that the target densities are accurate. 
• Ensure that the calibration of  your proofing printer is correct by 
using the Verification Strip and the Visual Tolerance Chart. 

Before Proofing
Before you proof  an image, ensure that your proofing printer is capable 
of  reproducing the colors of  the output printer and determine, in RIP-
Queue, which printer you will use as your proofing printer. The follow-
ing sections describe how to set up your proofing process:

• Comparing Printer Gamuts
• Configuring a Proofing Printer

Comparing Printer Gamuts
The first step in the proofing process is to determine whether your 
proofing media completely encompasses the gamut of  your final output 
media. This ensures that your proofing printer can accurately reproduce 
the colors of  your final output printer. To compare your proofing gamut 
with your final output gamut, use the MediaAnalyzer tool.

MediaAnalyzer Tool

The MediaAnalyzer tool allows you to visually compare two gamuts at 
the same time (see Figure 1). The tool contains a Left Configuration, a 
Right Configuration, and a Gamut Data View in the center where it maps 
a rough wire frame representation of  up to two gamuts on an L*a*b* 
axis (see Figure 4). This allows you to determine if  your proofing gamut 
fully encompasses the final output gamut. If  the proofing gamut does 
not cover the final output gamut, it cannot accurately reproduce the de-
sired colors.
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Figure 1—MediaAnalyzer Tool



To open the MediaAnalyzer tool:
1. Browse to the MediaAnalyzer folder on ONYX Graphics\Produc-

tion House\preflight directory. 
2. Double-click MediaAnalyzer.exe.

The MediaAnalyzer tool can capture gamut configurations from either a 
measuring device by clicking Measure or by importing the information 
from an ICC Profile by clicking ICC Import. You can directly load an 
ICC Profile from a .PrnLib file or from a .PrnInst file. Clicking Save al-
lows you to save a gamut configuration for viewing later. Clicking Load 
allows you to open a previously saved gamut configuration.
Use the options at the bottom of  the MediaAnalyzer window to control 
what data displays in the Gamut Data View. Each slider control allows 
you to rotate the gamut view along an axis. The L* axis runs vertically 
in the Gamut Data View while both the a* and b* axis run horizontally. 
For the most part, you will want to move the L* slider to rotate the view 
around the L* axis, which allows you to view the various hues. Because 
MediaAnalyzer provides a 3-dimensional perspective view, the parts of  
the gamut and L*a*b* axis that are closer to you appear further from the 
center of  the view.
Use the MediaAnalyzer tool to analyze your ICC Profiles and compare 
the color gamuts of  your proofing printer and final output printer. 

The Proofing Printer

First, view the gamut for the proofing printer.

To view the gamut:
1. Launch the MediaAnalyzer by browsing to your ONYX Graphics 

> Production House > Preflight directory and double-clicking 
MediaAnalyzer.exe. This displays the MediaAnalyzer window 
(see Figure 1).

2. In the MediaAnalyzer window, click ICC Import in the Left Con-
figuration section to display the Open dialog (see Figure 2).

3. In the Open dialog, browse to the ONYX Graphics > Production 
House > Common Folder. This folder lists all the installed print-
ers with their associated .PrnLib files (see Figure 3).

4. Highlight the proofing printer’s PrnLib (the printer on which you 
want to print a proof), and click Open. This displays the Select 
Profile dialog. 

5. Select the desired profile, and click OK. The MediaAnalyzer tool 
displays a red wireframe which represents the gamut of the proof-
ing profile (see Figure 4).

The Select Profile dialog displays a list of  printer profiles for the selected 
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To view the gamut from the top, set the 
a* slider to 85; to view the gamut from 
the bottom set the a* slider to 265.

Figure 2—Open

Figure 3—Common Folder



.PrnLib file. Each item in the list represents a separate printer profile and 
uses this format: MediaConfig~Resolution~PatternID~Name.
The PatternID indicates which dot pattern this profile was created for. 
The Pattern IDs are as follows:

• 0 = FDRP 
• 1 = FDRP Line 
• 2 = FDRP Plus 
• 3 = Ordered Dither 
• 4 = Screen
• 5 = Stochastic
• 6 = Contone
• 7 = Smooth Screen

The Final Output Printer

Next, view the gamut of  the media you want to proof:

To view the gamut:
1. In the MediaAnalyzer window, click ICC Import in the Right Con-

figuration section. This displays the Open dialog.
2. In the Open dialog, browse to the ONYX Graphics > Production 

House > Common Folder. This folder lists all the installed print-
ers with their associated .PrnLib files.

3. Highlight the final output printer’s PrnLib (the printer you want to 
proof), and click Open. This displays the Select Profile dialog.

4. Select the desired profile, and click OK. The Media Analyzer tool 
displays a blue wireframe which represents the gamut of the final 
output profile (see Figure 4).

Reviewing the Gamut Data

Once the MediaAnalyzer tool displays both gamut wireframes, review 
the Left and Right Report windows (see Figure 5). The Gamut volume 
value for the proofing gamut should generally be as big or bigger than 
the gamut of  the media that is being proofed.
Use the L* slider to rotate the gamuts and ensure that the blue (proofed) 
gamut is entirely inside the red (proofing) gamut. Note any places where 
the blue proofed gamut falls outside the red proofing gamut. This indi-
cates that the proofing media cannot accurately reproduce these colors.
It is important to understand the limitations of  the proofing media as 
this sets the proper expectations. In some cases, you may feel that it is 
acceptable for parts of  the final output gamut to fall outside the proofing 
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Figure 4—Gamut Wireframes

Figure 5—Gamut Report



gamut; however, this depends entirely upon your situation and expecta-
tions. In general, the proofing process is designed to help you understand 
the expected output, even if  the proof  is not an exact replica.
Once you determine how your proofing printer and selected media will 
reproduce the colors of  your final output printer and media, you need to 
configure your proofing printer.

Configuring a Proofing Printer
When you configure a printer for proofing, you select the final output 
printer and then determine which printer and settings you want to use 
for proofing. 

To configure a proofing printer:
1. In RIP-Queue, highlight the printer you want to use for the final 

output.
2. Click Configure Proofing. This opens the Proof Creation Set-

tings dialog (see Figure 6).
3. Use the Printer drop-down menu to select the printer you want to 

use for proofing.
4. Select the desired Quick Set for the proofing printer.
5. Set the Maximum Width and Height for the proof. This does not 

set the actual width and height, it simply sets a limit on the size 
of the proof. The actual output of the proof will be in proportion to 
the original job.

6. Enable Proof All Pages if you want to print all the pages of a 
multi-page document. Disable this option to only print a proof of 
the first page.

7. Select the desired Rendering Intent using the drop-down menu. 
8. Use the Pure Hues area to select which colors you want to ex-

clude from the ICC workflow.

Once you configure your printer, you have completed the necessary set-
up, and you are ready to print a proof.

Printing a Proof
You can print a proof  using any of  three methods:

• From a selected job in RIP-Queue
• From Preflight
• Automatically using a Quick Set

To print a proof from a selected job in RIP-Queue:
1. Highlight the desired job in the Jobs Ready to Print or the Buff-

ered Jobs Area of the RIP-Queue window.
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Figure 6—Configure Proofing



2. Right-click the highlighted job, and select Proof.
3. RIP-Queue creates a new job in the Jobs Ready to Print area 

and appends -Proof to the job name. RIP-Queue also places the 
original job on hold until you release it (see Figure 7). 

Depending on the Quick Set and Media Placement settings, the proof  
image previews, rips, and prints just as a normal job.
While you can manage proofs in the same way as any other job, you 
should not need to open a proof  job in Preflight nor should you edit any 
color management or color correction settings. This defeats the purpose 
of  a proof—mimic the output of  another printer. However, you can 
modify the color management, size, etc., of  the original job in Preflight.

Proofing from Preflight

You can submit for proofing any image you modify in Preflight. This 
allows you to apply changes such as color filters or cropping to an image 
and then submit those changes to the proof  printer before tying up the 
final output printer.

To print a proof from Preflight:
1. Open the desired job in Preflight by right-clicking the job in the 

Jobs Ready to Print area of RIP-Queue and selecting Edit > 
Job in Preflight. If you open a job into Preflight using another 
method, you will not have the option to submit the job as a proof.

2. Use the tools in Preflight to make any necessary crops, edits, 
or color changes. It is acceptable to make color changes at this 
point because you are changing the original image before you 
proof it. However, it is important that you do not open the proof 
image into Preflight and modify the color.

3. Once you have made the desired changes, click the Print tab in 
Preflight (see Figure 8).

4. Click Submit Proof. RIP-Queue creates a new job in the Jobs 
Ready to Print area and appends -Proof to the job name. RIP-
Queue also places the original job on hold until you release it. 

Depending on the Quick Set and Media Placement settings, the proof  
previews, rips, and prints just as a normal job.
After the proof  is ready, review the results. If  necessary, you can edit the 
color of  the original image again and submit another proof. Do this until 
you achieve the desired result.

Proofing Automatically Using a Quick Set

You can create a Quick Set for your final output printer which automati-
cally sends a proof  file to the proofing printer. Use this option if  you 
regularly print a proof  before printing your final output.
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Figure 7—Proofing

Make sure that the job you highlight for 
proofing is originally set to print on the 
final output printer.

Figure 8—Proofing from Preflight



To print a proof using Quick Sets: 
1. Highlight the final output printer in RIP-Queue.
2. Click Edit Quick Set. This opens the Edit Quick Sets window.
3. Highlight the Quick Set you want to configure, and click Edit. This 

opens the Edit Quick Set dialog.
4. Click Advanced. This opens the Edit Quick Set—Advanced Op-

tions dialog (see Figure 9).
5. In the Workflow Tab, enable the Create Proof Automatically 

check box.
6. Click OK.

Each time you apply this Quick Set to an image, RIP-Queue creates a 
new job in the Jobs Ready to Print area and appends -Proof to the job 
name. RIP-Queue places the original job on hold until you release it. 

Verify the Proof
In order for your proofing printer to be accurate, it is important that you 
properly calibrate the proofing media. However, due to environmental 
variables and printer wear and tear, calibrations tend to drift. In other 
words, they lose their accuracy.
It is important that your proofing printer’s calibration be accurate to en-
sure that it is producing the correct colors. Printing a Visual Tolerance 
Chart (located in the ONYX Graphics\Production House\Samples 
folder) on the proofing printer immediately after calibrating the proofing 
media gives you an accurate reference point. When you print a proof, you 
can ensure that your proofing printer is producing accurate output by 
checking the Verification strip which prints at the bottom of  each proof  
against the Visual Tolerance Chart. You should print a Visual Tolerance 
Chart for each media, ink, resolution, and dot pattern that you will be 
using.

Visual Tolerance Chart
The Visual Tolerance Chart displays several sets of  patches along with 
varying differences of  lightness, saturation, and hue which correspond 
to the patches on the Verification strip (see Figure 10). This helps you to 
determine if  your proofing printer’s output is accurate.

To print a Visual Tolerance Chart:
1. In RIP-Queue select Open from the File menu. This displays the 

Open dialog.
2. Browse to the ONYX Graphics\Production House\Samples 

directory.
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Figure 9—Proofing Using Quick Sets

Figure 10—Visual Tolerance Chart



3. Highlight the file named VisualToleranceChart.tif.
4. In the Open dialog, use the Printer drop-down menu to select 

your proofing printer.
5. Use the Quick Sets drop-down menu to select the All Profiles 

Off Quick Set. If you do not already have an All Profiles Off Quick 
Set, open the Job into Preflight and set your profile selections 
there. 

6. Click Open. The image processes and prints according to your 
printer and Quick Set settings.

Once you print the Visual Tolerance Chart, cut it into strips along the 
white lines and, using a paper hole puncher, punch holes where indicated 
by the white circles. Make sure there are no white borders around the 
holes. Print a new Visual Tolerance Chart each time you recalibrate a 
media. 

Verification Strip
Now that you have printed the Visual Tolerance Chart, you can compare 
it to the Verification strip which prints at the bottom of  each proof  to 
check the accuracy of  the media calibration.

To verify the calibration of the proofing media:
1. Using strip one of the Visual Tolerance Chart, place the hole of 

the patch marked with a V over the first patch of the Verification 
Strip. Make sure that the colors are identical (see Figure 11). 
Repeat this step, comparing each set of patches in strips one and 
two of the Visual Tolerance Chart with the corresponding patch in 
the Verification strip.

2. If your verification strip does not match the patch with a marker 
(V), use the other patches in the set to determine whether your 
proof is within the visual tolerance range—lighter/darker, under 
saturated/over saturated, or a different hue.

3. Using the set of patches on strip three of the Visual Tolerance 
Chart, place the hole nearest the patch marked with a V over 
the corresponding patch on the Verification Strip. Make sure that 
the colors are identical (see Figure 12). The verification patches 
should match the densest corresponding patch on the Visual 
Tolerance Chart.

4. Ensure that the last four patches on the Verification Strip are 
within the color range of the corresponding patches on strip four 
of the Visual Tolerance Chart (see Figure 13). For example, com-
pare the last yellow patch on the Verification Strip against all the 
yellow patches on strip four of the Visual Tolerance Chart. The 
Verification patch should match the patch marked with a V.
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Figure 11—Strip One

Figure 12—Strip Three

Figure 13—Strip Four



Color Management 
& ICC Profiles
Objectives
This chapter will take you through Color Management and ICC Profiles. 
By the end of  this chapter, you will have an understanding of  the fol-
lowing items:

• Color Management & Color Theory
• ICC Profiles
• Color Management Options
• Profile and Calibration Terminology

What is Color Management?
Color Management determines the color characteristics of  your images 
in RIP-Queue by using color spaces and profiles. Understanding and 
using proper Color Management will help you achieve quality output 
color. 

What is an ICC Profile?
The ICC (International Colour Consortium) sets the standards for color 
management in the imaging industry. An ICC profile lets one device 
know how another device has created its colors and how those colors 
should be interpreted or reproduced. Simply put, ICC Profiles help en-
sure that you have accurate color.

Color Theory
Color theory is a set of  basic rules for mixing color to achieve a de-
sired result. Because color can be formed using both additive (RGB) and 
subtractive (CMYK) methods, two different definitions, or color spaces, 
were developed to describe color.

RGB
RGB color is based on the light spectrum, and it breaks color down into 
an RGB representation. In other words, all color is defined by a certain 
amount of  R (red), G (green), and B (blue). Light emitting devices such 

76 Color Management & ICC Profiles—Advanced Guide

9

If  you are unfamiliar with the theory 
behind Color Management, read the 
Color Theory section of  this chapter. 
If  you are familiar with Color Theory, 
skip ahead to Color Management 
Options.



as TVs and computer monitors function in this manner. If  you were 
to turn your monitor off, you would see black because no R, G, or B 
colors are present. This would be represented as RGB% 0,0,0. If  you 
were looking at a white screen, this would be represented as RGB% 
100,100,100 because each red, green, and blue source is shining at full 
potential. Other colors are created by combining various amounts of  R, 
G, and B. True white light is composed of  a full spectrum of  all light 
colors, but RGB is close enough for most standards. RGB is referred to 
as an additive color theory because when you add all the colors together, 
you get white.

CMYK
CMYK color is based on colorants and is referred to as a subtractive 
color theory because you get white by taking away color. C (cyan), M 
(magenta), and Y (yellow) are used to create color. In theory, an equal 
amount of  C, M, and Y would create K (black), but the result in practice 
is actually a muddy brown. Because of  this, K is added to create pure 
blacks and other dark colors. K is also an economical solution since K 
ink is less expensive than C, M, or Y.
Because RGB color spaces are defined by light and not colorants like 
CMYK, RGB devices generally have a much larger color gamut. This 
creates some problems because the color on your monitor can be differ-
ent than what is printed.

Device-Dependent Color Spaces
RGB and CMYK are referred to as device-dependent color spaces be-
cause the colors defined in these spaces are intrinsically tied to the de-
vices they are defined on. A device may refer to a printer, scanner, moni-
tor, or any device in which color is created. For example, in a television 
showroom each television has a slightly different color even though they 
are displaying the same program—they each have their own unique RGB 
color spaces. Likewise, printers have a unique CMYK color space that 
varies slightly from printer to printer.
Colors that are defined in device-dependent color spaces cannot accu-
rately be changed to any other device-dependent color space in a direct 
process because they are not compatible (see Figures 1 & 2). Like an 
interpreter, you need something that can communicate will both RGB 
and CMYK.

Device-Independent Color Spaces
In 1976, a mathematical color space was created that could be used as an 

77

A color gamut is the range of  colors 
that are possible. For example, a color 
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Figures 1 & 2—Device-Dependent Color Spaces



interpreter—L*a*b*. This color space is now the standard method used 
to interpret between two device-dependent color spaces. Because L*a*b* 
is not dependent on any color space, it is called a device-independent 
color space.
The L*a*b* color space has three different components—L*, a*, and 
b*. L* is the lightness value which ranges from 0 (no lightness) to 100 
(maximum lightness); a* determines the red-to-green value and ranges 
from +128 (red) to -128 (green); and b* defines the yellow-to-blue value 
and ranges from +128 (yellow) to -128 (blue).
Because the L*a*b* space is a fixed standard, any defined value will al-
ways be accurate. L*a*b*: 65,5,-110 can be correctly understood by an 
L*a*b* compatible program or device as the exact shade of  blue that it 
was originally designed as. In comparison, you cannot accurately measure 
the actual CMYK and RGB color spaces. 
Once an L*a*b* value is defined, accuracy can be guaranteed within the 
realms of  the L*a*b* space—but the source and the target of  a particu-
lar color is almost always either RGB or CMYK. Because each device-
dependent space is different, the idiosyncrasies and gamut restrictions 
must be taken into account before a translation to the L*a*b* space can 
occur. This is done with a profile (see Figure 3).
Profiles can be referred to as ICC Profiles, ICM Profiles, or Color Man-
agement Profiles and have either the .icc or .icm extension. RIP-Queue 
supports both formats, and both formats may be used interchangeably 
in RIP-Queue.

ICC Profiles
An ICC Profile correctly maps a particular device-dependent color space 
to an L*a*b* standard. A profile also works in a reverse manner to map 
an L*a*b* value to a device-dependent space. For example, when you 
scan an image the original color space (of  the scanner) is RGB. Applying 
a profile to the image correctly converts the RGB data to an L*a*b* color 
space. Then, applying another profile accurately changes the L*a*b* val-
ues to CMYK in order to print the image (see Figure 3). If  each profile is 
accurate, the colors of  the printed image match the colors of  the original 
image.
It is important to note that profiles are tied to the color space they were 
created in. That means that the profiles, too, are device-dependent. 
Therefore, if  you create a profile for one printer, it may not be accurate 
if  you use it for another printer. 
You can apply ICC profiles to either convert a device-dependent color 
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Figure 3—L*a*b* and Profiles
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of  the workflow.
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input source that has a gamut sig-
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the output source because they can be 
impossible to correctly match.

Because the L*a*b* color space is theo-
retical, it has no gamut limitation. RGB 
and CMYK each have a restricted 
gamut and each gamut is different. 



space to L*a*b* or to convert L*a*b* to a device-dependent color space; 
in other words, you can use most ICC Profiles as either an input or 
an output profile. The only difference between an input and an output 
profile is how you use the profile. However, remember that profiles are 
device-dependent, and using an input profile as the RIP-Queue output 
profile (or vice-versa) can cause undesirable color changes in your print-
ed image.
Input profiles convert the device-dependent color space of  the image 
to L*a*b*, and output profiles convert L*a*b* to the device-dependent 
color space of  the output device or file (see Figure 4). Because the out-
put of  RIP-Queue is the printed image, the output profile is the default 
ICC Profile for the media in the printer.

Input Profiles
Because profiles are device-dependent, you should select appropriate 
input profiles for both CMYK and RGB color spaces. RIP-Queue also 
allows separate profiles for images (raster data) and vector objects (Post-
Script data). You can also choose a profile for one type and choose not 
to use a profile for another. 

Output Profiles
The output profile used in RIP-Queue is the Default Printer ICC profile 
for the printer, media, dot pattern, and resolution combination you are 
using. 

Rendering Intents
You can also select a rendering intent for the output profile from the 
ICC Profile Setup dialog. Rendering Intents control how a profile is ap-
plied and how the colors are mapped from one gamut to another (how 
the profile maps colors within the image that are not achievable by the 
printer gamut). Because printers must take into account gamuts, white 
point, and other variable factors, rendering intents allow one profile to 
be used for different circumstances.
You can choose a rendering intent for both images (raster data) and vec-
tor objects (PostScript data). You can also choose from the following op-
tions: Perceptual (Images), Saturation (Graphics), Relative Colorimetric, 
Absolute Colorimetric, and Poster Color. To choose these options, click 
on the down arrow for either Images or Vector.

• Perceptual (Images)—this gives your images pleasing color. It 
adjusts all the colors in the image to control the colors that are out-
side the gamut of  the output profile. Every color changes slightly, 
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but the overall results of  your image look pleasing because the rela-
tionship between the colors stays the same. This is the default set-
ting for images.
• Saturation (Graphics)—this gives you the best solid hues. It 
takes all colors and scales them to the brightest saturation possible. 
This is most suitable for printing when color impact is more im-
portant than color accuracy, such as when you want to print vector 
(PostScript) data with bold and bright colors.
• Relative Colorimetric—this is used for proofing when you do 
not want to simulate the final output substrate color. It accurately re-
produces the colors within the printers’ range but does not attempt 
to accurately render the out-of-gamut colors. This can result in some 
strange color patterns because the final colors that are out-of-gamut 
are not reproduced. This setting uses the color of  the output media 
as the white point. When proofing, this proofs only the image, and 
assumes that the media used is the same as the final media. 
• Absolute Colorimetric—this is used for proofing when you want 
to simulate the final output substrate color. It accurately reproduces 
all the colors within the printer’s range, but adjusts the out-of-gamut 
colors so that they fall within the range of  the printer. This setting 
simulates the white point of  the input profile. For proofing, this 
proofs both the image and the media.
• Poster Color—this rendering intent, created by ONYX Graphics, 
Inc. to allow for an improved CMYK color workflow, preserves hue 
and relative saturation by mapping the input CMYK gamut directly 
to the output CMYK gamut. If  the output gamut is larger than the 
input gamut, the output will be more colorful than the source image. 
Use this rendering intent with a CMYK source workflow. Using this 
rendering intent with an RGB source workflow provides the same 
results as the perceptual rendering intent. 

L*a*b* Image Files
Although most images require an input profile to be processed correctly, 
L*a*b* files (image files with an L*a*b* color space) do not use an input 
profile. Using L*a*b* files is highly recommended because they avoid an 
initial conversion from RGB or CMYK, which guarantees more accurate 
color. RIP-Queue supports both L*a*b* TIFF and PSD files.

Embedded Profiles
Because the input profile of  an image should match the output profile 
of  the software or device it came from, many programs facilitate the ap-
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plication of  profiles by using Embedded Profiles. When an application 
embeds a profile, it automatically packages the profile with the image. 
When possible, you should use the embedded profile bundled with an 
image because it will most accurately interpret your image.
For example, if  you create an image in Photoshop and save it as a TIFF 
file with embedded profiles applied, Photoshop encodes the profile into 
the TIFF file to be used as the input profile in another application. When 
you bring that image into RIP-Queue, the profile is automatically avail-
able for your use.
The embedded profile displays in the ICC Profile Setup dialog as Image’s 
Embedded Profile. RIP-Queue does not display the actual name of  the 
profile. Because of  this, you should always check that the correct profile 
is defined before you export or save the original image file.

Color Matching Table
The Color Matching Table is a lookup table for named process (spot) 
colors. For example, if  you have a PostScript file that uses a custom-
defined color called SPOTCOLOR Yellow C, RIP-Queue can use the 
specific L*a*b* values associated with that color when processing and 
printing the image.
The Color Matching Table only applies when using PostScript files with 
named process colors. When a PostScript file contains a named process 
color that is listed in the Color Matching Table, RIP-Queue ignores the 
vector input profiles and calculates the output color value directly using 
the L*a*b* value of  the process color and the default output profile of  
the printer. Refer to Online Help at http://help.onyxgfx.com/x10/me-
diamanager for more information concerning the Color Matching Table.

Color Management Options
Because there are so many different settings that control color, RIP-
Queue groups these settings into Color Management options to facilitate 
managing the color settings.
When you select a Color Management option in Preflight or in a Quick 
Set, you do not have to select individual settings, such as the input and 
output ICC Profiles, because selecting the Color Management option 
automatically sets those options for you. However, if  you do want to 
change the individual profiles, click Change Profiles from Edit Quick 
Sets to open the ICC Profile Setup dialog. 
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Setting a Color Management Option in a Quick 
Set
If  you want to use a specific Color Management option for future im-
ages, edit a Quick Set and select that Color Management option.

To access the Color Management option for a Quick Set:
1. Highlight the printer that uses the Quick Set you want to modify.
2. Click Edit Quick Sets on the Toolbar. This opens the Edit Quick 

Sets menu.
3. Highlight the Quick Set you want to modify, and click Edit. This 

opens the Edit Quick Set dialog (see Figure 5).
4. Select the Color Management option you want to use.
5. Click Change Profiles if you want to select individual profiles us-

ing the ICC Profile Setup dialog.

Setting a Color Management Option in Preflight
If  you want to specify a particular Color Management option for a single 
image, open the image in Preflight and change the Color Management 
option. If  you change the Color Management options for a job, you will 
need to reprocess the job before you can reprint it.

To change the Color Management option in Preflight:
1. Open the image in Preflight.
2. Click the Printer and Media tab.
3. Modify the Color Management option in the Mode area (see 

Figure 6).
4. Click Change Profiles if you want to select individual profiles us-

ing the ICC Profile Setup dialog.

ICC Profile Setup
Use the ICC Profile Setup dialog to specify individual profiles for image 
and vector aspects of  a particular color space (see Figure 7). Depending 
on the type of  image you are working with, different options display 
in the ICC Profile Setup dialog. For example, if  you are working with 
an RGB image, RIP-Queue disables the CMYK options; if  the job is a 
CMYK image, then it disables the RGB options. PostScript files gener-
ally contain more than one data type, so RIP-Queue enables both the 
RGB and the CMYK sections when you are working with a PostScript 
file. However, when working with a PostScript file, one or both sections 
(RGB or CMYK) can be ineffective if  there are no such color space ele-
ments in the image. RIP-Queue disables both the CMYK and the RGB 
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Figure 6—Mode Area

Figure 7—ICC Profile Setup

Figure 5—Edit Quick Sets



input profile selections when working with L*a*b* data. When creating 
or editing a Quick Set, RIP-Queue enables all options.
You can also set output profile and rendering intents in the ICC Profile 
Setup dialog. Use the following tabs and options to set the input and 
output profiles, as well as the rendering intents, for your image:

Profiles Tab

You can use the Profiles tab to set the following options (see Figure 7):
• CMYK Image
• CMYK Vector
• RGB Image
• RGB Vector
• Custom Image—this option applies a profile to any image for-
mat other than CMYK or RGB (e.g., CMYKOG, CMYKRB)
• Use Embedded Profiles When Available—disabling this op-
tion causes RIP-Queue to ignore embedded profiles. 
• Proof—this option allows you to simulate a specific color space 
or device. 
• Pure Hues—if  you want to print your primary process colors 
without the profiles, click Pure Hues (the button with the colored 
squares; see Figure 8). Using Pure Hues applies the profile to all the 
colors except those with the checkbox selected on the Pure Hues 
dialog. 

Rendering Intents Tab

The Rendering Intents tab allows you to select the rendering intent you 
want to use (see Figure 9). If  you are working with a PostScript file or 
a Quick Set, you can choose a rendering intent for both image and vec-
tor. For information on rendering intents, refer to the Rendering Intents 
information in the Color Theory section of  this chapter.
The Proof  option is disabled unless a proof  ICC is selected on the Pro-
files tab. Proofing allows you to simulate the rendering intent as if  you 
were printing on another printer. 

Output Tab

The Output tab allows you to set how RIP-Queue will output an image 
(see Figure 10). 
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• Output—use the Output drop-down list to select the output pro-
file you want to use for your image. 
• Advanced Black Generation—click Advanced Black Genera-
tion on the Output Tab to access the Advanced Black Generation 
dialog. This dialog includes both GCR and Gray Balance options. 
Use the drop-down menus to add GCR tables and Gray Balance 
profiles for your data type. For GCR options, you can select No 
GCR Selected, Default GCR, or Custom GCR. For Gray Balance 
options, you can select No Gray Balance Selected and Default Gray 
Balance (see Figure 11). 
• Spot Channel Replacement—this option allows you to print 
separation files with defined spot colors on any printer space (see 
Figure 12). For example, the spot colors in a CMYKSS file can be 
converted to CMYK so the file can be printed correctly on a CMYK 
printer. This option lets you print files designed for a spot color 
workflow on printers that don’t have spot color channels.

To use the spot channel replacement tools:
1. From the Output Tab, click Spot Channel Replacement. 
2. In the Spot Channel Replacement dialog, highlight the spot color 

you want to define, and click Edit. This opens the Edit Spot 
Channel Replacement dialog.

3. Select the desired color space.
4. When you are finished, click OK.

Saving Custom Color Management Settings
You can save your custom color management settings for future use. 
While you can only save your settings in a Quick Set, these settings are 
available for your use in Preflight.

To save your custom color management settings:
1. Highlight the printer you want to modify, and click Edit Quick 

Sets on the toolbar. This opens the Edit Quick Sets dialog.
2. Highlight the Quick Set you want to save your custom color 

management settings to, and click Edit. This will open the Edit 
Quick Set dialog.

3. In the Color MAnagement area of the Edit Quick Set dialog, click 
Change Profiles and adjust the profile settings as desired. 
Click OK to accept the changes and return to the Edit Quick 
Set dialog. 

4. Once you modify the profiles, click the pull down arrow on the 
Change Profiles button in the Color Management area of the Edit 
Quick Set dialog to display a menu. Select Save As... to display 
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GCR (Gray Component Replacement) 
is the process of  removing the graying 
component equivalent to the least 
dominant color, and replacing that with 
black ink in the black separation.

Gray Balance adjusts the levels of  C, 
M, or Y to get a balanced gray. ICC 
Profiles do this automatically, so only 
use this option if  you are not using an 
ICC Profile. 

Figure 11—Advanced Black Generation
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Figure 10—Output



Figure 12—Spot Channel Replacement

Figure 13—Save Color Management Setting

the Save Color Management Setting dialog (see Figure 13).
5. Enter a name for the custom color management setting, and click 

OK. Once you have saved a custom color management setting, 
you can modify or delete these settings.

85



Contour
Cutting
Objectives
This chapter will take you through the details of  Contour Cutting. By the 
end of  the chapter, you will know how to do the following:

• Prepare a file for Contour Cutting
• Modify a Quick Set for Contour Cutting
• Use Contour Cutting workflows
• Configure CUT-Server

What is Contour Cutting?
Contour cutting allows you to print an image and then use a specialized 
device to cut portions of  that image. To do this, you prepare a file with a 
specialized spot color which acts as a cut path. You then print the job us-
ing RIP-Queue. Once RIP-Queue completes the print, the cutting device 
uses the cut path to determine where the image needs to be cut.

How do I use Contour Cutting?
To use the contour cutting feature, you need to prepare your image file 
properly. There are three steps to setting up contour cutting. 

1. Create a cut path in a vector-based drawing program such as Ado-
be® Illustrator® or CorelDRAW®.
2. Create a special Quick Set that uses the cutter path prefix. This 
creates the cut file from the cut paths in the image.
3. Determine your cutting workflow and change your printer’s setup 
options accordingly. You must change the setup options to print the 
file with a barcode and registration marks. 

Depending upon your equipment, you can use one of  three cutting 
workflows:

• Print and cut on the same device—this workflow uses RIP-
Queue to print and cut. 
• Print on any printer and use the I-Cut® digital die cutter—this 
workflow uses RIP-Queue to print and the I-Cut application to cut.
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• Print on any printer and use a separate cutter—this workflow 
uses RIP-Queue to print and CUT-Server to cut.

Preparing a File for Cutting
The first step in the Contour Cut process is to prepare your file for 
contour cutting. To prepare your file, first you must define the cut path 
in a vector-based drawing program. The cut path can be as simple or 
complex as you like.
Once you create the cut path, assign a spot color to it. This spot color 
(specifically the name, not the color) is the most important part of  pre-
paring the file because it allows the cutter software to determine where 
the cutter should cut the image.
The name you assign to this spot color must have a unique prefix which 
matches the prefix assigned in RIP-Queue (see the next section, Creating 
a Quick Set for Contour Cutting, for information on where to set this prefix). 
In RIP-Queue, the default prefix for the cut path spot color is CutCon-
tour. Once you decide on a prefix you can append unique identifiers to 
the name like CutContour1.
When RIP-Queue processes and prints the file, the path with this spe-
cially named spot color will not be printed with the rest of  the image. 
RIP-Queue processes the spot color as a cut path and creates a separate 
cut script file for your cutting device.

Defining the Cut Path in Illustrator
The following steps are specific to Adobe Illustrator; however, many 
drawing programs use similar steps to achieve the same result. The most 
important part of  creating a cut path is that you must create a spot color 
named CutContour and that you apply the color to the cut path. 

To define a cut path in Adobe Illustrator:
1. Open your file in Adobe Illustrator.
2. Create a new layer (Window > Layer > New Layer) and select 

that layer. With complex artwork, create a new layer for your cut 
path elements; with simple artwork this is not always necessary. 
For help on creating layers, refer to the Adobe Illustrator Help.

3. Draw your cut path using the rectangle/ellipse, pen, or pencil tool. 
Make sure you close all paths.

Assign a Spot Color

For RIP-Queue to recognize your cut path, you must assign a unique 
spot color to the path.
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To assign a spot color to the cut path in Adobe Illustrator:
1. Open the Swatches palette (see Figure 1). If the Swatches pal-

ette is not visible, select Swatches from the Window menu.
2. Click the arrow on the upper right corner of the Swatches palette 

to display a secondary menu and select New Swatch to display 
the New Swatch dialog, or click the New Swatch icon on the 
Swatches toolbar.

3. In the New Swatch dialog, enter CutContour as the name for the 
swatch. Whatever you enter here must match what is entered 
into RIP-Queue. 

4. Select Spot Color from the Color Type drop-down menu (see 
Figure 2).

5. Use the slider bars to create a CMYK color. The color is not 
important, only what you name the color.

6. Click OK to close the New Swatch dialog.
7. Select your cut paths and assign the new swatch color to those 

paths.

Save Your File 

Now that you have defined the cut path and assigned a spot color to the 
cut path, save your file in .eps format.

Creating a Quick Set for Contour Cutting
Before you can print a contour cut file, you must either modify an exist-
ing Quick Set or create a new one for your contour cut files. Using a 
specialized Quick Set for contour cutting allows you to include additional 
options such as Tile Outline Cut Paths and Trim Overlap.

To Create a Quick Set for Contour Cutting:
1. Open the Edit Quick Set dialog (Figure 3) by either clicking Con-

figure Printer > New or Edit Quick Sets > Edit. Use the first 
option to create a new Quick Set; the second to edit an existing 
Quick Set.

2. Select your cutter from the Cutter Selection drop-down menu. If 
your cutter is not available, select Generic Cutter.

3. Set all the other Quick Set options you want, and click Ad-
vanced. This opens the Advanced Options dialog.

4. Select the PostScript File tab (Figure 4) and enable the Use 
Cutter Path Prefix option. The prefix must exactly match the 
prefix you entered in step 3 of Assigning a spot color to the 
cut path (see above). If it does not, you will not be able to create 
the cut path. Leaving this as the default setting (CutContour) is 
strongly advised.

5. Select the Marks tab, and select additional options. You can 
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Figure 1—Swatch Palette

Figure 2—New Swatch

Figure 3—Edit Quick Set



choose to Generate Tile Outline Cut Paths or use Trim Over-
lap.

• Generate Tile Outline Cut Paths—this option is useful for mul-
tiple copies of  a photo that doesn’t contain an embedded cut line, 
or for cutting around the edge of  a tiled image.
• Trim Overlap—this option configures RIP-Queue to place cut 
lines in the center of  the overlap. 

Contour Cutting Workflows
Depending on the type of  equipment you have, your workflow will fall 
into one of  three categories:

• Print and cut on the same device
• Print on any printer and cut on the I-Cut digital die cutter
• Print on any printer and cut on a separate cutter

Print and Cut on the Same Device
There are many devices which act as both a printer and a cutter.

To print and cut a job on the same device:
1. Open the Edit Quick Set dialog (Figure 1) by either clicking Con-

figure Printer > New or Edit Quick Sets > Edit. Use the first 
option to create a new Quick Set; the second to edit an existing 
Quick Set.

2. In the Contour Cutting drop-down menu, select By Printer 
(Figure 5).
3. Click OK.
4. Open your file and apply your Contour Cutting Quick Set. RIP-

Queue will print the image and automatically cut it. 

Print on Any Printer and Cut on the I-Cut Digital 
Die Cutter
In this workflow, you can print on any printer and then use the I-Cut 
digital die cutter. When you print an image to cut on an I-Cut digital die 
cutter, the software automatically prints a barcode which the cutter uses 
to find the corresponding cut file. 

To print on any printer and cut using the I-Cut digital die 
cutter: 

1. Follow steps 1 through 4 for the previous workflow, but select 
I-Cut (Figure 6) instead of By Printer in step 2.  
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It is imperative that the text in the 
Cutter Path Prefix field match the 
prefix you assigned to the cut path 
spot color, including case and spaces. 
If  this field does not match the prefix 
you assigned to the cut path spot color, 
RIP-Queue will not recognize the spot 
color as a cut path.

Figure 4—PostScript File Tab

Figure 5—By Printer Option

Figure 6—I-CUTOption



2. Once RIP-Queue is done printing, place the finished print on the 
cutting table.

3. In the I-Cut application, select Options > File Location.
4. Browse your network and select the shared Hot Folder (machine 

name\cutter\I-Cut).
5. Start the cutting process. The cutter automatically reads the 

barcode on the image and finds the corresponding cut script file.

Print on Any Printer and Cut on a Separate 
Cutter

This workflow allows you to print your job on any printer and then cut 
on any cutting device.

To print on any printer and cut on a separate cutter:
1. In RIP-Queue, highlight your printer, and click Change.
2. In the Change Media and Placement dialog (Figure 7), click 

Setup. 
3. Select the General tab, and set the top offset to 2 inches. This 

adds an extra margin that the cutter needs when moving the 
media back and forth.

4. Click OK.
5. Open the Edit Quick Set dialog (Figure 3) by either clicking 

Configure Printer > New or Edit Quick Sets > Edit. Use the first 
option to create a new Quick Set; the second to edit an existing 
Quick Set. Select your cutter from the Contour Cutting drop-
down menu. If your cutter is not available, select Generic Cutter 
(Figure 8).

6. Click OK.
7. Open your file and apply your Contour Cutting Quick Set. 
8. Once RIP-Queue is done printing, use CUT-Server to cut the 

print. For more information on using the CUT-Server, see the Us-
ing CUT-Server section of this chapter.

Modifying the Cutter Setting
You can change the cutter assigned to a print job by right-clicking 
on the job and selecting Job Settings. On the Job Settings dialog, 
you can then select a new cutter or, to turn off  cutter marks, select 
None.

Job Nesting by Assigned Cutter
When Job Nesting is enabled, only jobs with the same cutter assign-
ment will nest together. This assures that jobs intended for a particular 
cutter will print with the correct marks for that device. 

90 Contour Cutting—Advanced Guide

This workflow requires that you have 
CUT-Server. If  you do not, contact your 
sales representative for an upgrade.

Figure 7—Change Media and Placement

Figure 8—Generic Cutter



Using CUT-Server
What is CUT-Server?
CUT-Server is an ONYX application that sends cut information to your 
specific cutter. RIP-Queue creates the cut information for the CUT-
Server from the cut path you defined in your graphics application. 

How do I use CUT-Server?
CUT-Server only works with the specific cutters listed in the Placement 
Strategy dialog in RIP-Queue; however, there is also a Generic Cutter 
option which works with most cutting devices.

Configuring CUT-Server
Once you’ve run the executable to install the new application, launch the 
CUT-Server by double-clicking the icon on your desktop or selecting 
CUT-Server from the Start menu. 

Navigating through CUT-Server
• The Preview Window (located in the center of  the screen) displays a 
wire outline of  the cut file currently selected. You can zoom in or out 
on the cut paths using the zoom buttons across the top of  the Preview 
Window (Figure 9).
• The Cutter area (located on the left of  the screen) displays all the cut-
ters and cut files currently used by CUT-Server. You can use the Cutter 
area to select which file you are currently working with. A separate win-
dow opens for each cutter.
• Cut File Tools area is located on the right of  the screen. You can use 
the Cut File Tools to rotate the cut files, choose your cutter settings, and 
configure cut layers.
• The Toolbar (located on the top of  the screen) allows you to open cut 
files, modify your settings, and perform other basic operations.
The first time you start the application, CUT-Server displays the Add 
Cutter dialog (see Figure 10).

To add and configure a cutter:
1. Click the Manage Cutters button on the toolbar.
2. Using the Type field, select your cutter from the list of available 

cutters. If your cutter is not available, select Generic Cutter. This 
cutter works with almost any cutter and provides solid output.

3. Enter a Display Name for your cutter, and click OK. 
4. Click the Configure button in the bottom right corner of the Cutter 
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Figure 9—CUT-Server Home Screen

Figure 10—Add Cutter Dialog



Panel for the cutter you wish to configure.
5. Under Port Settings, select the port you use. Click Setup to select 

your port settings. 
6. Enable/Disable Auto-forwarding. If enabled, cut jobs are auto-

matically cut as soon as they arrive in the queue. Once cut, the 
jobs are then archived.

7. In the Device Settings area, you can Add, Delete, and Configure 
your settings. These settings control your cutter specific settings 
like knife pressure and speed (Figure 11).

Workflow Options for Adding Cut Files
There are several workflow options for adding cut files to the job list. 
When you add a cut file using any of  these methods, the file will display 
under the correct device heading. If  you add a cut file for a cutter that’s 
not configured, you will be prompted with a message to add that specific 
cutter. Cut jobs will display in the job list for the intended cutter.
Typically, cut files are automatically added to CUT-Server. When an im-
age with cut paths is created in RIP-Queue, RIP-Queue automatically 
places the cut file in the appropriate CUT-Server folder. When the image 
is done printing, you can open CUT-Server, verify your settings, and click 
Cut Now.  

Cutter Hot Folder

This is the most common workflow. Once RIP-Queue processes the im-
age, it creates the cut file and stores it in the Hot Folder for that cutter. 
CUT-Server recognizes cutter Hot Folders automatically so the job dis-
plays in the CUT-Server job list. 

Opening Cut Files Manually

To open a cut file manually, click Open from the tool bar and browse 
to the cut file. The recognized file extension for cut files is .xml. Use 
this option if  your cut files are stored on a network or other location. 
Remember to verify all of  your settings to ensure accuracy.

Scanning a Barcode
1. To import a cut file into CUT-Server using Scan a Barcode click the Scan 
a Barcode button on the main toolbar. This opens the Scan a Barcode 
dialog (Figure 12).
2. Enter the barcode by typing the barcode in to the field or by scanning the 
barcode with a barcode reader.

3. Click OK.
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Because the settings for each cutter are 
different, consult the user manual for 
your cutter for assistance configuring 
your Port Settings and Device Settings.

To use Scan a Barcode, your job must be 
created with an associated barcode. 

For more information on cut paths in 
RIP-Queue, see the RIP-Queue On-
line Help at http://help.onyxgfx.com/
x10/rip-queue. For the best workflow, 
verify that all your settings are accurate 
in both RIP-Queue and CUT-Server.  

Figure 12—Scan a Barcode 

Figure 11—Edit Cutter Settings 



Drag and Drop

You can drag and drop cut files into CUT-Server. To do this, select the 
file and drag and drop the file into the application.

Custom Hot Folder

You can configure custom Hot Folders for CUT-Server to recognize a 
network folder or another known location. To do this, click Application 
Settings on the main toolbar. Click Jobs > Add and browse from the 
Application Settings dialog.

Archive

The Archive in CUT-Server allows you to store old cut files. After a 
while, your Cutter area will become crowded with old cut files. Using the 
Archive allows you to clear that area without deleting cut files. 

To automatically send cut files into the Archive after cutting, click Pref-
erences > Jobs > Archive Jobs After Cutting.
Click Archive on the main toolbar to open the Archive dialog (Figure 
13). This dialog lists each of  your cutters by name with the associated cut 
files. You can restore and reuse a cut file by highlighting it and clicking 
Restore File. If  you want to clear your archive, highlight the files you 
want to remove, and click Delete Files.

Cutter Settings
The Cutter Settings determine which settings, such as knife pressure and 
speed, you are going to use with your cutter. Use the Cutter Settings 
drop-down box, located in the Tools area, to select which Cutter Setting 
you want to use. 

Cutting Workflow
Once you have installed the cutter, you can add you cut files to the job 
list.
To send a cut job to the cutter:

1. In the CUT-Server window, highlight the desired cut job from the 
job list to display the cut paths in the preview area.

2. If you want to inspect your cut paths, use the zoom and pan tools. 
To reset the preview, use the zoom drop-down, and select Fit to 
Window.

3. Load the print into the cutter. If you’ve made a change to the rota-
tion, check the preview area to verify the correct orientation.

4. Click Cut Now.

93

Figure 14—Cutter Settings

You can create other Cutter Settings 
by clicking the Configure Cutter 
button on the Cutter Panel..

Figure 13—Archive 



Layer Settings
If  the cutter you are using supports multi-layer cutting, each layer listed 
in the Cut File Tools section can have its own Cutter Settings selection. 
This will allow you to, for example, cut some paths with a shallow kiss 
cut, and cut other paths completely through the media, all within the 
same cut job list.
Even if  the cutter you are using does not support multi-layer cutting, 
CUT-Server provides a way for you to cut individual layers with differ-
ent settings. Simply make a Cutter Settings selection, deselect all layers 
but the one you want to use the selected Cutter Settings, and cut. Then 
change the Cutter Settings, select the layer you want to use with those 
settings, and cut again.

Automatic Layer Creation

Each cut job contains at least one layer. Depending on the configuration 
of  the original source image and the RIPQueue application, a cut job 
may have multiple layers generated automatically.
If  you want a specific Cutter Settings selection to be made automatically 
for a layer, name the Cutter Setting the same as the Cut Layer. For exam-
ple, a Cutter Setting named CutContour1 will automatically be selected 
for the Cut Layer named CutContour1. If  there is not a Cutter Settings 
selection that matches the Cut Layer name, then the Default Cutter Set-
ting will be selected for that layer.
The Cutter Setting selected for each layer can be changed manually.
In X10 the ability to name layers has been improved. In the past, the 
names of  cut layers had to have the cutter prefix (e. g. CutContour) fol-
lowed by a number from 1 to 9. In X10 the layers can have more descrip-
tive names added to the prefix, e. g. CutContourKissCut, CutContour-
ThroughCut, CutContourPerforation.

Manual Layer Creation

You can manually create a new Cut Layer using the following steps: 
1. Click the Add New Layer button at the bottom of the Cut File Tools 
panel (Figure 17). 

2. Enter a name for the layer and click OK.

3. Make a Cutter Settings selection for the new layer.

4. Add Cut Paths to the new layer.

Managing Cut Paths and Layers
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Cut Layer and Settings changes are not 
saved automatically. Select Save from 
the File menu to ensure any changes you 
make to Layers and Settings are saved.

Figure 15—Layers Section 

Figure 16—Layer Information Panel 



You can move a cut path to a layer by selecting the path and dragging it 
to a Layer Information Panel (Figure 16). You can also right-click on a 
path to assign it to a layer. 
Click on a path to see which layer the path is assigned to. The Layer 
Information Panel with that path assigned will highlight. You can also 
click on the Layer Information Panel to see which cut paths are assigned 
to that layer.
Layers can be enabled and disabled by using the check box in the Layer 
Information Panel.

Renaming Layers

You can rename a Cut Layer using the following steps:
1. Select the Layer Information Panel for the layer you wish to rename.

2. Click the Rename the selected Layer button at the bottom of the Cut 
File Tools panel (Figure 17).

3. Enter a new name for the layer and click OK.

Rearranging Layers

Some cut operations need to be performed in a specific order. For ex-
ample, a kiss cut should be done first, followed by a through cut.
You can change the order of  Cut Layers using the following steps:

1. Select the Layer Information Panel for the layer you wish to move.

2. Click on either the Move the Layer Up button or the Move the Layer 
Down button at the bottom of the Cut File Tools panel (Figure 17).

Deleting Layers

You can delete a Cut Layer using the following steps:
1. Move any cut paths you wish to keep to a different layer.
2. Select the Layer Information Panel for the layer you wish to delete.
3. Click the Delete the selected Layer button at the bottom of the Cut File 
Tools panel (Figure 17).

4. Click OK.

Application Settings
The Application Settings allow you to customize the appearance and 
functionality of  the application. (see Figure 18). To set your preferences, 
click Preferences on the main screen toolbar, and then select the option 
that you want to modify. 
You can choose to modify the Appearance, Cutters, Jobs, or Short-
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A layer can only be enabled if  it contains 
at least one valid cut path.

When a cut layer is deleted, all cut paths 
assigned to that layer will be deleted as 
well.

Figure 17—Add New Layer
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cuts. You can also select About to see information about the application.
Changing the Appearance 
Appearance is the first dialog displayed in Application Settings (see Fig-
ure 18). Use these settings to change the general appearance of  the pro-
gram.

• Ruler Enabled—this option displays rulers along the top and left-
side of  the preview screen.
• Show text on toolbar buttons—this option displays text under 
the tool bar icons.
• Display warning when deleting cut file—this options will cause 
a warning message to be displayed to make sure you want to delte 
that cut file.
• Show feed direction on the preview—this option displays feed 
direction arrows above the preview screen. If  you rotate cut jobs, 
this indicates the media orientation.
• Animate Cut Path—this option displays cut paths as animated 
dashed lines.
• Use Operating System buttons and controls—this option 
causes the buttons and controls to change to the defualt options of  
your operating system.
• Use Default Font Size—this option displays the font size for the 
user interface. Deselect this option to change the font size from the 
default. Font size does not control fonts in the image.
• Units—this option displays the units of  measurements.
• Language—this option displays the current language for the user 
interface. Use the drop-down menu to select your desired language. 
You will be prompted to restart the program for the changes to take 
effect.

Managing Cutters

You can manage your cutters using the Cutters options. To access the 
Cutters options, click Preferences from the main toolbar and then click 
Cutters (see Figure 19). The Device Management section of  the Cutters 
window displays a list of  current devices.

• Add Cutter—if  you want to add a new cutter, click the Add but-
ton.
• Delete Cutter—if  you want to delete a cutter from the list, high-
light the device, and click Delete.

Figure 18—Appearance

Figure 19—Cutters
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• Configure Cutter—if  you want to configure a cutter from the 
list, highlight the device, and click Configure. 

The Application Settings section of  the Cutters window displays a 
checkbox for Sort CutPaths and Allow Open CutPaths.

• Sort CutPaths—this is checked by default and improves cut accu-
racy and efficiency by sorting cut paths in a logical manner to reduce 
media feed adjustment while cutting. 
• Allow Open CutPaths—this option allows you to use cut paths 
that are not completely closed. This gives you a margin of  error 
when creating your cut paths.

Managing Jobs

Select the Jobs icon on the left-side of  the Application Settings dialog 
to open the Job options (see Figure 20). Use these settings to configure 
Archive Options and Hot Folders.
Archive Options:

• Don’t do anything with jobs after cutting—this option leaves 
the job in the job list until you manually delete the file. You can 
manually delete files from the job list by highlighting the job, and 
then either selecting Delete from the right-click menu or the De-
lete icon located on the tool bar.
• Archive jobs after cutting—this automatically moves jobs to the 
Archive list. You can manually archive jobs from the job list by high-
lighting the job, and selecting Archive from the right-click menu. 
Restore or delete archived jobs using the Archive icon on the tool 
bar.
• Delete jobs after cutting—this deletes the job from the list after 
cutting.

Hot Folders
CUT-Server automatically recognizes ONYX Hot Folders and displays 
cut files in the job list for the intended cutter. CUT-Server displays a list 
of  custom Hot Folders from the network or a different known location. 
Use the checkbox to enable active Hot Folders.

• Add—if  you want to add a custom Hot Folder, click Add and 
browse to the location. You can add an unlimited number of  Hot 
Folders and any cut jobs in the defined Hot Folders will display in 
the job list.
• Edit—if  you want to edit a Hot Folder from the list, highlight the 
entry, and click Edit. This allows you to browse to a new location.

Figure 20—Jobs
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• Remove—if  you want to remove a Hot Folder from the list, high-
light the entry, and click Remove.

Viewing Shortcuts

Select the Shortcuts icon on the left-side of  the Application Settings 
dialog to view the Shortcut Key Strokes (see Figure 21). These are only 
for display and are not editable.

Viewing About

Select the About icon on the left-side of  the Application Settings dialog 
to view the CUT-Server information.Figure 21—Shortcuts



99



Layout 
Front-end
Objectives
This chapter will introduce you to Layout Front-end. By the end of  this 
chapter, you will understand the following.

• Purpose of  Layout Front-end
• Functionality of  Layout Front-end

What is Layout Front-end?
Layout Front-end gives you immediate, hands-on control over multiple 
images (see Figure 1). Instead of  modifying and printing a single image 
at a time in multiple applications, Layout allows you to open, modify, 
organize, and print any number of  images from a single application.  
Unlike RIP-Queue, Layout does not use Quick Sets, and it is only avail-
able before an image is sent to RIP-Queue. This allows you to customize 
the organization of  your images on your media, modify the images using 
the simplified tools, select your printer and media settings, and then send 
the nest to RIP-Queue much faster than sending each image to Preflight 
individually. When you click the Print button, the nest is processed, sent 
to RIP-Queue, and printed as a single image. Because the image is only 
processed at printing and not after each modification, your changes ap-
pear immediately.
Layout also has several new features such as Overlap Tiles, Multiple Jobs, 
image bleeds, simplified color corrections and tiling, and variable data.
Because Layout allows you to organize your images how you want them 
on the media, it is especially useful for flatbed printers. You should use 
Layout to conserve the most media possible, overlap tiles, perform basic 
modifications, and use variable data. You should not use Layout for jobs 
handled with Quick Sets.

Using Layout Front-end
Layout Front-end was designed to be user friendly and highly intuitive. 
The following sections describe basic functionality. See Online Help at 
http://help.onyxgfx.com/x10/layout for more information about spe-
cific features.
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11
If  you do not have Layout Front-end, 
contact your sales representative for a 
Key Update.

A Job is a group of  images organized 
for printing as a single unit.

Overlap Tiles allows you to conserve the 
most media by making the white bound-
aries around many images transparent. 
This allows you to overlap tiles and 
conserve media. 

Figure 1—Layout Front-end



Application Settings
You can access the Application Settings (see Figure 2) by clicking the 
Application Settings button on the main toolbar. The Application Set-
tings control the following options and features:

• Appearance—this option controls the basic appearance of  the 
program, cut path color, measurement units, and language settings.
• Quality Options—this option determines the speed and quality 
of  image processing prior to printing. This option can also affect 
the quality of  the final print.
• Image Options—this option allows you to adjust processing and 
printing options for your image.
• Cutter—this option manages your cutters. It lets you add, delete, 
and configure your cutters.
• Shortcuts—this option displays shortcut keys used in Layout 
Front-end.
• About—this option displays information about the application.

Image Tools Tab
The Image Tools tab (see Figure 3) controls job settings such as size, til-
ing, and color corrections. To access any feature in the Image Tools tab, 
click on the tab and then select the appropriate feature. Many of  these 
features are explained in the Preflight chapter. You can also look at the 
Online Help at http://help.onyxgfx.com/x10/layout

• Size Crop—this option sets the width, height, magnification, and 
orientation of  your image. You can also crop your image by clicking 
the Crop Image button. 
• Tiling—this option sets the tiles and tile overlaps for your image 
using either automatic or manual settings.
• Color Management—this option modifies the color of  your 
image using the Image Color Correction tool. To open the Image 
Color Correction tool (see Figure 4), highlight your image and click 
the Basic Adjustments button. Click the appropriate color to ad-
just your image. The preview windows by each color show what the 
image will look like if  you choose to add more of  that color. You 
can modify brightness, contrast, and saturation using the appropri-
ate buttons along the bottom of  the screen.
• Color Replacement—this option selects and changes one color 
to another color (see Figure 5).
• Cut Paths—this option creates automatic cut paths.
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Figure 2—Application Settings

Figure 3—Image Tools Tab

Figure 4—Color Correction



• Labels—this option controls what information appears in the la-
bel. It also controls the location and appearance of  the label.
• Marks—this option determines the marks that will be printed 
with your image. 
• Image Bleed—this option lets you print a bleed with your image. 
You can choose from Colored, Duplicate, Wrap, and Mirror. Image 
bleeds leave your cut image with a clean edge.
• Variable Data—this option lets you create a template image where 
certain portions of  the image are modified from image to image. 
Instead of  modifying each image individually, Variable Data allows 
you to import data from a spreadsheet. Layout Front-end will then 
automatically insert the appropriate data in the pre-defined fields. 
This option is often used when printing similar items like price ad-
vertisements, business cards, and name plates. 
• Package Templates—this option allows you to use and create 
templates that automatically resize, duplicate, and arrange the image 
on the media. Select an open image and use the drop down menu 
to select a template or click Template Manager to create a new tem-
plate. This will apply the template to the open image.

Page Tools Tab
The Page Tools tab (see Figure 6) controls your initial image settings,  
layout, and cutter marks. To access any feature in the Page Tools tab, click 
on the tab and then select the appropriate feature. 

• Settings—this option lets you name your job and apply a water-
mark to your image
• Layout—this option lets you determine the vertical and horizon-
tal space between each of  your images. You can also automatically 
arrange your images and add offsets. To manually arrange your im-
ages, click and drag the image to a location.
• Cutter Marks—this option lets you place a barcode on your im-
age for contour cutting and determines the type and size of  cutter 
marks you will use. You can also manually place cutter marks on 
your image to maximize media usage and efficiency. 

Images Tab
The Images tab (see Figure 7) displays the images from your current job. 
Each image is listed with any associated tiles. You can select which im-
ages or tiles you want to print by selecting or deselecting the Print option 
next to each image. If  you deselect an image, it will still be available in the 
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Figure 6—Page Tools Tab

Figure 5—Color Replacement



job, but it will not be displayed nor will it print. This allows you to print 
only specific tiles or, with PostScript files, only specific pages. You can 
delete an image by highlighting and selecting Delete Image. 

Printer and Media Options
The Printer and Media Options section (see Figure 8) on the bottom of  
the application window displays your printer and media settings. Use the 
drop down arrows to select your settings. These settings need to match 
the settings you have in RIP-Queue.

• Printer—this option lets you select the printer you want to use. 
Printers that are already installed in RIP-Queue are automatically 
available in Layout Front-end.
• Cutter—this option lets you select the cutter you want to use. 
You can add cutters by selecting Application Settings > Cutters 
> Add Cutter. 
• Media Group—this option lets you select the media configura-
tion you want to use.
• Media—this option lets you select which media you want to use.
• Mode—this option sets your mode.
• Page Size—this option determines the page size.
• Print Button—this option controls printing and cutting. Depend-
ing on your settings, it will either let you Print, Cut, or Print and 
Cut.

Jobs
Layout organizes your images using Jobs. Jobs are groups of  images or-
ganized for printing as a single unit. You can create, delete, and rename 
jobs by right-clicking on the bottom of  the application window (see Fig-
ure 9). You can also add a job by clicking on the green + or delete a job 
by selecting that job and clicking on the red X. To switch between jobs, 
click on the job you want to view. 
You can also save a job by clicking Save Job in the top left corner of  the 
application. Browse to where you want to save the job and reopen it later 
by clicking Open Job.
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Figure 7—Images Tab

Figure 9—Jobs

Figure 8—Printer and Media Options
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Note to Windows Vista and 
Windows 7 Users
Make sure to have the following settings applied to be able to ad-
just settings on Virtual Printers*.

UAC (User Ac-
count Control) 
State

Administrator 
Privileges

Effects on Application and Virtual Printers

Off Yes Application runs normally. User has complete access to Virtual 
Printer settings.

Off No User must right-click the application icon and select Run as 
administrator.... The application then runs normally and changes 
to virtual printers can be made. UAC State should not affect 
access to Virtual Printer settings. If  this action does not give 
you administrative privileges and access to printer settings, log 
off  and log back on with an administrative account or turn on 
UAC.

On Yes Application runs normally. User has complete access to Virtual 
Printer settings. If  you right click and select Run as administra-
tor... a warning opens asking whether you want to cancel or 
allow this action. Select Allow.

On No User must right-click the application icon and select Run as 
administrator.... A dialog opens displaying user accounts with 
administrative privileges. Select the desired account and type in 
the password. The application then runs normally and changes 
to virtual printers can be made. UAC State should not affect 
access to Virtual Printer settings.

*Adjustable settings for Virtual Printers include: add/remove/edit page sizes, add/
remove/rename media, add/remove/edit keywords, rename printer, activate/deacti-
vate printer, add/remove/rename quicksets, add/remove/rename modes.



Glossary
A
ACRN 

Achromatic Color Replacement. See GCR

Active Printers 

A Printer that can be used in RIP-Queue. Use Printer Manager to 
activate or deactivate printers.

Additive Color (Additive Primaries)

Colors formed by the combination of  red, green, and blue colored 
light. Video images are produced by this method. This differs from 
Subtractive Color (used in printing), in that adding more color light-
ens the image; 100% of  all three colors produces white.

Aliasing

Visual stair-stepping of  edges that occurs in images that have been en-
larged too much. Sometimes known as jaggies. See also Anti-aliasing.

ANPA-COLORTM

ANPA-COLORTM Color System. American color matching sys-
tem, mostly used in newspaper printing.

Anti-aliasing

Technique for reducing the visual stair-stepping of  edges that oc-
curs in an image that has been enlarged too much by averaging or 
blending the colors next to the edge.

ASCII (American Standard Code for Information Inter-
change)

A coding standard that uses 7 or 8 bits to assign numerical values up 
to 256 for the representation of  characters and symbols.
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AST

Adobe Separation Table. Color profile providing RGB to CMYK 
color conversions.

B
Banding

1. Distinct levels of  color in an otherwise continuous span of  color, 
caused by printing gradients without sufficient color information.
2. Horizontal striping caused by a printer head malfunction. Usually 
this is either a misfiring head or improper media feeding.

Base Address 

The address at which a device resides in computer memory. The 
computer must know this address to communicate with the device.

Base Folder

A folder containing the input and work folders for a printer.

Bitmap

A raster image format where each position on a video screen or 
printout is a picture element (Pixel). Every pixel is addressable, and 
they are stored and processed at that level. Each pixel is represented 
by 1 (for black and white images) or more bits (24 bits allows ap-
proximately 16 million shades of  gray or colors). A bitmap is the 
two-dimensional matrix of  pixel representation. 

Black Generation 

Addition of  K ink to Process Colors when converting from RGB to 
CMYK. Usually handled through UCR or GCR methodologies.

Bounding Box

An invisible frame drawn by an application around a portion of  an 
image that sets the size. This applies to PostScript only.

Brightness

A measure of  the total amount of  light emitted, transmitted, or re-
flected by an object or image; normally measured in Candela. 
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C
Candela

International unit of  measure for Luminance, approximately equal 
to one candlepower. In technical terms, a candela is 1/60th of  the 
luminous intensity per square centimeter of  a blackbody radiating at 
the temperature of  solidification of  platinum (2,046 K).

Chrominance

Signal which describes Hue and Saturation, used in measuring the 
difference between two colors of  equal Brightness.

CIE (Commission Internationale de l’Éclairage) 

An international group that developed the most commonly used set 
of  color definition standards. See also ICC.

CIECAM, CIECAM97

Profile standards proposed by the ICC which take into account 
viewing conditions such as temperature, light angle, and light type.

CIELab

A uniform Colorspace proposed by the CIE for use in the measure-
ment of  small color differences. See also L*a*b*.

CMYK

System for describing colors based on a combination of  values for 
Cyan, Magenta, Yellow, and Black; the ink colors used in four-color 
process printing. In theory, 100% of  Cyan, Magenta, and Yellow 
create Black. In practice, the addition of  Black ink is necessary to 
print a true Black. See RGB.

CMYKOG

System for describing color based on a combination of  values for 
Cyan, Magenta, Yellow, Black, Orange, and Green. It is an expan-
sion of  the CMYK color model that provides a larger color gamut.

CMYKRGB

System for describing colors based on a combination of  values for 
Cyan, Magenta, Yellow, Black, Red, Green, and Blue. It is an expan-
sion of  the CMYK color model that provides a larger color gamut.
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Color

The attribute of  visual experience that can be described using the 
dimensions of  Hue, Saturation, and Brightness.

Color Gamut

The range of  color that can be created on an output device.

Color/Gray Levels

A color correction tool that allows modification of  contrast, bright-
ness, and saturation (Color Levels), as well as the highlights, mid-
tones, and shadow levels (Gray Levels).

Color Layer

A layer of  a separated image composed of  a single color.

Color Management System (CMS)

A System which ensures color uniformity across input and output 
devices so that the final printed results match the originals. The 
characteristics or profiles of  devices are normally established by ref-
erence to standard color targets.

Color Rendering Dictionary (CRD)

A feature of  PostScript Level 2 and PostScript Level 3 that speci-
fies output device color capabilities using CIE color notation. Con-
tained in a PostScript RIP, a CRD converts CIE Yxy information 
embedded in a PostScript file to CMYK information for output.

Color Rendering Intent

A method of  mapping color values so colors can be reproduced 
on different devices even if  the devices have a different gamut. As 
part of  this process, it determines how in-gamut and out-of-gamut 
colors are mapped. See also Rendering Intent.

Color Separation

The process of  splitting full-color images into their CMYK com-
ponents. Color separation can also refer to one or all four of  the 
separate pieces of  film or data files from which a four-color version 
is to be printed. Each separation is a distinct Halftone image.
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Color Space

The set of  referents used to describe color. The color spaces dis-
played in RIP-Queue are CMYK, RGB, and HSV. L*a*b* manipula-
tions are also possible in Color Correction.

Color Space Array (CSA)

Color space description that specifies source color characteristics. 
(These are usually embedded in PostScript Level 2 and PostScript 
Level 3 EPS files.) A CSA is based on the monitor settings of  the 
application or is specified by the printer driver.

Color Temperature

A measurement of  color value in degrees Kelvin. The higher the 
temperature the closer it moves to white. Typical daylight rages from 
5500°K to 6500°K.

Color Wheel

An image or chart that displays the entire color spectrum at one 
time. See wheel.tif  in the RIP-Queue Samples directory.

Colorimeter

An instrument that measures and quantifies color in a way that re-
sembles human vision. The measurements are usually in the form 
of  coordinates in a CIE color space.

Continuous Tone

1. Images that contain an apparently infinite range of  shade and 
color smoothly blended to create a true copy of  the source image.
2. Printing method where dots of  equal size are placed in a vari-
able-spaced pattern causing the transitions between colors to appear 
more natural.

Contone

A RIP-Queue dot pattern that produces continuous tone data (such 
as RGB TIFF output) as opposed to half-tone data.

Contrast

The difference in tone between the darker and lighter parts of  an 
image.
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Crop Box

Defines the area of  an image that is to be included in the final out-
put. Anything outside of  the crop box is excluded.

Cropping

Cutting or manipulating an image to eliminate unwanted detail 
along the top, bottom, or sides of  an image. Cropped images in 
RIP-Queue are square or rectangular in shape.

D
DCS (Desktop Color Separations)

A version of  the standard EPS format; this lets you save color sepa-
rations of  CMYK or multi-channel files. Use the DCS 2.0 format to 
export images containing spot channels and single alpha channels 
from Adobe Photoshop.

Densitometer

A photoelectric instrument that measures the density of  printed 
inks or dyes. A densitometer works in two modes: Integral mode 
measures density on a logarithmic scale from 0 to about 4; Dot-
percent mode measures density on a linear scale from 0 to 100. 
RIP-Queue uses integral mode.

Density

Degree of  opacity of  coverage by an ink or toner. Usually measured 
as a percentage, with 0% equal to no ink, and 100% equal to full 
coverage.

Density Linearization

A procedure to normalize a device behavior to obtain a linear input 
to output response for opacity.

Density Range

The measurable difference between the brightest highlight (white) 
and the darkest value (black) that a device can create or register. The 
greater the dynamic range, the more lifelike the image.
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Device Independent Color Space

A color space that is not dependant on any particular physical de-
vice. See CIELab.

Dithering

Process of  averaging primary colors to approximate other colors.

DLL (Dynamic Linked Library) 

A file containing a set of  functions/routines called by a program to 
perform a task.

DMA (Direct Memory Access)

This allows high speed transfer of  data between a peripheral device 
(such as an LPT port) and a computer’s memory without using the 
computer’s processor. DMA channels can work simultaneously in-
dependent of  the computer’s processor.

Dot

A single element in the halftone printing process. In traditional half-
tone generation, dots vary in size to control the intensity of  the 
printed color. In digital printing, the dot size is fixed by the print 
mechanism.

Dot Gain, Dot Bloom

Process whereby the ink or toner spreads (blooms) larger than the 
initial size of  the dot due to either capillary action or the ink physi-
cally running over the edges of  the dot (over inking). Dot gain can 
be modified by adjusting the physical environment (humidity or 
temperature) of  the printer, or by reducing the saturation level of  
the inks. See GCR, UCR.

DPI (Dots Per Inch)

Screen or printer resolution. A single value (for example 1200 dpi) 
means dots per linear inch both vertically and horizontally; two val-
ues (for example 600 x 1200 dpi) indicates horizontal and vertical 
resolutions, respectively. A dpi value shown as 600@1200 dpi means 
that the image is processed at 600, but is printed at 1200. See also 
Dot, Virtual Pixel.
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Drop-Down Menu

A user interface element that allows a selection from a menu ac-
cessed by clicking a down arrow.

Dye Sublimation (Dye Sub)

A printing process using small heating elements to evaporate pig-
ments from a carrier film depositing them smoothly onto a media.

Dynamic Range

The measurable difference between the brightest highlight (white) 
and the darkest value (black) that a device can create or register. The 
greater the dynamic range, the more lifelike the image.

E
ECP (Enhanced Capability Port)

A parallel port (LPT) interface which uses the following character-
istics: 
1. Uses RLE (Run-Length Encoded) data compression for input 
and output. 
2. Provides for I/O buffers at either end. 
3. Uses DMA for handling actual data transfer. 
4. Allows ECP devices to address multiple channel across the same 
physical interface. This supports multi-function devices, such as 
combination scanner/modem/fax/printer devices.

ECW

A raster file format that uses high compression.

Effective Resolution 

Resolution of  Raster Format image independent of  the printer res-
olution. Effective resolution is determined by dividing the nominal 
resolution of  the image by the pixel duplication ratio. For example: 
a 2048x3072 pixel image has an effective resolution of  300 dpi at 
10x7 inches, 200 dpi at 15x10 inches, 150 dpi at 20x14 inches and 
72 dpi at 42x28 inches.
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Embedded Profiles 

Profiles that are contained in a raster file. TIFF, PSD, and JPG files 
support embedded profiles.

Encapsulated PostScript (EPS)

A PostScript (vector) file format that can include various options 
such as the specified PostScript level, embedded fonts, and a pre-
view image. EPS files are printer-independent. See also PS, Post-
Script.

Enhanced-Gamut Color

Another name for HiFi (CMYKOG) color.

EPP Port (Enhanced Parallel Port)

A parallel port specification jointly introduced by Intel, Xircom, and 
Zenith Data Systems. 

Error Diffusion 

Screening technology used in digital printers where fixed-size dots 
are placed based on image details and tone values to enhance detail. 
See also FDRP Diffusion.

F
FDRP Diffusion (Fixed Dot Random Placement Diffusion)

Patented error-diffusion process created by ONYX Graphics, Inc. 
for use in large-format printing.

FDRP Line (Fixed Dot Random Placement Diffusion—Line 
variant)

Modified version of  the FDRP Diffusion Process created by ONYX 
Graphics, Inc.

FDRP Plus

A hybrid of  the Stochastic and FDRP Diffusion dot patterns.

Flatness 

The vector calculation of  the maximum distance of  any points of  
the approximation from the corresponding point on the true curve, 
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measured in output device pixels.

FOCOLTONE Color

FOCOLTONE® Color System. English color matching system.

Fotoba Cutter Marks

Proprietary marks that are printed around images to allow the im-
ages to be cut out automatically.

Four-color Process Printing 

The basic method for recreating a broad spectrum of  colors on 
a printing press or computer printer, using only Yellow, Magenta, 
Cyan, and Black inks or dyes. See also Process Color Printing.

G
Gamma

Contrast level in photographic images. Mathematically, this is the 
logarithmic relationship between input and output. A perfect mir-
ror has a gamma of  1.0 (1:1), while color transparency film has a 
gamma of  approximately 2.0 (1:10). See also Tonal Range.

Gamut

The range of  colors that can be created by a particular output de-
vice. Colors are referred to as in-gamut if  they can be reproduced 
on a particular device and out-of-gamut if  they cannot. 

GCR (Gray Component Replacement)

In Four-color Process Printing, black is made up of  a combination 
of  the three primary colors. GCR determines how much black to 
print with black ink, and how much black to print with the remain-
ing three colors. See also UCR. Also known as Skeleton Black Gen-
eration when used in converting RGB files to CMYK. 

GIF (Graphic Interchange Format)

A standard for small raster image files. GIF files support transparen-
cies and different color palettes.

Grayscale 

1. The range of  tones from black to white.
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2. An image consisting of  only levels of  black and white. 

H
Halftone

1. An image in which continuous tones are simulated by regular pat-
terns (screens) of  small dots.
2. A process for creating images. Screening can be done at different 
angles and the line density varies over a wide range (50 – 500 lines 
per inch). Printing a black & white photograph on a press or printer 
requires the creation of  a single halftone. Four color process print-
ing requires a separate halftone for each of  the process colors. See 
also Continuous Tone, Screen Angle.

Hardware Key 

The physical plug that is required to use RIP-Queue. 

HexachromeTM

Pantone® trademark name for a printing system that uses specific 
values of  CMYK plus Orange and Green. See also CMYKOG(V).

HiFi Color

Printing system using additional levels of  dilute toner (usually cyan 
and magenta) in combination with CMYK to produce a wider gam-
ut of  colors and more natural-looking images. May also refer to a 
printing system using additional primary process colors.

Histogram

A type of  graph that shows frequency data in two-dimensional rect-
angles. The width of  each rectangle represents the class interval (in 
RIP-Queue, this is the section of  the spectrum), while the height 
represents the number of  occurrences (in RIP-Queue, this is the 
number of  pixels with that color value).

Hot Folder

A folder found in the Input folder that can be used to automatically 
process images by copying images into that folder. Each Hot Folder 
represents a specific Quick Set.

HSV

116 Glossary



A color space that defines colors by Hue, Saturation, and Value 
(Brightness).

Hue

1. A tint or color specified by an angle on the HSV Color Wheel. 
Going counter-clockwise around the wheel, hues shift from red to 
yellow to green to cyan to blue to magenta and finally back to red.
2. The attribute of  a color that permits it to be identified as a spe-
cific color. Hue combined with Saturation and Value fully defines 
a color. 

I
ICC Profile

An international standard for describing color transformations. Also 
known as ICM (.icm). See also Color Profile and Profile Library.

ICC (International Color Consortium) 

An organization that developed the standard for color management.

ICR (Integrated Color Removal)

See GCR.

IEEE-1284

The preferred standard for LPT ports, cables, and communication.

ICM Profile

See ICC Profile.

Ikon Card

A PCI add-on card that is required to print to some printers. Use the 
VPT printer port to print using the Ikon Card.

Ink Limiting

The process of  restricting the total amount of  ink applied to a me-
dia by adjusting the maximum percentage of  the color values in a 
processed image.

Ink/Toner Model
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A set of  parameters for a specific ink or toner. This is used in cali-
bration to compensate for imperfectly balanced inks and to assist in 
generating similar output from dissimilar inks.

Input Folder

A folder that is constantly monitored for image files to allow auto-
matic processing and printing. See Hot Folder.

Input Profile

1. A profile that describes the color characteristics of  a device such 
as a scanner that is used to create images.
2. A profile that identifies the output device being simulated for ICC 
Color Matching (that is, modifying the output image so that a print 
on one device appears as if  it were printed on a different device).

Intensity

Degree of  saturation or reflection of  visible light.

Interpolation

Process of  increasing the apparent resolution of  a raster image by 
using either a bi-cubic or sequential algorithm to create new dots in 
between the existing dots.

Intranet

A local computer network connecting nearby computer systems and 
printers, such as in an office.

J
Job

An image coupled with RIP-Queue settings.

JPEG (Joint Photographic Experts Group) 

A raster file format as well as a standard for compression of  image 
files in general. See also Raster Format.

K
Key Update
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A file that adds permissions to your Hardware Key. See Hardware 
Key.

L
L*a*b* (L*a*b* Color)

A uniform color space proposed by the CIE for use in the measure-
ment of  small color differences. The lightness (L*) and the color 
parameters (a* and b*) accurately define a color. See also CIELab.

LAN (Local Area Network)

A computer network designed to connect nearby computers and 
printers, such as in an office. A LAN can be connected to another 
LAN, or the Internet.

Landscape Orientation

A page oriented so that it is wider than it is tall. 

Leading Edge Effect (LEE)

This is a print error where an empty strip appears following a solid 
color or no color area. Use a Stochastic dot pattern to fix this.

Line Screen

Organization of  elements in a printing screen, used to define the 
density of  the screen. For example, a 140-line screen is a pattern 
that has 140 Halftone Dots per linear inch. The greater the number, 
the more accurately details are printed. See also Screen Ruling.

Linearization

The process of  normalizing a device so that it produces a linear 
(1:1) input to output response.

LPI (Lines Per Inch)

This refers to the number of  Halftone Dots that will be printed per 
linear inch in an image, based on the Screen used. 

Luminance

The lightness or Brightness of  an image.

LZWTM
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Standard form of  loss less file compression for video and graphic 
images (such as RIFF). From Lempel-Ziv-Welch, the inventors.

M
Media

A paper or other substrate that the printer creates images on.

Media Model

A media model defines the targets used for calibrating for different 
classes of  inks. See also Ink/Toner Model.

Metamerism

Condition where two colors match each other under one light 
source, but not another.

Moire (Interference Pattern) 

A pattern of  visible waves caused by overprinting halftones whose 
screen angles are aligned improperly. This is usually the result of  
scanning and screening a previously screened halftone image. The 
pattern is confusing and destroys detail, creating uneven tonal val-
ues. See also Screen Angle.

Monitor Profile

A profile that describes the color characteristics of  a display device.

Monochrome

An image that is composed only of  levels of  a single color and 
white. See also Grayscale.

N
Nibs

A part of  the physical print head on the printer that produces the 
ink dots.

O
Opacity
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Resistance to the passage of  light.

Ordered Dithering

A dot pattern that attempts to evenly distribute the expected range 
of  color levels using a matrix acting as a screen. This is done by 
defining the dot placement in a recursive fashion. This results in a 
screen which has a grid appearance to it. In RIP-Queue, ordered 
dithering has been extended to place each color at angles to other 
colors. This produces a rosette pattern similar to the halftoning that 
appears in newspapers, since the rosettes are small. See also Half-
tone, Screen, Screen Angle.

Origin

The point where the measurement units for both x and y axes are 
zero. In RIP-Queue the origin is always the top-left corner of  the 
selection box; in PostScript it is always the lower-left corner.

Output Profile

A profile that describes the color characteristics of  an output de-
vice, such as a printer or film recorder.

P
Pantone®

A system for identifying colors based on CMYK values as they ap-
pear on the printed page.

Patch

Single color sample contained in a swatch. Used as part of  profile 
generation.

PCX

A standard for raster image files developed by ZSoft for PCPaint-
brush.

PDF (Portable Document Format)

Modified PostScript file format used by the Acrobat document ex-
change system. Fonts should be embedded within the PDF docu-
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ment in order for RIP-Queue to use them.

PhotoCD

Raster image format developed by Kodak. There are two types, 
each containing multiple resolutions. Standard PhotoCD images are 
2048x3072 pixels, and require 18MB of  storage. Professional Pho-
toCD images are 4096x6144 pixels and require 80MB of  storage.

Photospectrometer 

Device for measuring color. Also known as Spectrophotometer.

Pixel (PEL)

Picture element. A single point in a raster format image.

Pixel Duplication Ratio

Ratio of  input pixels to output dots. (Scan resolution divided by 
output resolution).

Pixelization

Effect of  over-enlarging a raster image so that the individual pixels 
in the source image become visible. See also Aliasing.

Plate

Layer of  a separated image that is composed of  a single color. See 
also Color Layer and Separation.

Portrait Orientation

A page oriented so that it is taller than it is wide. See also Landscape 
Orientation and Transverse Orientation.

Posterization

The effect produced when an image or part of  an image is displayed 
or printed with too few colors (or shades of  gray) to accurately re-
produce color differences.

PostScript (PS)

A vector-based page description language, which stores text and 
graphics as lines and arcs that can be filled with a variety of  differ-
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ent backgrounds. PostScript files are printer dependent, do not need 
a showpage command, and have embedded fonts. See also Encap-
sulated PostScript, PDF.

PostScript Screen

A specific setting for a color channel that determines the frequency, 
angle, and function when using the Halftone dot pattern.

PPD (Printer Profile Description)

A file listing the limits and capabilities of  a printer in a form that 
printer drivers and other software programs can read.

Preflight

An application used to view and modify RIP-Queue jobs.

Primary Colors

Colors that can be combined in various proportions to produce an-
other color. In the light (additive color) spectrum, primary colors 
are red, green, and blue. In inks, paints, and other pigments (sub-
tractive color), the primary colors are generally cyan (red), yellow, 
and magenta (blue).

Printer Pool

One or more similar printers that share a common printer library, 
Hot Folders, and Quick Sets.

PrnInst (Printer Installation File)

A proprietary file format used to install a RIP-Queue printer. A 
PRNINST file contains the dlls, profile library information (media, 
calibrations, and profiles), and other support files that are necessary 
to use a given printer.

Process Colors 

The four ink colors used in four-color process printing: Cyan, Ma-
genta, Yellow, and Black.

Profile

1. A method of  defining and compensating for the color shifts in an 
image as it is shown on a monitor and printed on a media.
2. A specific Printer/Ink/Media combination in RIP-Queue.
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Profile Library (Printer Profile Library)

Collection of  color profiles specific to a printer type.

PSD (Photoshop Document)

The native file format of  Adobe Photoshop. They are raster files 
that support L*a*b* color, spot channels, and embedded profiles.

Pure Hues

Color created by applying 100% each of  one or more inks in an 
image. 

Q
Queue

An organized list of  jobs that are printed on a first-in first-out 
(FIFO) basis.

Quick Set

A group of  settings that is applied to images to create jobs in an 
efficient manner.

R
Raster

File format in which pixels are placed in a grid. (That is, pixels are 
located by exact addresses, rather than by their relation to other pix-
els.)

Raster Format

Graphic file format in which images are described as a matrix of  
dots. See also Raster.

Rasterizing

Conversion of  a file to Raster format.

Reflective Copy

A piece of  artwork that is viewed by reflected light (for example, 
drawings or photographs). Also called reflection copy and reflective 
art. See also, Transparency.
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Registration

The precise alignment of  film or plates for printing. Register marks, 
usually placed outside the trim area, assist the printer and finisher in 
achieving accurate registration in multiple color jobs.

Registration Marks

Cross-hair marks placed at each corner of  the image to help ensure 
proper registration. Registration Marks are also used to aid in trim-
ming the image.

Rendering Intent

A method of  compressing out-of-gamut color values so they can 
be reproduced.

Resolution

The number of  dots available to represent graphic detail in a given 
area. On a computer screen, resolution is usually measured in pixels 
per inch (ppi). On a printer, the resolution is measured in dots per 
inch, or dpi. Halftone resolution measurements are in lines per inch, 
or LPI. See also Screen Ruling.

RGB

System for describing colors based on a combination of  values for 
Red, Green, and Blue—the additive primaries. RGB is the basic ad-
ditive color model used for color video display. Mixing various per-
centages of  red, green, and blue light can recreate most of  the spec-
trum; combining 100% of  all three creates white light. See CMYK, 
Additive Color.

RIP (Raster Image Processing)

Method for converting a vector-based image into a raster based 
(pixel-by-pixel grid) image.

Ripping

Process of  turning files into printer or bitmap files. See Rasteriz-
ing.

RLE (Run Length Encoding)
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A method of  loss less file compression.

S
Saturation

Term used to describe the strength, purity, or vividness of  a hue. 
Saturation indicates how much color is present. When there is no 
saturation, there is no color.

Screen Angle

The orientation of  a halftone screen as measured from the horizon-
tal axis. Forty-five degrees is commonly used for Black and White, 
105° for Cyan, 75° for Magenta, and 90° for Yellow.

Screen Ruling

Measure of  the fineness of  a Halftone screen—the higher the num-
ber, the finer the screen. See also Lines Per Inch.

Screen (Screen Pattern, Screening)

1. A way of  filling areas in graphic design, created with various den-
sities of  black-and-white (or color-and-white) patterns. 
2. The process of  breaking up a photograph into dots of  black and 
white for easier printing.
3. A shade of  gray or color. Black (solid) is 100% screening and 
white is 0%. See Halftone, Line Screen.

Separation

Individual layer of  a multi-color image. Each layer contains the 
amount of  each primary color needed to produce a four-color im-
age when layers are superimposed on each other.

Separation Color Space

PDF’s name for a Spot Color. A separation color space always car-
ries an alternate tint transform. The transform can be in RGB or 
CMYK (or others) and gives the rules for outputting in that space 
when the named color is unavailable.

Server

A computer that provides facilities to other computers on a local 
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area network. Examples of  servers include file servers, print servers, 
and mail servers.

SID

A proprietary raster file format developed by LizardTech, Inc. Also 
known as MrSID. This format uses high compression algorithms.

Skeleton Black Generation

A color separation technique that substitutes Black ink for calculat-
ed amounts of  Cyan, Magenta, and Yellow. Black gives more depth 
in the reproduction, corrects a color cast in the shadows, and results 
in better gray neutrality. See also GCR.

Spectrophotometer

An instrument used to measure the spectral transmittance or reflec-
tance of  objects. They provide densitometric and colorimetric data, 
and can be used to read Linearizations and ICC Profile swatches.

Spot Color

A specific color or type applied to individual graphic items.

Spot Color Printing

A method of  color printing using an ink that is premixed to a spe-
cific color, such as a corporate logo. These colors are generally pre-
mixed according to a color matching system and are printed on top 
of  preexisting color. Sometimes referred to as Fifth-color Printing.

Stochastic Sampling

Dot pattern analysis and generation using locations in the area of  
a pixel wherein the pixel is perturbed or jittered. This produces an 
average of  the color for an area. Stochastic generation methods are 
generally much faster than other methods, at some expense in shad-
ow and highlight detail.

Strike Mode

Technology which controls how often and at what point the printer 
applies additional ink dots to the media.

Subtractive Color

Colors that are formed by the removal of  certain wavelengths of  
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light. Colors on a printed page are subtractive (e.g., white light 
strikes the page and the ink absorbs some wavelengths. This allows 
only certain colors to be reflected to the eye.)

Subtractive Primaries

Cyan, Magenta, and Yellow, which, along with Black, are the ink 
colors used in four-color process printing. See also RGB.

Swatch

Standard print image used by RIP-Queue for profile generation. A 
swatch contains multiple patches.

Swath

A band of  ink laid down by the printer head as it moves across the 
media.

SWOP (Specification for Web Offset Publication) 

The most common standard for American printing inks. This is not 
tied to any individual color matching system or device.

T
Targa

24 or 32-bit raster format originally developed for video production 
by AT&T EPIC (later Truevision). This format does not support 
the storage of  image data as planes of  color information.

TCP/IP (Transmission Control Protocol/Internet Protocol) 

A communications protocol developed under contract from the 
U.S. Department of  Defense to connect dissimilar systems. Sup-
ports mail (SMTP), file transfer (FTP), remote terminal operation 
(Telnet), and remote printing. RIP-Queue supports TCP/IP remote 
printing.

TIFF (Tagged Image File Format)

A standard raster format for graphic files.

TIFF-IT (Tagged Image File Format for Image Technology) 

A variant of  the TIFF file format developed by the American Na-
tional Standards Institute, Inc. (ANSI). It is intended to smooth pre-
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press workflow by making images easier to exchange and transfer.

Tile

Section of  a print image. Images can be tiled when they are too large 
for the media, or to fit mounting and display requirements

Tint

A solid color reduced in shade by screening. Altering the tint alters 
the hue of  a color without affecting the saturation of  the color.

Tonal Range

Range of  white in an image. An image with a small tonal range will 
appear very flat, because there will be little difference between the 
darker and lighter areas of  the image. See also Contrast.

Tone

Degree of  luminosity or amount of  white in color represented by 
the L axis in the L*a*b* color space. See also Luminance.

TOYO Color

TOYO 88 ColorfinderTM 1050 System. (Japanese)

Transparency

Any artwork that is viewed by light passing through it, rather than 
reflecting off  it. See Reflective Copy.

Transverse Orientation

Page oriented so that it is wider than it is tall, but the text is rotated 
90° so that it remains in the same relation to the page as in a Portrait 
orientation. See Portrait Orientation, Landscape Orientation.

Triggering

The mechanism by which RIP-Queue determines when jobs can be 
printed. Manual print triggering is controlled by the Print Now but-
ton. Automatic print triggering is controlled by a time-out value or 
an area percentage value of  media usage.

TRUMATCH Color 
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TRUMATCH Swatching SystemTM. An American color matching 
system.

TWAIN (Technology without An Interesting Name)

A platform-independent interface for acquiring images from image 
devices.

U
UCR (Under Color Removal)

The process of  reducing the smallest Halftone Dot in areas where 
yellow, magenta, and cyan all print, together with quantities of  the 
other two colors, sufficient to produce a neutral gray, and replacing 
that color with black ink. See also GCR.

URL (Uniform Resource Locator)

An address on the Internet or an intranet.

V
Value

Representation how bright (or dark) a color is. As value increases, 
the amount of  black decreases. See also Brightness.

Vector Format

Graphic file format in which an image is described as a set of  math-
ematical relationships. See PostScript.

VideoNet

A proprietary network protocol used to communicate with some 
printers such as ColorSpan devices.

Virtual Pixel

A dpi value that is processed at a lower resolution than is printed. 
The virtual pixel value is shown in two parts separated by the @ 
character, such as 600@1200. 600@1200 means that the image is 
processed at 600 but is printed at 1200. See also Dot.
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Virtual Printer

A Windows printer driver that prints to RIP-Queue. The virtual 
printer can be shared on a network for other systems (Windows or 
Macintosh) to use.

VPT

A printer port used when printing via an Ikon card and generally 
used for Xerox electrostatic printers.

W
White/Black Limits 

A color correction tool that modifies the white and black points of  
an image without changing the values of  the midtones.

WinKey

An application that shows the permissions of  the Hardware Key. 
WinKey is also used to print, e-mail, or update the key permis-
sions.

Y
YCC 

Kodak’s internal format standard for PhotoCD image files. This file 
format is not currently supported by RIP-Queue. Save these files as 
PCD files. See PhotoCD.

Z
Zipped File

Any file that is compressed using the algorithms developed by PK-
ware. Used for loss less compression of  files for storage or transfer.
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A
Aborting a Print  44
Absolute Colorimetric  80
Activating a Printer  65
Adding a Cutter  91
Adding Printers  29
Additive Color Theory  76
Add Printer Wizard  4
Advanced Black Generation  84
After Cutting  93
        Archive Jobs After Cutting  93
After Printing  26

Archive Job as Space Allows  26
Archive Jobs Indefinitely  26
Delete Jobs  26

After Processing  25
Delete Source Image  25

Anti-Aliasing  12
Archive Job as Space Allows  26
Archive Jobs Indefinitely  26
Area Based Start  43
Auto Detect  11
Automatically Start Printing  40, 43
Automatic Triggering  40

B
Base Folder  63

Changing the Base Folder  63

Input Folder  63
Work Folder  63

BestFit  41
Bit Depth  10, 29
Black Limit  24
Bounding Box  11
Brightness  23
Buffered Jobs Area  1

C
Calculate Ink Usage  10
Calibration  32
Changing a Job’s Order  47
CMYK  77
Color  76 – 85
Color/Gray Levels  22 – 23

Brightness  23
Color Levels  22
Contrast  23
Gray Levels  23
Highlights  23
Mid-Tones  23
Saturation  23
Shadows  23

Color Correction  21 – 25
Color Correction Filter  12
Color Correction Tab  21

Color/Gray Levels  22
Color Levels  22
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Color Replacement  25
Filters  25
Primary Color Levels  21
Primary Color Curves  22
Saturation  22
White/Black Limits  23

Color Correction Tools Display  13
Color Display  13
Color Levels  21 – 23

Modifying  23
Color Limit  24
Color Management  76 – 85

Color Management Options  81
Setting Color Management Options in a 
Quick Set  82
Setting a Color Management Option in Pre-
flight  82

Saving Color Management Settings  84
Color Management Profiles  78
Color Matching Table  81
Color Replacement  25
Color Spaces  77

CMYK  77
Device-Dependent Color Spaces  77
Device-Independent Color Spaces  77
L*a*b*  78
RGB  76

Color Theory  76
Additive Color Theory  77
Subtractive Color Theory  77

Configure Printers  3, 58
Configure Printer Capabilities  32
Configuring the Printer Port  58
Firewire Printer  4

TCP/IP Printer  3
USB Printer  4

Configuring the Network  52, 54
Configuring the Printer Port  58 – 60
Conserve Media  42
Console  1
Contour Cut Paths  28
Contour Cutting  86 – 95

Generic Cutter  88
I-Cut® digital die cutter  86
Creating a Quick Set for Contour Cutting  88
Preparing a File for Cutting  87
Print and cut on the same device  86
Setting up  6
Workflows  89

Contrast  23
Copies  46

Changing the Number of  Copies  46
Copying a Job to a Different Printer  48
Correction Factor  64

Adjusting the Correction Factor  64
Create Proof  Automatically  26
Crop  11, 18 – 19, 27

Crop Marks  27
Crop Outline  27
Using Origin and Size Values  19
Using the Mouse  18

Crop Marks  27
Crop Outline  27
Custom Image  83
Cut File, Open  92
CUT-Server  

Adding a Cutter  91
Configuring a Cutter 91
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Navigating through  91
Cutter Hot Folder  92
Cutter Mark Darkness  44
Cutter Path Prefix  8
Cutter Selection  8
Cutter Settings  93

D
Deactivating a Printer  65
Default Operator Name  26
Default Quick Set  13, 35
Defining the Cut Path  87
Delete Jobs  26
Delete Source Image  25
Deleting a Job  49
Deleting a Printer  66
Deleting Meida  62
Deleting Printers  29
Device-Dependent Color Spaces  77
Device-Independent Color Spaces  77
Display  13
Do Not Apply Output Profile to L*a*b* Images  84
Dot Pattern  11
Duplicating a Printer  66

E
Embedded Profiles  80
Enabling Tiles  20

F
File Name Selection  11
Filter Manager  25
Filters  25

Creating Filters  25

Empty Filters  25
Filter Manager  25
Multiple Filters  25

Final Output Printer  71
Firewire  4
Flip  19
Fotoba Cutter Marks  42

G
Gamma Range  24
Gamut Data View  69
Gamuts  69 – 72, 77

Reviewing Gamuts  71
Viewing Gamuts  70

GCR  84
Advanced Black Generation  84

Generate Tile Outline Cut Paths  89
Generic Cutter  91
Gray Levels  23
Grayscale  28
Grouping  41
Group Jobs Together  42

H
Hardware Key  iii, 36

Permissions  iii, 37
Updating the Hardware Key  36

Height  8
Highlights  23
Hold  38, 46 – 47

Changing the Hold Status  38
Hold Icon  26
Wait for Media  39

Hold for Operator  26
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Hold Icon  26
Hot Folders  14 – 15

Cutter Hot Folder  90
Dropping Images in Hot Folders  15
Troubleshooting  15

HTTP Access (Web Portal)  56 – 57

I
I-Cut® digital die cutter  86
ICC Profiles  76, 78 – 79

Embedded  iii
ICC Profile Setup  82

ICC Profile Setup  82
Output Tab  83
Profiles Tab  83
Rendering Intents Tab  83

ICM Profiles  78
Image  9, 28
Image Bleed  102
Image Options  9
Importing

Image  17
Media  61
Settings  2

Information Area  1
Ink Calculation  64

Adjusting the Correction Factor  64
Defining the Reporting Unit  64

Ink Limits  33
Ink Restrictions  33
Input Folder  15, 63
Input Profiles  79
Install  2

Printer  3
Software  2

IP Address  52 – 53
Finding an IP Address  52

J
Job

Change Job Size  19, 45
Changing a Job’s Order  47
Changing the Hold Status  46
Changing the Media  46
Copying a Job to a Different Printer  48
Deleting a Job  49
Modifying the Marks Options  47
Modifying the Workflow Options  47
Printing Jobs  36
Processing Jobs  35
Reprinting Jobs  36
Sending a Job to Preflight  48
Viewing a Job  47

Job Creation  26
Create Proof  Automatically  26
Make Copy of  Image  26
Preview Image Before Processing  26

Job Options  17
Jobs Ready to Print Area  1
Job Status  6

Hold  6
Offline  6
Online  6

Justification  43

K
Key Update  36 – 37
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Keywords  9

L
L*a*b*  78, 80
L*a*b* Image Files  80
Language Settings  ii
Layers  94
       Create  94
       Delete  95
       Manage  94
       Rearrange  95
       Rename  95
       Settings  94
Layout  100
Layout Front-end 96 – 99

Application Settings  97
Image Tools Tab  101
Images Tab  102
Jobs  97
Page Tools Tab  102
Printer & Media Options  103

Left Configuration  69
Linearizations (See Calibration)

M
Mac OSX  51 – 55

Adding the Printer on the Mac OSX  53, 55
Configuring the Network  52, 54
Printing from a Mac OSX  51
Printservices for UNIX  55
Windows Printing  52

Magnification  8, 45 – 46
Make Copy of  Image  26
Managing Printers  29, 65 – 66

Activating a Printer  65
Adding Printers  29
Creating a PrnInst  66
Deactivating a Printer  65
Deleting a Printer  66
Deleting Printers  29
Duplicating a Printer  66

Managing Media  61
Changing the Media Specific Options  61
Deleting Media  62
Importing Media  61

Managing Quick Sets  13
Manual Triggering  40
Marks  11, 27 – 28, 47

Contour Cut Paths  28
Crop Marks  27
Crop Outline  27
Registration Marks  27
Tile Dotted Overlap  27
Zero-Line Tile Marks  27

Marks Options  27 – 28, 47
Modifying the Marks Options  47

Maximum Print Area  39
Maximum Printer Area  19
Media  38 – 39

Change the Media for a Job  5, 39, 46
Change the Media for a Printer  18, 39
Managing Media  61 – 62
Setting up Media  4

MediaAnalyzer Tool  69
Gamut Data View  70
Left Configuration  69
Right Configuration  69

Media and Page Size  7
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Media Manager  32 – 33
Media Options  8
Media Settings  4

Change Media  5, 18
Mid-Tones  23
Mode  7, 18

Manage Modes  32
Set the Mode  18

Modifying Placement Options  42
Modifying Triggering  40

N
Navigation  1

O
Offline  6
Offset  43
Online  6
ONYX Workflow  34
Opening Images  4

File > Open  16, 17
Importing Images into Preflight  17
Open in Preflight  5
Open in RIP-Queue  4

Operator  19, 26
Default Operator Name  19, 26
Hold for Operator  19, 26

Original Image File  34
Origin and Size Values  18, 19
Output  9, 28, 83 – 84

Color  28
Grayscale  28
Output Tab  83
Separations  28

Output Options  28
Image  28
Output  28
Processing  28

Output Profiles  79
Output Tab  83
Overlap  20 – 21, 27

Weld Overlap  21
Overlap Tiles  100
Overlapping Tiles  20

Weld Overlap  21

P
Page Size  39, 62

Adding Page Sizes  62
Deleting Page Sizes  62
Editing Page Sizes  62

PatternID  71
Perceptual (Images)  79
Perform Image Processing During Print Stage 10
Pixel Based  8
Pixel Duplication  12
Placement Strategies  41 – 44

BestFit  41
Conserve Media  42
Fotoba Cutter Marks  42
Group Jobs Together  42
Placement Options  42

Contour Cutting  43
Cutter Mark Darkness  44
Grouping  41
Justification  43
Modifying Placement Options  42
Offset  43
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Print All Rows at a Time  43
Print Triggering  43
Size of  Cutter Mark  44
Space Between Copies  43
Space Between Image and Cutter Mark  44

Print Jobs Individually  44
Poster Color  80
PostScript  11, 35
PostScript File  11, 35
PostScript Halftone  11
PostScript Separated File  11
PostScript Settings, Overddide Default  12
PPD (Printer Profile Description)  51
Preflight  16

Color Correction Tab  21
Importing Images into Preflight  17
Preflight Button  17
Preview & Size Tab  18
Printer & Media Tab  18
Print Tab  25
Tiling Setup Tab  19

Preflight Button  17
Press Proof   68
Preview & Size Tab  18
Preview Image Before Processing  26
Primary Color Curves  22

Modifying  22
Primary Color Levels  21
Print All Rows at a Time  43
Print and cut on the same device  86
Printer & Media Tab  18
Printer Area  1
Printer Gamuts  69
Printer Manager  29, 65 – 67

Printer Pools  60
Printer Ports  58 – 60

Configuring the Printer Port  58
Firewire  59
LPT  59
Print Forwarding  59
Print to File  59
Print to Windows Printer Driver  59
SCSI  59
TCP/IP  59
USB  59
VideoNet  59
VPT  59

Printer Settings  40, 49
Print Forwarding  59
Printing  5 – 6

Aborting a Print  44
Printing a Proof   72
Printing from a Mac OSX  51
Printing Jobs  36
Reprinting Jobs  48
with Tiles  20

Print Jobs Individually  42
Print Label  27
PrintMetryx  9
Print Now Button  40
Print Reflections  9
Printservices for UNIX  55 – 56
Print Setup  25
Print Tab  25

Marks Options  27
Output Options  28
Print Setup  25
Workflow Options  25
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Print to File  60
Print to Windows Printer Driver  60
Print Triggering  43

Area Based Start  43
Automatically Start Printing  43
Time Based Start  43

PrnInst  66
Creating a PrnInst  66

Process/Print Options  26
Print  26
Reprocess  26

Processing  10, 28, 35
Perform Image Processing During Print Stage  28
Process with Interpolation  28
Two-Stage Processing  12

Processing Jobs  35
Process with Interpolation  28
Profiles  79

Embedded Profiles  80
ICC Profiles  78
Input Profiles  79
Output Profiles  79
Rendering Intents  79

Profiles Tab  83
Profiling  32
Proofing  68 – 69, 83

Comparing Printer Gamuts  69
Final Output Printer  71
Press Proof   68
Printing a Proof   72
Proofing Printer  70
Simulation Proof   68
Verifying Proofs  74

Proofing Printer  70

Configuring a Proofing Printer  72
Pure Hues  83

Q
Quick Sets  7 – 14

Advanced Quick Set Options  9
Color Correction  13
Crop  11
Display  12
Keywords  9
Marks  11
Output  9
PostScript  11
PostScript File  11
PostScript Halftone  11
Tiling  10
Workflow  12

Create a New Quick Set  7
Default Quick Set  13
Edit a Quick Set  7
Managing  13

Copy  14
Delete  14
Edit  13
Export  14
Import  14
Rename  13

Modifying a Quick Set for Contour Cutting  88
Quick Set Options  7

Media and Page Size  7
Mode  7
Quick Set Name  7
Sizing Rule  8

Using Quick Sets  7
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R
Raster Data  35
Read-Only Files  15
Registration Marks  27
Relative Colorimetric  80
Renaming a Printer  62
Rendering Intents  79

Absolute Colorimetric  80
Perceptual (Images)  79
Poster Color  80
Relative Colorimetric  80
Rendering Intents Tab  83
Saturation (Graphics)  80

Rendering Intents Tab  83
Reporting Unit  64

Defining the Reporting Unit  64
Reprinting Jobs  36, 48
Reprocess  26
Resolution  18
RGB  76
Right Configuration  69
RIP-Queue  4, 17, 72
Ripping  35
Rotate  9, 19

S
Saturation  23, 80
Scaling  51
SCSI  59
Sending a Job to Preflight  48
Separations  11, 28
Settings, Importing  2
Setup Media  4
Shadows  23

Simulation Proof   68
Size  7, 45 – 46

Changing Size (Magnification)  45
Size of  Cutter Mark  102
Sizing Rule  8
Source Image  25
Space Between Copies  43
Spot Channel Replacement  84
Spot Color Replacement  12
Spot Layer Tool  25
Subtractive Color Theory  77
Support Information  ii
System Requirements  ii

T
TCP/IP  3
Tile Dotted Overlap  27
Tiling  10, 20

Adjusting 20
Create Custom Tiles  20
Enabling Tiles  20
Overlapping Tiles  20
Printing with Tiles  20
Reset Tiles  20
Selecting Tiles to Print  47
Tiling Setup Tab  19
Weld Overlap  21

Tiling Setup Tab  19
Time Based Start  43
Triggering  40, 43

Automatic Triggering  40
Manual Triggering  40
Modifying Triggering  40

Trim Overlap  89
TrueType Font Handling  51
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Twain32  17
Two-Stage Processing  12

U
UCR  33
Updating the Hardware Key  36
USB  4
Use Embedded Profiles When Available  83

V
Variable Data  102
Verification Strip  75
Viewing a Job  47
Virtual Printers  6, 50

Virtual Printer Share Name  53
Establishing a Virtual Printer Share Name  53

Visual Tolerance Chart  74 – 75
Printing Visual Tolerance Charts  74

W
Wait for Media  5
Warning Level  12
Web Portal (HTTP Access)  56

Changing the Web Portal Port  57
Launching the Web Portal  56
Submitting a Job Using the Web Portal  57

Weld Overlap  21
White/Black Limits  23 – 24

Black Limit  24
Color Limit  24
White Limit  24

White Limit  24
Width  8, 20
Windows Printing  52 – 54

WinKey  37
Workflow  12, 25–26, 34, 36, 47

Contour Cutting Workflows  89
ONYX Workflow  34
Workflow Options  25

After Printing  26
After Processing  25
Job Creation  26
Modifying the Workflow Options  47
Operator  26
Process/Print Options  26

Work Folder  63

Z
Zero-Line Tile Marks  27



142

Thank you for 
choosing ONYX®.

092407-7.1


